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Support
Thank you for selecting NETGEAR products.

After installing your device, locate the serial number on the label of your product and use it to register your product at
https://my.netgear.com. You must register your product before you can use NETGEAR telephone support. NETGEAR
recommends registering your product through the NETGEAR website.

For product updates and web support, visit http://support.netgear.com.
Phone (US & Canada only): 1-888-NETGEAR.
Phone (Other Countries): Check the list of phone numbers at http://support.netgear.com/general/contact/default.aspx.

Compliance

For regulatory compliance information, visit http://www.netgear.com/about/regulatory.
See the regulatory compliance document before connecting the power supply.

Trademarks

© NETGEAR, Inc., NETGEAR and the NETGEAR Logo are trademarks of NETGEAR, Inc. Any non-NETGEAR trademarks are
used for reference purposes only.
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Hardware Overview of the Modem
Router

The NETGEAR® AC1600 WiFi VDSL/ADSL Modem Router Model D6400, in this manual
referred to as the modem router, delivers WiFi connection speeds up tol 300 Mbps on 2.4 GHz
802.11n and up to 1300 Mbps on 5 GHz 802.11ac. Both 2.4 GHz and 5 GHz bands can be active
simultaneously. The modem router is compatible with most major DSL Internet service providers
and also supports cable or fiber Internet service.

The chapter contains the following sections:

Unpack Your Modem Router

Front Panel with LEDs

Back Panel with Ports, Buttons, and Connector

Right Side Panel with WPS and WiFi On/Off Buttons and USB Port
Bottom Panel Product Label

Note: For more information about the topics that are covered in this manual,
visit the support website at support.netgear.com.

Note: Firmware updates with new features and bug fixes are made
available from time to time at downloadcenter.netgear.com. You can
check for and download new firmware manually. If the features or
behavior of your product does not match what is described in this
guide, you might need to update your firmware.

Note: In this manual, the terms wireless and WiFi are interchangeable.

1. Actual data throughput and WiFi coverage will vary. Network conditions and environmental factors, including volume of network traffic, building
materials and construction, and network overhead, lower actual data throughput rate and WiFi coverage. NETGEAR makes no express or implied
representations or warranties about this product’'s compatibility with any future standards.
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Unpack Your Modem Router

Your package contains the following items.

Ethernet cable

\m:\
v <
—-

Modem router Phone cable

e

N~
Z <
Power adapter DSL or ADSL filter
(varies by region) (varies by region)

Figure 1. Package contents for the modem router

Your package might contain more items. The filter or phone cable provided depends on the
region, and in some locations, a CD is included.

Hardware Overview of the Modem Router
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Front Panel with LEDs

The modem router displays status LEDs on the front panel.

DSL LED
Internet LED
WiFi LED
USB LED

Figure 2. Modem router front panel view

Hardware Overview of the Modem Router
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The following table describes the LEDs from right to left and their behavior. For information
about how to troubleshoot with the LEDs, see Troubleshoot with the LEDs on page 278.

Table 1. LED descriptions

LED Icon Description

Power e Solid green. The power is on and the modem router is functioning normally.

@ e Solid amber. The modem router is booting. After about one minute and 10 seconds,
the Power LED turns solid green.

If the LED does not turn green, a power-on self-test (POST) failure occurred or the
modem router is malfunctioning. For more information, see Power LED Remains Solid
Amber on page 278.

e Blinking amber. The Reset button on the back panel is pressed.

When you release the Reset button, the Power LED blinks amber three times and
then turns green as the modem router resets to the factory defaults.

- Off. The modem router is not receiving power.

DSL e Solid green. The modem router is providing a DSL connection. In technical terms,
@ the DSL port is synchronized with an ISP’s network-access device.
e Blinking green. The modem router is negotiating the best possible speed on the
DSL line.

e Off. The modem router is not negotiating the speed on the DSL line and is not
providing a DSL connection.

Internet e Solid green. The modem router is connected to the Internet.

¢ Solid amber. The modem router failed to connect to the Internet. For more
information, see Troubleshoot the Internet Connection on page 280.

e Alternating green and amber. The traffic meter is enabled and the traffic limit was
reached.

e Off. The modem router did not detect an Internet connection or functions in bridge
mode (that is, an external device handles the IP connection).

WiFi e Solid blue. One or both WiFi radios are enabled and the modem router is providing

‘ WiFi connectivity.

e Blinking blue. WPS (Wi-Fi Protected Setup) is active.

- Off. Both WiFi radios are disabled and the modem router is not providing WiFi
connectivity. You can still plug an Ethernet cable into one of the LAN ports to get
wired connectivity.

USB e Solid blue. A USB device is connected to a USB port and is ready.
‘ e Blinking blue. A USB device is connected to a USB port and is trying to connect.

e Off. No USB device is connected or someone clicked the Safely Remove Hardware
button, and it is now safe to remove the attached USB device.

Hardware Overview of the Modem Router
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Back Panel with Ports, Buttons, and Connector

The back panel of the modem router provides ports, buttons, and a DC power connector. The
following figure shows only part of the back panel.

USB Ethernet Reset DC power
2.0 port LAN ports button connector
DSL port Internet Power

port On/Off button

Figure 3. Modem router back panel

Viewed from left to right, the back panel contains the following components:

USB port. One USB 2.0 port. (Another USB 2.0 port is located on the right side panel.)

DSL port. One RJ-11 asynchronous DSL port for connecting the modem router to an
ADSL or VDSL line. This port is colored gray.

Ethernet LAN ports. Four Gigabit Ethernet RJ-45 LAN ports to connect the modem
router to LAN devices. These ports are colored yellow.

Internet port. One Gigabit Ethernet RJ-45 port to connect the modem router to a fiber or
cable modem. This port is colored red.

Note: You can use either the DSL port or the Internet port for WAN connectivity.
You cannot use both simultaneously.

Reset button. For information about using the Reset button, see Use the Reset Button
on page 227.

Power On/Off button. Press the Power On/Off button to provide power to the modem
router or to turn it off.

DC power connector. Connect the power adapter that came in the product package to
the DC power connector.

Hardware Overview of the Modem Router
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Right Side Panel with WPS and WiFi On/Off Buttons and
USB Port

The right side panel provides the WiFi On/Off button, the WPS button, and a USB port.

WiFi On/Off button

WPS button

UBS 2.0 port

Figure 4. Modem router right side panel

The following table describes the buttons and port.

Table 2. Button and port descriptions

Button Icon Description
or port
WiFi By default, the 2.4 GHz and 5 GHz WiFi radios are enabled. Pressing this button for three
On/Off Q seconds turns off both radios. Pressing the button again for three seconds turns on both
radios.
If you turn off the radios, the WiFi LED on the front panel turns off too. If you turn on the
radios, the WiFi LED on the front panel lights blue.
WPS Pressing this button for three seconds activates WPS (Wi-Fi Protected Setup) to let you
O add a WiFi device to the WiFi network without typing the WiFi password.
While WPS is active, the WiFi LED on the front panel blinks blue.
For more information about using WPS, see the following sections:
e Join the WiFi Network of the Modem Router on page 18
¢ Use WPS to Add a Device to the WiFi Network on page 100
UsSB (n/a) One 2.0 USB port. (Another USB port is located on the back panel.)

Hardware Overview of the Modem Router
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Bottom Panel Product Label

The product label on the bottom panel of the modem router lists the login information, WiFi
network name (SSID) and password (network key), serial number, and MAC address of the
modem router.

NETG EAR '/\\ACLél()OD\;VRS/DSL/ADSLModem Fouter \g’ 0@ c € @ @
odel: < . 12V=2.5A
O SO @ () o VAN R-NZ

Power DSL Internet WiFi USB

WiFi network name (SSID) R

http://www.routerlogin.net
user name admm

password: password :
MAC address
ReadySHARE Access on

Windows: Start -> RUN -> \\readyshare
(Type \\readyshare)

Designed by NETGEAR in California Made in China

Serial number

Network Key (password)

XXX-XXXXX-XX

Figure 5. Modem router product label

Hardware Overview of the Modem Router
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Install and Access the Modem
Router and Its Network

This chapter describes how you can install and access the modem router and its network.
The chapter contains the following sections:

e Position Your Modem Router

* Connect to the Modem Router

e Types of Logins

e NETGEAR genie Automatic Setup Ultility

e Set Up Your Modem Router for DSL Service

e Set Up Your Modem Router for Cable or Fiber Service

e Log In to the Modem Router After Setup to View or Change Settings
e Change the Language

e Change the admin Password and Automatic Login Time-Out Period
e Set Up Password Recovery

e Let the Modem Router Automatically Update Its Firmware

* Access the Modem Router with the NETGEAR genie App

16

Download from Www.Somanuals.com. All Manuals Search And Download.



AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Position Your Modem Router

The modem router lets you access your network anywhere within the operating range of your
WiFi network. However, the operating distance or range of your WiFi connection can vary
significantly depending on the physical placement of your modem router. For example, the
thickness and number of walls the WiFi signal passes through can limit the range.

Additionally, other WiFi access points in and around your home might affect your modem
router’s signal. WiFi access points are routers, repeaters, WiFi range extenders, and any
other device that emits a WiFi signal for network access.

Position your modem router according to the following guidelines:
* Place your modem router near the center of the area where your computers and other
devices operate and within line of sight to your WiFi devices.

* Make sure that the modem router is within reach of an AC power outlet and near Ethernet
cables for wired computers.

* Place the modem router in an elevated location, minimizing the number walls and ceilings
between the modem router and your other devices.

* Place the modem router away from electrical devices such as these:
- Ceiling fans
- Home security systems
- Microwaves
- Computers
- Base of a cordless phone
- 2.4 GHz cordless phone

* Place the modem router away from large metal surfaces, large glass surfaces, insulated
walls, and items such as these:

- Solid metal door
- Aluminum studs
- Fish tanks

- Mirrors

- Brick

- Concrete

If you are using adjacent access points, use different radio frequency channels to reduce
interference.

Install and Access the Modem Router and Its Network
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Connect to the Modem Router

During and after installation, you can connect to the modem router’s network through a wired
or WiFi connection. If you set up your computer to use a static IP address, change the
settings of your computer so that it uses Dynamic Host Configuration Protocol (DHCP).

Connect to the Modem Router Through an Ethernet Cable

You can connect your computer to the modem router using an Ethernet cable and join the
modem router’s local area network (LAN).
» To connect your computer to the modem router with an Ethernet cable:

1. Make sure that the modem router has power (its Power LED is lit).
2. Connect an Ethernet cable to an Ethernet port on your computer.
3. Connect the other end of the Ethernet cable to one of the numbered Ethernet ports.

Your computer connects to the local area network (LAN). A message might display on
your computer screen to notify you that an Ethernet cable is connected.

Join the WiFi Network of the Modem Router

Choose either the manual or the WPS method to add a WiFi device such as a computer,
iPhone, iPad, or gaming device to the WiFi network of the modem router.

Manual Method

> To connect a device manually to the WiFi network of the modem router:

1. Make sure that the modem router has power (its Power LED is lit).

2. On the WiFi device that you want to connect to your modem router, open the software
application that manages your WiFi connections.

This software scans for all WiFi networks in your area.
3. Look for your network and select it.

If you did not change the name of your network during the setup process, look for the
default WiFi network name (SSID) and select it. The default SSID is on the product label.

N E TG E A R Q%LgEOD‘QVi%(;/DSL/ADSL Modem(DRoufer
ower n

WiFi network name (SSID)

Network Key (password)

ReadySHARE Ac:

Designed by NETGEAR in California XXX-XXXXX-XX

4. Enter the modem router password.

Install and Access the Modem Router and Its Network
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The default WiFi password (also referred to as the network key or passphrase) is also on
the product label.

Click the Connect button.
The device connects to the WiFi network of the modem router.

Wi-Fi Protected Setup Method

Wi-Fi Protected Setup (WPS) is a standard for easily adding computers and other devices to
a home network while maintaining security. To use WPS (Push 'N' Connect), make sure that
all WiFi devices to be connected to the network are Wi-Fi certified and support WPS. During
the connection process, the client gets the security settings from the modem router so that
every device in the network supports the same security settings.

> To use WPS to connect a device to the WiFi network of the modem router:

1.

2.
3.
4

Make sure that the modem router has power (its Power LED is lit).
Check the WPS instructions for your computer or wireless device.
Press the WPS button on the side panel of the modem router for three seconds.

Within two minutes, press the WPS button on your WiFi device, or follow the WPS
instructions that came with the device.

The WPS process automatically sets up the device with the network password and
connects the device to the WiFi network of the modem router.

For more information, see Use WPS to Add a Device to the WiFi Network on page 100.

Types of Logins

Separate types of logins serve different purposes. This section describes the differences so
that you know which login to use when.

Types of logins:

ISP login. The login that your Internet service provider (ISP) gave you logs you in to your
Internet service. Your ISP gave you this login information in a letter or some other way. If
you cannot find this login information, contact your ISP.

WiFi network key or password. Your modem router is preset with a unique WiFi
network name (SSID) and password for WiFi access. This information is on the product
label. Use this information to connect a WiFi device to the WiFi network of the modem
router.

Modem router login. This logs you in to the modem router interface from an Internet
browser as admin.
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NETGEAR genie Automatic Setup Utility

You can use the NETGEAR genie automatic setup utility during initial installation and setup
of your modem router. This utility functions with both types of Internet service that the modem
router supports:

e DSL service. If you install your modem router for DSL service (the modem router
supports ADSL and VDSL service), you can set up your modem router with the
NETGEAR genie automatic setup utility, which launches the first time that you set up the
Internet connection for your modem router. The NETGEAR genie automatic setup utility
runs on any device with a web browser.

For more information, see Set Up Your Modem Router for DSL Service on page 21.

e Cableorfiber service. If you install your modem router for cable or fiber service, you can
set up your modem router with the NETGEAR genie automatic setup utility, which
launches the first time that you set up the Internet connection for your modem router. The
NETGEAR genie automatic setup utility runs on any device with a web browser.

For more information, see Set Up Your Modem Router for Cable or Fiber Service on
page 29.

Note: After initial installation and setup, the NETGEAR genie Setup Wizard
is always accessible to assist you with setting up an installation with
DSL service or an installation with cable or fiber service. For more
information, see Use the Internet Setup Wizard After Initial Setup on
page 42.

Whether you install your modem router for DSL service or for cable or fiber service, you can
always use the genie menus and screens to set up your modem router manually.

Before you start the setup process, get your ISP information and make sure that the settings
that are described here are specified for the computers and devices in the network.

When your Internet service starts, your Internet service provider (ISP) typically gives you all
the information that you need to connect to the Internet. For DSL service, you might need the
following information to set up your modem router:

* The ISP configuration information for your DSL account

* ISP login name and password

* Fixed or static IP address settings (special deployment by ISP; this setting is rare)

If you cannot locate this information, ask your ISP to provide it. When your Internet
connection is working, you no longer need to launch the ISP login program on your computer

to access the Internet. When you start an Internet application, your modem router
automatically logs you in.
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Set Up Your Modem Router for DSL Service

You can install your modem router for DSL service or for cable or fiber (Ethernet WAN)
service. If you use a DSL modem, follow the procedure that is described in Cable the Modem
Router for DSL Service and Access the Modem Router on page 22. If you use a cable or fiber
modem, follow the procedure that is described in Set Up Your Modem Router for Cable or
Fiber Service on page 29.

DSL Service

Make sure that your ADSL or VDSL service is active before you install the modem router.
You need the following information to install your DSL modem and connect to the Internet:

* DSL user name and password. This information is included in the welcome letter your
DSL ISP sent you when you signed up for your service. Record your DSL Internet service
account user name and password.

* Your telephone number or DSL account number. If you do not use voice service, you
can use your DSL account number in place of a phone number.

If you do not know or cannot locate your DSL user name and password, call your DSL
Internet service provider (ISP). Be specific when speaking with your DSL Internet service
provider. For example, you could say, “| need my DSL service user name and password. Can
you help me?”

Note: If your provider says that they do not support NETGEAR services, tell
them that you need only your DSL user name and password; you do
not need support.
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Cable the Modem Router for DSL Service and Access the
Modem Router

The following figure shows the cabling of your modem router for DSL service.

Figure 6. Modem router cabling for DSL service

To connect your modem router to a DSL service:

1. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall jack
for your Internet service.

2. If your DSL modem includes a battery backup, remove the battery.
3. Install an ADSL or DSL microfilter between the phone line and the phone.

The product package contains either an ADSL or a DSL microfilter.
4. Use a phone cable to connect the microfilter to the gray DSL port on the modem router.
The product package contains a phone cable.

5. If your DSL modem includes a battery backup, reinsert the battery.
6. Plug in your DSL modem’s power and turn on your DSL modem.
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7. Connect the power adapter to the modem router and plug it into an electrical outlet.
Wait for the Power LED @ to light solid green, which takes about one minute.
8. If the Power LED does not light, press the Power On/Off button.

9. Wait for the WiFi LED @ to light blue.

If the WiFi LED does not light, press the WiFi On/Off button B
10. Check the DSL LED.

If the modem router is connected to a DSL service, the DSL LED @ lights green.
11. Connect a computer to the modem router by one of the following methods:

e Ethernet cable. Use an Ethernet cable to connect your computer to a yellow Ethernet
LAN port on the modem router.

The product package contains a yellow Ethernet cable.
Your computer connects to the modem router’'s LAN.
*  WiFi. Connect to the default WiFi network of the modem router:
a. On your computer or WiFi device, find and select the WiFi network.
The WiFi network name (SSID) is on the product label.
b. Join the WiFi network and enter the WiFi password.
The password (network key) is on the product label.
Your computer or WiFi device connects to the modem router's WiFi network.
Note: If the computer is set to a static (fixed) IP address (this setting is
uncommon), either change the computer to obtain an IP address
automatically from the modem router through DHCP, or change the IP
address of the computer to a static IP address in the
192.168.0.2-192.168.0.254 range.
12. Launch a web browser.

The NETGEAR genie automatic setup utility displays. (This utility is also called the Setup
Wizard.)

You are not yet connected to the Internet

Do you want NETGEAR Genie to help?
® ves

C No, | want to configure the Internet connection myself

© | have saved the router settings in a file and | want to restare the router to those settings
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If the NETGEAR genie automatic setup utility displays, skip to Step 14. If it does not

display, do the following:

a. Inthe address field of the web browser, enter www.routerlogin.net.

b. When prompted, enter admin for the user name and password for the password.

If the NETGEAR genie automatic setup utility displays, skip to Step 14. If the NETGEAR

genie automatic setup utility still does not display, see Step 13.

If the browser cannot display the web page, do the following:

e Make sure that the computer is connected to one of the four Ethernet LAN ports or
over WiFi to the modem router.

e Make sure that the Power LED @ of the modem router is lit green.

» Make sure that your browser does not cache the previous page by closing and
reopening the browser.

e Clear the browser cache.

« If the computer is set to a static or fixed IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static or fixed IP
address in the 192.168.0.2-192.168.0.254 range.

14. Click the Next button.

NETGEAR genie '

D6400

Select Country
Country: USA -

Select ISP
ISP: ATAT >

Auto-Detect Connection Type
The Smart Setup Wizard can detect the type of Internet connection that you have.
Do you want the Smart Setup Wizard to try and detect the connection type now?

9 Yes
No. | want to configure the router myself.

15. From the Country menu, select the country in which you use the modem router.
16. From the ISP menu, select the ISP that you are using.

If your ISP is not in the menu, select Other.

17. Select the Yes radio button.
18. Click the Next button.
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The Setup Wizard searches your Internet connection for servers and protocols to
determine your ISP configuration.

This process can take up to six minutes; please wait

“"
<
"w

When the modem router is connected to the Internet, the Congratulations! screen
displays, and you successfully completed the setup process.

If the Congratulations! screen does not display, other screens might display and you
might need to provide more information, in which case you must continue with the next
step. The screens that display depend on your type of ISP connection and configuration.

You are successfully connected to the Intemet
This router is preset with the following unigue wireless network name (SSID) and network key (password

2.4GHz Wireless Network Name (SSID): NETGEAR23

Wireless Network Key (Password) - jaggedtrumpet276
5GHz Wireless Network Name (SSID): NETGEAR23-5G

Wireless Network Key (Password) © jaggedtrumpet276

19. (Only if you are using an ADSL connection and the following screen displays) Specify a full
scan to let the Setup Wizard find the PVC protocol.

The screen that displays might ask you if you need the Setup Wizard to do a full scan to
find the PVC protocol. If this screen does not display, continue with the next step.

Do you need Setup Wizard to do full scan to find the PVC/Prolocal?
% Yas, (This will take approcamotaly 1 10 6 minutes)

MNo. | want to configure the router myself

Do the following:

a. Select the Yes radio button.
b. Click the Next button.

The Setup Wizard performs a full scan, which might take up to six minutes.
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This takes approximately 1 to 6 minutes

.l"
-
-

20. (Only if the following screen displays) Specify how to manage problems with the detection of
the Internet connection.

The screen that might display states that a problem occurred while the wizard was
detecting the Internet connection. If this screen does not display, continue with the next
step.

Problem Detecting the Internet Connection
This is most likely due to one of the following reasons

1. The modem was not power cycled during the cabling step

To solve this problem, power cycie the modem (turn it off and on). To power cycle a modem with battery backup,
you might need to remove and reinsert its battery. After the power cycle, wait 2 minutes for the modem to
completely start up.

2. The yellow Ethernet cable is not fully inserted, or is inserled in the wrong place
To solve this problem, make sure that the yellow Ethernet cable is securely plugged in to the broadband modem
port and the router Intemet port

I just power cycled the modem and waited for 2 minutes.

| comecied a problem with the Ethernet cable

MNone of the above

Note: The option for the Ethernet cable connection that is stated onscreen

applies to a cable or fiber Internet connection only (see Set Up Your
Modem Router for Cable or Fiber Service on page 29).

Take one of the following actions:

If you already power cycled the DSL modem (see Step 1 through Step 6), do the
following:

a. Select the None of the above radio button.
b. Click the Next button.
If you did not yet power cycle the DSL modem, do the following:

a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall
jack for your Internet service.

b. If your DSL modem includes a battery backup, remove the battery.
c. Wait 10 seconds.
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If your DSL modem includes a battery backup, reinsert the battery.
Plug in your DSL modem’s power and turn on your DSL modem.
Wait two minutes.

Select the | just power cycled the modem and waited for 2 minutes radio
button.

Click the Next button.

21. (Only if the following screen displays) Specify how to manage problems with the detection of
the IP address for the Internet connection.

The screen that might display states that a problem occurred while the wizard was
detecting the Internet connection IP address.

Problem Detecting the Internet Connection - IP Address

Did your Internat Service Provider (ISP) assign to you a fixed (static) IP address? This is a very rare special
deployment

Select an option and click Next to proceed
Yes. My ISP assigned a fixed (static) IP address to me
Mo, | did not get a ficed (static) |P address from my ISP

| don’t know

Take one of the following actions:

e If your ISP assigned you a fixed (static) IP address, do the following:

a. Select the Yes radio button.

b.

Click the Next button.

Enter the fixed I[P settings assigned by your Internet Service Provider and click Next to proceed
My IP Address
Subnet Mask
Dafault Gateway
Praferred DNS Server

Alternate DNS Server

Enter the address information that your ISP gave you for your fixed IP address
configuration.
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d. Click the Next button.

e If your ISP did not assign you a fixed IP address or you do not know if your ISP
assigned you a fixed IP address, do the following:

a. Select either the No or the | don’t know radio button.
b. Click the Next button.

Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label
Enter the MAC address here

{format AABBCCDDEEFF)

c. Enter the MAC address of the computer or router with which you previously were
able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the
MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF
format.

d. Click the Next button.

22. If the Congratulations! screen still does not display and the modem router still does not
connect to the Internet, do the following:

a. Review all your settings.

Make sure that you selected the correct options and entered everything correctly.

Run the Setup Wizard one more time.
Contact your ISP to verify that you are using the correct configuration information.
Read Troubleshoot the Internet Connection on page 280.

If problems persist, register your NETGEAR product and contact NETGEAR
technical support.

® o o o
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Set Up Your Modem Router for Cable or Fiber Service

You can install your modem router for cable or fiber (Ethernet WAN) service or for DSL
service. If you use a cable or fiber modem, follow the procedure that is described in this
section. If you use a DSL modem, follow the procedure that is described in Cable the Modem
Router for DSL Service and Access the Modem Router on page 22.

The following figure shows the cabling of your modem router for cable or fiber service.

Figure 7. Modem router cabling for cable or fiber service

» To connect your modem router to a cable or fiber service:

1. Unplug your cable or fiber modem’s power, leaving the modem connected to the wall
jack for your Internet service.

2. If your cable or fiber modem includes a battery backup, remove the battery.
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Use an Ethernet cable to connect the cable or fiber modem to the red Internet port on the
modem router.

Plug in and turn on your cable or fiber modem.
If your cable or fiber modem includes a battery backup, reinsert the battery.
Connect the power adapter to the modem router and plug it into an electrical outlet.

Wait for the Power LED @ to light solid green, which takes about one minute.
If the Power LED does not light, press the Power On/Off button.

Wait for the WiFi LED @ to light blue.

If the WiFi LED does not light, press the WiFi On/Off button B

Check the DSL LED.

If the modem router is connected to a DSL service, the DSL LED @ lights green.
Connect a computer to the modem router by one of the following methods:

* Ethernet cable. Use an Ethernet cable to connect your computer to a yellow Ethernet
LAN port on the modem router.

The product package contains a yellow Ethernet cable.
Your computer connects to the modem router’'s LAN.
*  WiFi. Connect to the default WiFi network of the modem router:
e. On your computer or WiFi device, find and select the WiFi network.
The WiFi network name (SSID) is on the product label.
f. Join the WiFi network and enter the WiFi password.
The password (network key) is on the product label.
Your computer or WiFi device connects to the modem router's WiFi network.
Note: If the computer is set to a static (fixed) IP address (this setting is
uncommon), either change the computer to obtain an IP address
automatically from the modem router through DHCP, or change the IP
address of the computer to a static IP address in the
192.168.0.2-192.168.0.254 range.
Launch a web browser.

The NETGEAR genie automatic setup utility displays. (This utility is also called the Setup
Wizard.)
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You are not yet connected to the Internet

Do you want NETGEAR Genie to help?
@ ves
(@]

o, l'want to configure the Internet connection myself
© I have saved the router settings in a file and | want to restore the router to those settings.

If the NETGEAR genie automatic setup utility displays, skip to Step 13. If it does not
display, do the following:

a. Inthe address field of the web browser, enter www.routerlogin.net.

b. When prompted, enter admin for the user name and password for the password.
If the NETGEAR genie automatic setup utility displays, skip to Step 13. If the NETGEAR
genie automatic setup utility still does not display, see Step 12.

12. If the browser cannot display the web page, do the following:

* Make sure that the computer is connected to one of the four Ethernet LAN ports or
over WiFi to the modem router.

e Make sure that the Power LED @ of the modem router is lit green.

e Make sure that your browser does not cache the previous page by closing and
reopening the browser.

e Clear the browser cache.

» If the computer is set to a static or fixed IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static or fixed IP
address in the 192.168.0.2-192.168.0.254 range.

13. Click the Next button.
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NETGEAR genie N 4

D6400
Select Country
Country: USA
Select ISP
I1SP: ATAT

Auto-Detect Connection Type
The Smart Setup Wizard can detect the type of Internet connection that you have.
Do you want the Smart Setup Wizard to try and detect the connection type now?

9 Yes
No. | want to configure the router myself.

From the Country menu, select the country in which you use the modem router.
From the ISP menu, select the ISP that you are using.

If your ISP is not in the menu, select Other.

Select the Yes radio button.
Click the Next button.

The Setup Wizard searches your Internet connection for servers and protocols to
determine your ISP configuration.

artimm

e Intarnad Pp——
= INWSTNCL WOl

This process can take up to six minutes; please wait

i
-
~

L)

When the modem router is connected to the Internet, the Congratulations! screen
displays, and you successfully completed the setup process.

If the Congratulations! screen does not display, other screens might display and you
might need to provide more information, in which case you must continue with the next
step. The screens that display depend on your type of ISP connection and configuration.
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Congratulations
You are successfully connected to the Intemet
This router is preset with the following unique wireless network name (SSID) and network key (password)

2.4GHz Wireless Network Name (SSID): NETGEAR23

Wireless Network Key (Password) - jaggedtrumpet276
5GHz Wireless Network Name (SSID): NETGEAR23-5G

Wireless Network Key (Password) - jaggedtrumpet276

18. (Only if the following screen displays) Specify how to manage problems with the detection of
the Internet connection.

The screen that might display states that a problem occurred while the wizard was
detecting the Internet connection. If this screen does not display, continue with the next
step.

Problem Detecting the Internet Connection
This is most likely due 1o one of the following reasons

1. The medem was not power cycled during the cabling step

To solve this problem, power cycls the modem (lum it off and on). To power cycle & modem with battery backup,
you might need to remove and reinsert its battery. After the power cycie, wait 2 minutes for the modem to
completely start up

2. The yellow Etharnet cable is not fully inserted, or is inserted in the wrong place.
To solve this problem, make sure that the yellow Ethemet cable is securely plugged in to the broadband modem
port and the router Internet port

| just power cycled the modem and waited for 2 minutes.

| corrected a problem with the Ethernet cable

None of the above

Note: The option for power cycling the modem router that is stated onscreen
applies to a DSL Internet connection only (see Set Up Your Modem
Router for DSL Service on page 21).

Take one of the following actions:

« If the yellow Ethernet cable is fully inserted in the correct places at the cable or fiber
modem and at the modem router, do the following:

a. Select the None of the above radio button.
b. Click the Next button.
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< If the yellow Ethernet cable is not fully inserted or is inserted at a wrong place, do the
following:

a.

b.
C.

Fully insert the Ethernet cable in the correct port on the cable or fiber modem
and in the red Internet port on the modem router.

Select the | corrected a problem with the Ethernet cable radio button.
Click the Next button.

19. (Only if the following screen displays) Specify how to manage problems with the detection of
the IP address for the Internet connection.

The screen that might display states that a problem occurred while the wizard was
detecting the Internet connection IP address.

Problem Detecting the Internet Connection - IP Address

Did your Internat Service Provider (ISP) assign to you a fixed (static) IP address? This is a very rare special
deployment

Select an option and click Next to proceed
Yes. My ISP assigned a fixed (static) P address to me
No, | did not get a fixed (static) IP address from my ISP

| don't know

Take one of the following actions:

e If your ISP assigned you a fixed (static) IP address, do the following:

a.
b.

Select the Yes radio button.
Click the Next button.

Enter the fixed IP sattings assigned by your Internet Service Provider and click Next to proceed
My IP Address
Subnet Mask
Deafault Gateway
Prefarred DNS Server

Alternate DNS Sarver

Enter the address information that your ISP gave you for your fixed IP address
configuration.
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d. Click the Next button.

e If your ISP did not assign you a fixed IP address or you do not know if your ISP
assigned you a fixed IP address, do the following:

a. Select either the No or the | don’t know radio button.
b. Click the Next button.

Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label
Enter the MAC address here

{format AABBECCDDEEFF)

c. Enter the MAC address of the computer or router with which you previously were
able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the
MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF
format.

d. Click the Next button.

20. If the Congratulations! screen still does not display and the modem router still does not
connect to the Internet, do the following:

a. Review all your settings.

Make sure that you selected the correct options and entered everything correctly.

Run the Setup Wizard one more time.
Contact your ISP to verify that you are using the correct configuration information.
Read Troubleshoot the Internet Connection on page 280.

If problems persist, register your NETGEAR product and contact NETGEAR
technical support.

® o o o

Log In to the Modem Router After Setup to View or
Change Settings

After you set up the modem router for DSL, cable, or fiber service, you can view or change
the settings for the modem router by accessing NETGEAR genie.
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> To log in to the modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.

Note: You can also type http://www.routerlogin.com or http://192.168.0.1.
The procedures in this manual use http://www.routerlogin.net.

The nature of the login screen that displays depends on your Internet browser.

and p d are being req d by http://www login.net. The site says:
"NETGEAR D6400"

User Name:  admin

Password: ssssssss

Cancel |

3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

NETGEAR' . «
G g e n I e Firmware Version

D6400 ¥1.0.0.22_1.0.22
T o

Internet » AT A

Wireless 3 !‘..v‘ I EA v ,ﬂ'.

: Y H H K

Attached Devices > “’ v - G o

Parental Controls 5 Internet Wireless Attached Devices

Ready SHARE o Saniel ceon Name (SSID): NETGEARAT |\ = ices: 1

Key/Password: grandbird1
Guest Network »

® @ @
I“ T N
Ikl “ II
Parental Controls ReadySHARE Guest Network

STATUS: NOT ENABLED STATUS: READY STATUS: NOT ENABLED

Help & Support pocumentation | Onine Support | Router FAQ | GNU GPL SEARCH HELP Bl "co'
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The BASIC Home screen displays a dashboard that lets you see the status of your
Internet connection and network at a glance. You can click any of the six sections of the
dashboard to view more detailed information. The left column displays the menus, and at
the top is an ADVANCED tab that you can use to access more menus and screens.

Change the Language

By default, the language is set as Auto. You can change the language.

» To change the language:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.

In the upper right corner, select a language from the menu.
When prompted, click the OK button to confirm this change.

The screen refreshes with the language that you selected.

Change the admin Password and Automatic Login
Time-Out Period

NETGEAR recommends that you change the default password that you use to log in to the
modem router to a more secure password. This is the password that you use to log in to the
modem router with the user name admin.

The ideal password contains no dictionary words from any language and contains uppercase
and lowercase letters, numbers, and symbols. It can be up to 30 characters.

Note: Thisadmin password is not the password that you use for WiFi access.
The label on your modem router shows your unique WiFi network
name (SSID) and password for WiFi access.
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> To change the password for the user name admin and the login time-out period:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Administration > Set Password.

L mar—ae -

Setup Wizard

» Setup Old Password LITTYTIYY

» USB Functions SetPassword

» Security Repeat New Password
|| Enable Password Recovery
 Administration
Router Status
Loas
Attached Devices
Backup SEEIngS

Set Password

Router Update

» Advanced Setup

Enter the old password.
Enter the new password twice.
To change the automatic login time-out, enter a new value in minutes in the field.

By default, you are logged out of the web management interface after five minutes of
inactivity.

Click the Apply button.

Your settings are saved.

Set Up Password Recovery

NETGEAR recommends that you enable password recovery if you change the password for

the modem router user name admin. Then you can recover the password if it is forgotten.
This recovery process is supported in Internet Explorer, Firefox, and Chrome browsers, but

not in the Safari browser.
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> To set up password recovery:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Administration > Set Password.
The Set Password screen displays.

6. Select the Enable Password Recovery check box.
7. Select two security questions and provide answers to them.
Click the Apply button.

Your settings are saved.

Let the Modem Router Automatically Update Its Firmware

When you set up your modem router and are connected to the Internet, the modem router
automatically checks for you to see if newer firmware is available. If it is, a message is
displayed at the top of the screen. For information about manually upgrading firmware, see
Update the Firmware of the Modem Router on page 222.

> To automatically update the firmware:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Wait for the modem router to check if newer firmware is available.

This process might take a few minutes. If the modem router detects new firmware, the
modem router displays a message at the top of the screen.
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6. Click the message.
7. To upgrade the modem router with the latest firmware, click the Yes button.

After the upgrade, the modem router restarts.

A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
upload. For example, do not close the browser, click alink, or load a
new page. Do not turn off the modem router. Wait until the modem
router finishes restarting and the Power LED turns solid green.

Access the Modem Router with the NETGEAR genie App

The genie app “# is the easy dashboard for managing, monitoring, and repairing your
home network from a smartphone, tablet, or computer. The genie app can help you with the
following:

e Automatically repair common WiFi network problems.

» Easily manage modem router features such as Live Parental Controls, guest access,
Internet traffic meter, speed test, and more.

e Share and stream music or videos.

» To usethe genie app to access the modem router:

1. Visit the NETGEAR genie web page at netgear.com/genie.

2. Follow the onscreen instructions to install the app on your smartphone, tablet, or computer.
3. Launch the genie app.

The genie app dashboard screen displays.

The following figure shows the genie app dashboard for a Windows computer.

g T
NETGEAR genie
g Select Language

Wireless Network: i
n N
WiFi Connection Tl "

\“ 1]
Router Settings
Hetwork Map Internet WiFi Connection Router Settings
Parental Controls STATUS GOOD STATUS Connected Click here
’
ReadySHARE
AirPrint = [ . r = 9
Wetwork Support | - w
= ki -

Network Map Parental Controls ReadySHARE

Number of devices: 7 Click here Click here
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Manage the Internet Settings
Manually

This chapter describes how you can manage the Internet settings of the modem router manually.

Usually, the quickest way to set up the modem router is to allow the NETGEAR genie automatic
setup utility to detect the Internet connection when you first access the modem router with an
Internet browser. These options are described in Chapter 2, Install and Access the Modem
Router and Its Network. You can also customize or specify your Internet settings manually.

The chapter contains the following sections:

L]

Use the Internet Setup Wizard After Initial Setup
Manually Set Up an ADSL Internet Connection
Manually Set Up a VDSL Internet Connection
Manually Set Up a Cable of Fiber Internet Connection
Specify an IPv6 Internet Connection

Manage the MTU Size
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Use the Internet Setup Wizard After Initial Setup

Whether you use DSL service or cable or fiber service, you can use the Setup Wizard to
detect your Internet settings and automatically set up your modem router.

Note: The Setup Wizard is the same as the NETGEAR genie automatic setup
utility that launches the first time you connect to your modem router.

» To use the Setup Wizard:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Setup Wizard.

I v ) —

Sup i Select Country
WPS Wizard | Country : USA v
» Satup Select Interqet SEWTCE Provider
Internet Service Provider : ATET -

» USB Functions

i1 7
» Security Do you want NETGEAR genie to help?

9 Yes

» Administration ") No. | wantto configure the router myself.
» Advanced Setup ! | have saved the router settings in a file and | want to restore the router to those settings.

From the Country menu, select the country in which you use the modem router.

From the Internet Service Provider menu, select the Internet service provider (ISP) that
you are using.

If your ISP is not in the menu, select Other.
Select the Yes radio button.

If you select the No radio button, you are taken to the Internet Setup screen after you
click the Next button (see Manually Set Up an ADSL Internet Connection on page 47).

Click the Next button.
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The Setup Wizard searches your Internet connection for servers and protocols to
determine your ISP configuration.

stecting the Internet Connection

This process can take up to six minutes; please wait

“'
<
"w

When the modem router is connected to the Internet, the Congratulations! screen
displays, and you successfully completed the setup process.

If the Congratulations! screen does not display, other screens might display and you
might need to provide more information, in which case you must continue with the next
step. The screens that display depend on your type of ISP connection and configuration.

You are successfully connected to the Intemet

This router is preset with the following unique wireless network name (SSID) and network key (password

2.4GHz Wireless Network Name (SSID): NETGEAR23

Wireless Metwork Key (Password) jaggedtrumpet276
5GHz Wireless Network Name (SSID): NETGEAR23-5G

Wireless Network Key (Password) : jaggedtrumpet276

10. (Only if the following screen displays) Specify a full scan to let the Setup Wizard find the
PVC protocol.

The screen that might display asks you if you need the Setup Wizard to do a full scan to
find the PVC protocol. If this screen does not display, continue with the next step.

Do you need Satup Wiarand 1o do full sean to find the PVC/Prolocal?
® Yas. (This will take approximolely 1 10 6 minutes)

Mo | want to configure the router mysalf

Do the following:

a. Select the Yes radio button.
b. Click the Next button.
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The Setup Wizard performs a full scan, which might take up to six minutes.

This takes approximately 1 to 6 minutes

e,
-
-

11. (Only if the following screen displays) Specify how to manage problems with the detection of
the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet
connection. If this screen does not display, continue with the next step.

Problem Detecting the Internet Connection
This is most likely due to one of the following reasons

1. The modem was not power cycled during the cabling step

To solvi this problem, power cycle the modem (turn it off and on). To power cycle a modem with battery backup,
you might need to remove and reinsert its battery After the power cycle, wart 2 minutes for the modem to
complelely start up.

2. The yellow Ethernet cable is not fully inserted, or is inserted in the wrong place
Teo selve this problem, make sure that the yellow Ethernet cable is securely plugged in to the broadband modem
port and the router Internet port

I just power cycled the modem and waited for 2 minutes.

| comected a problem with the Ethernet cable

Mone of the above

Take one of the following actions:

e If your setup includes a DSL modem, power cycle the DSL modem:

a. Unplug your DSL modem’s power, leaving the DSL modem connected to the wall
jack for your Internet service.

If your DSL modem includes a battery backup, remove the battery.
Wait 10 seconds.

If your DSL modem includes a battery backup, reinsert the battery.
Plug in your DSL modem’s power and turn on your DSL modem.
Wait two minutes.

Q@ &~ o o o T

Select the | just power cycled the modem and waited for 2 minutes radio
button.

h. Click the Next button.
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* If your setup includes a cable or fiber modem, see if the yellow Ethernet cable is not
fully inserted or is inserted at the wrong place. If necessary, do the following:

a. Fully insert the Ethernet cable in the correct port on the cable or fiber modem
and in the red Internet port on the modem router.

b. Select the | corrected a problem with the Ethernet cable radio button.

c. Click the Next button.

e If you do not need to power cycle the DSL modem or the Ethernet cable is already
fully inserted in the correct ports, do the following:

a. Select the None of the above radio button.
b. Click the Next button.

12. (Only if the following screen displays) Specify how to manage problems with the detection of
the IP address for the Internet connection.

The screen that might display states that a problem occurred while detecting the Internet
connection IP address.

Problem Detecting the Internet Connection - IP Address

Did your Internat Service Provider (ISP) assign to you a fived (static) IP address? This is a very rare special
deployment

Salect an option and click Next to proceed
Yes. My ISP assigned a fixed (static) IP address to me
No, | did not get a fixed (static) IP address from my ISP

| don't know

Take one of the following actions:
e If your ISP assigned you a fixed (static) IP address, do the following:

a. Select the Yes radio button.
b. Click the Next button.
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Enter the fixed IP sattings assigned by your Internet Service Provider and click Next to proceed
My IP Addreas
Subnet Mask
Deafault Gateway
Prefarred DNS Server

Alternate DNS Sarver

c. Enter the address information that your ISP gave you for your fixed IP address
configuration.

d. Click the Next button.

e If your ISP did not assign you a fixed IP address or you do not know if your ISP
assigned you a fixed IP address, do the following:

a. Select either the No or the | don’t know radio button.
b. Click the Next button.

Problem Detecting the Internet Connection - MAC Address

If you previously connected to your Internet service with a computer or another router, NETGEAR Genie can use
the same MAC address that worked before

A MAC address is a unique number. You can find the MAC address of the computer or router on its product label

Enter the MAC address here

(format AABECCDDEEFF)

c. Enter the MAC address of the computer or router with which you previously were
able to connect to the Internet.

You might find the MAC address on the product label of your device. Enter the
MAC address in the AABBCCDDEEFF format, not in the AA:BB:CC:DD:EE:FF
format.

d. Click the Next button.

13. If the Congratulations! screen still does not display and the modem router still does not
connect to the Internet, do the following:

a. Review all your settings.
Make sure that you selected the correct options and entered everything correctly.

b. Run the Setup Wizard one more time.
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c. Contact your ISP to verify that you are using the correct configuration information.
Read Troubleshoot the Internet Connection on page 280.

If problems persist, register your NETGEAR product and contact NETGEAR
technical support.

Manually Set Up an ADSL Internet Connection

You can view or change the modem router’s ADSL Internet connection settings manually.
The following sections describe the options that are available to you to manually set up the
ADSL Internet connection:

e Specify an ADSL Connection Without a Login Requirement on page 47

e Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service
on page 51

Note: Some ISPs require that you register on their website before you can
obtain Internet service. Follow the directions that your ISP gave you.

Specify an ADSL Connection Without a Login Requirement

If you want to manually configure the ADSL connection settings, use the information that your
ISP gave you to connect to your Internet service. If you cannot find this information, contact
your ISP. Entering incorrect information might prevent the modem router from connecting to
the Internet.

> To view or specify the settings for an ADSL Internet connection that does not require a
login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

The BASIC Home screen displays.
5. Select Internet.

The Internet Setup screen displays.

6. Scroll down to the Does your Internet connection require a login? section and select the No
radio button.
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As an example, the following figure already shows the settings that display when you
configure an ADSL connection.

( BASIC

Home

Wireless

Attached Devices

Ld

Parental Controls

Ready SHARE

Guest Network

]

CTED

Auto -

Select Country USA -
Select Internet Service Provider Other -

Transfer Mode ATM -
DSL Mode Auto v

WANT -

/| Enable This Interface
Multiplexing Method VC-BASED
VPI 0

VCI 35

4
m

[Fuse vLANID B
Prigrity (802.1p) 0

Does your Internet connection require a login?

® Yes
@ No

Account Name (If Required)
Domain Name (If Required)

Internet IP Address

@ Get Dynamically from ISP

) Use Static IP Address
IP Address 192 |. (168 |. (100 |. |150
IP Subnet Mask 255 |. [255 |. |255 |. 0
Gateway IP Address 192 |. |168 |. |100 |. |1

) Use IP Over ATM (IPoA)
IP Address 0 - |0 . |0 + [
IP Subnet Mask 1] . |0 . |0 . |0
Gateway IP Address ] . |0 ] « o

Domain Name Server (DNS) Address
© Get Automatically from ISP
) Use These DNS Servers
Primary DNS 192 |. |168 (. |100 |. |1

Secondary DNS . . .

MNAT {Network Address Translation)
© Enable
© Disable

Router MAC Address
9 Use Default Address
) Use Computer MAC Address
@) Use This MAC Address 80:37:73:C6:BB:E8

DHCP Options
Vendor Class Identifier String (option 50)

Class Identifier String (option 61)
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7. Enter the ADSL settings as described in the following table.

Field

Description

Select Country

Select the country in which you use the modem router.

Select Internet Service
Provider

Select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.

Transfer Mode

For an ADSL connection, select ATM.

DSL Mode

Select the ADSL mode that your ISP provided you:

e Auto. The modem router detects the DSL mode automatically. This is
the default setting.

e« ADSL. Legacy version of ADSL.
e« ADSL2. Legacy version of ADSL2.

 ADSL2+. ADSL2+ provides the fastest downstream rates and can
interoperate with ADSL2 and ADSL.

Enable This Interface

Make sure that WANL1 is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

Select LLC-BASED or VC-BASED, as indicated by your ISP.

The multiplexing method can either be virtual circuit (VC) based or logical
link control (LLC) based.

VPI

Enter a number between 0 and 255 for the virtual circuit number for the
virtual path identifier (VPI), as indicated by your ISP.

If your ISP did not provide you with a VPI setting, leave the default setting
(0). The VPI might be required not only for a VC-based connection but also
for an LLC-based connection.

VCI

Enter a number between 32 and 65535 for the virtual circuit number for the
virtual channel identifier (VCI), as indicated by your ISP.

If your ISP did not provide you with a VCI setting, leave the default setting
(35). The VCI might be required not only for a VC-based connection but
also for an LLC-based connection.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. If your ISP did not provide you with a VLAN ID, leave the Use
VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).
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Field Description

Account Name (If Required) | Enter the account name, as indicated by your ISP. This name might also be
called the host name.

If your ISP did not provide you with an account name or host name, leave
this field blank.

Domain Name (If Required) | Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address

Get Dynamically from ISP Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.

Use IP over ATM (IPoA) Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for IPOA service. The gateway is the ISP router to which
your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

e Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

¢ Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.
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Field Description

DHCP Options

Vendor Class Identifier String | Enter the vendor class identifier (VCI) string, as indicated by your ISP.

(option 60) If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String Enter the client identifier (client ID) string, as indicated by your ISP,
(option 61) If your ISP did not provide you with a client ID string, leave this field blank.

Click the Apply button.
Your settings are saved.
Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.

Specify an ADSL Connection with a Login Requirement and
PPPoA or PPPoOE Service

If you want to manually configure the ADSL connection settings, use the information that your
ISP gave you to log in and connect to your Internet service. If you cannot find this
information, contact your ISP. Entering incorrect information might prevent the modem router
from connecting to the Internet.

To view or specify the settings for an ADSL Internet connection that requires a login
and uses a PPPoE or PPPOA service:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.
Select Internet.

The Internet Setup screen displays.

Scroll down to the Does your Internet connection require a login? section and select the Yes
radio button.

As an example, the following figure already shows the settings that display when you
configure an ADSL connection.
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[ BASIC

Home

Internet »

Wireless

| (e

e Internet Setup

Attached Devices

Select Country USA

Parental Controls

Ready SHARE

Guest Network

Select Internet Service Provider ATAT

Transfer Mode
DSL Mode

ATM

WANT v
Enable This Interface
Multiplexing Method
VP
vel

VC-BASED -

35

[Cluse vianD
Priarity (802.1p)

Does your Internet connection require a login?
@ Yes
|_‘_| No

Encapsulation PPPo

E -

Login
Password

guest

Service Name (If Required)
Connection Mode
Idle Timeout{in Minutes)

Always On -

Internet IP Address
@ Get Dynamically from ISP

© Use Static IP Address 192

-|168 |./100 |./150

Domain Name Server (DNS) Address
@ Get Automatically from ISP
) Use These DNS Servers

Primary DNS 192

Secondary DNS

-|168

-j100 [.11

Add Translation)

NAT (N
® Enable
) Disable

Router MAC Address

@ Use Default Address

) Use Computer MAC Address
© Use This MAC Address

80:37:73:C6:BB:ES8
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7. Enter the ADSL settings as described in the following table.

Field

Description

Select Country

Select the country in which you use the modem router.

Select Internet Service
Provider

Select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.

Transfer Mode

For an ADSL connection, select ATM.

DSL Mode

Select the ADSL mode that your ISP provided you:

e Auto. The modem router detects the DSL mode automatically. This is
the default setting.

e« ADSL. Legacy version of ADSL.
e« ADSL2. Legacy version of ADSL2.

 ADSL2+. ADSL2+ provides the fastest downstream rates and can
interoperate with ADSL2 and ADSL.

Enable This Interface

Make sure that WANL1 is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

Select LLC-BASED or VC-BASED, as indicated by your ISP.

The multiplexing method can either be virtual circuit (VC) based or logical
link control (LLC) based.

VPI

Enter a number between 0 and 255 for the virtual circuit number for the
virtual path identifier (VPI), as indicated by your ISP.

If your ISP did not provide you with a VPI setting, leave the default setting
(0). The VPI might be required not only for a VC-based connection but also
for an LLC-based connection.

VCI

Enter a number between 32 and 65535 for the virtual circuit number for the
virtual channel identifier (VCI), as indicated by your ISP.

If your ISP did not provide you with a VCI setting, leave the default setting
(35). The VCI might be required not only for a VC-based connection but
also for an LLC-based connection.

Use VLANID

Select the Use VLANID check box and enter the VLAN ID, as indicated by
your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. If your ISP did not provide you with a VLAN ID, leave the Use
VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).
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Field

Description

Encapsulation

Select the encapsulation, as indicated by your ISP:
e PPPoE. Your Internet connection uses PPP over Ethernet.
* PPPOA. Your Internet connection uses PPP over ATM.

Login Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password Enter the password that you use to log in to your Internet service, as

indicated by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.

Often, a service name is not required.

Note: This field does not display if your selection from the Encapsulation
menu is PPPOA.

Connection Mode

Select how the Internet connection functions:

« Always On. Once the Internet connection is established, it remains on.
This is the default setting.

< Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

¢« Manually Connect. You must connect to the Internet manually (see
View, Renew, or Release a TCP/IP Internet Connection on page 235 or
View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection
on page 237).

Idle Timeout (In Minutes)

If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter O.
(When you disable the idle time-out, the connection is not terminated
automatically).

Internet IP Address

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway |IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP

Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.
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Field Description

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

« Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

e Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

8. Click the Apply button.
Your settings are saved.
9. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.
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Manually Set Up a VDSL Internet Connection

You can view or change the modem router’s VDSL Internet connection settings manually.
The following sections describe the options that are available to you to manually set up the
VDSL Internet connection:

e Specify a VDSL Connection Without a Login Requirement on page 56
e Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 60

Note: Some ISPs require that you register on their website before you can
obtain Internet service. Follow the directions that your ISP gave you.

Specify a VDSL Connection Without a Login Requirement

If you want to manually configure the VDSL connection settings, use the information that your
ISP gave you to connect to your Internet service. If you cannot find this information, contact
your ISP. Entering incorrect information might prevent the modem router from connecting to
the Internet.

> To view or specify the settings for a VDSL Internet connection that does not require a
login:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

The BASIC Home screen displays.
5. Select Internet.

The Internet Setup screen displays.

6. Scroll down to the Does your Internet connection require a login? section and select the No
radio button.

As an example, the following figure already shows the settings that display when you
configure a VDSL connection.
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7. Enter the VDSL settings as described in the following table.

Field

Description

Select Country

Select the country in which you use the modem router.

Select Internet Service
Provider

Select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.

Transfer Mode

For a VDSL connection, select PTM.

DSL Mode

When you select PTM from the Transfer Mode menu, the only option in the
DSL Mode menu is VDSL.

Enable This Interface

Make sure that WANL1 is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

These settings are disabled because they do not apply to a VDSL

VPI connection.
VCI
Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated by

your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. In some unusual situations, a VLAN ID is required for VDSL
Internet service. If your ISP did not provide you with a VLAN ID, leave the
Use VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Account Name (If Required)

Enter the account name, as indicated by your ISP. This name might also be
called the host name.

If your ISP did not provide you with an account name or host name, leave
this field blank.

Domain Name (If Required)

Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.
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Field Description

Use IP over ATM (IPoA) Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for IPOA service. The gateway is the ISP router to which
your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

« Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

« Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

DHCP Options

Vendor Class Identifier String | Enter the vendor class identifier (VCI) string, as indicated by your ISP.

(option 60) If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String Enter the client identifier (client ID) string, as indicated by your ISP.
(option 61) If your ISP did not provide you with a client ID string, leave this field blank.

8. Click the Apply button.
Your settings are saved.
9. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.

Manage the Internet Settings Manually
59

Download from Www.Somanuals.com. All Manuals Search And Download.



AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Specify a VDSL Connection with a Login Requirement and
PPPOE Service

If you want to manually configure the VDSL connection settings, use the information that your
ISP gave you to log in and connect to your Internet service. If you cannot find this information,
contact your ISP. Entering incorrect information might prevent the modem router from
connecting to the Internet.

To view or specify the settings for a VDSL Internet connection that requires a login
and uses a PPPOE service:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.
Select Internet.

The Internet Setup screen displays.

Scroll down to the Does your Internet connection require a login? section and select the Yes
radio button.

As an example, the following figure already shows the settings that display when you
configure a VDSL connection.
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7. Enter the VDSL settings as described in the following table.

Field

Description

Select Country

Select the country in which you use the modem router.

Select Internet Service
Provider

Select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.

Transfer Mode

For a VDSL connection, select PTM.

DSL Mode

When you select PTM from the Transfer Mode menu, the only option in the
DSL Mode menu is VDSL.

Enable This Interface

Make sure that WANL1 is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

These settings are disabled because they do not apply to a VDSL

VPI connection.
VCI
Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated by

your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. In some unusual situations, a VLAN ID is required for VDSL
Internet service. If your ISP did not provide you with a VLAN ID, leave the
Use VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Encapsulation

For a PPP over Ethernet (PPPOE) connection, select PPPoE from the
menu.

Note: PPP over ATM (PPPoA) is not supported for a VDSL connection.

Login Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password Enter the password that you use to log in to your Internet service, as

indicated by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.

Often, a service name is not required.

Manage the Internet Settings Manually

62

Download from Www.Somanuals.com. All Manuals Search And Download.




AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Field Description

Connection Mode Select how the Internet connection functions:

* Always On. Once the Internet connection is established, it remains on.
This is the default setting.

- Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

e Manually Connect. You must connect to the Internet manually (see
View, Renew, or Release a TCP/IP Internet Connection on page 235 or
View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection
on page 237).

Idle Timeout (In Minutes) If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically).

Internet IP Address

Get Dynamically from ISP Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

« Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.
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Field Description

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

8. Click the Apply button.
Your settings are saved.
9. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.

Manually Set Up a Cable of Fiber Internet Connection

You can view or change the modem router’s cable or fiber Internet connection settings
manually. The following sections describe the options that are available to you to manually
set up the cable or fiber Internet connection:

e Specify a Cable or Fiber Connection Without a Login Requirement on page 65

e Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service on
page 69

Note: Some ISPs require that you register on their website before you can
obtain Internet service. Follow the directions that your ISP gave you.

Note: If you connect both a DSL modem and a cable or fiber modem to the
modem router and you want to manually specify the settings for a
cable or fiber Internet connection, you must first set the WAN
connection preference manually to the Ethernet WAN port (see
Change the Physical WAN Connection Preference on page 197). If
you do not, the DSL settings take precedence over the cable or fiber
settings. However, NETGEAR recommends that you connect only the
modem that you intend to use for your Internet connection: a DSL
modem, cable modem, or fiber modem.
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Specify a Cable or Fiber Connection Without a Login
Requirement

If you want to manually configure the cable or fiber connection settings, use the information
that your ISP gave you to connect to your Internet service. If you cannot find this information,
contact your ISP. Entering incorrect information might prevent the modem router from
connecting to the Internet.

To view or specify the settings for a cable or fiber Internet connection that does not
require alogin:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

The BASIC Home screen displays.
5. Select Internet.

The Internet Setup screen displays.

6. Scroll down to the Does your Internet connection require a login? section and select the No
radio button.

As an example, the following figure already shows the settings that display when you
configure a cable or fiber connection.
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7. Enter the cable or fiber settings as described in the following table.

Field

Description

Select Country

Select the country in which you use the modem router.

Select Internet Service
Provider

Select the Internet service provider (ISP) that you are using.
If your ISP is not in the menu, select Other.

Transfer Mode

DSL Mode

These settings are not disabled but do not apply to a cable or fiber
connection. You can ignore these settings.

Enable This Interface

Make sure that WANL is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

These settings are not disabled but do not apply to a cable or fiber

VPI connection. You can ignore these settings.
VCI
Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated by

your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. If your ISP did not provide you with a VLAN ID, leave the Use
VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Account Name (If Required)

Enter the account name, as indicated by your ISP. This name might also be
called the host name.

If your ISP did not provide you with an account name or host name, leave
this field blank.

Domain Name (If Required)

Enter the domain name, as indicated by your ISP.
If your ISP did not provide you with a domain name, leave this field blank.

Internet IP Address

Get Dynamically from ISP

Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address

Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.

Use IP over ATM (IPoA)

Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for IPOA service. The gateway is the ISP router to which
your modem router connects.
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Field Description

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

¢ Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

« Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

DHCP Options

Vendor Class Identifier String | Enter the vendor class identifier (VCI) string, as indicated by your ISP.

(option 60) If your ISP did not provide you with a VCI string, leave this field blank.
Client Identifier String Enter the client identifier (client ID) string, as indicated by your ISP,
(option 61) If your ISP did not provide you with a client ID string, leave this field blank.

8. Click the Apply button.
Your settings are saved.
9. Click the Test button to test your Internet connection.

If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.
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Specify a Cable or Fiber Connection With a Login Requirement
and PPPoOE Service

If you want to manually configure the cable or fiber connection settings, use the information

that your ISP gave you to log in and connect to your Internet service. If you cannot find this

information, contact your ISP. Entering incorrect information might prevent the modem router
from connecting to the Internet.

To view or specify the settings for a cable or fiber Internet connection that requires a
login and uses a PPPoE service:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.
Select Internet.

The Internet Setup screen displays.

Scroll down to the Does your Internet connection require a login? section and select the No
radio button.

As an example, the following figure already shows the settings that display when you
configure a cable or fiber connection.
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7. Enter the cable or fiber settings as described in the following table.

Field Description

Select Country Select the country in which you use the modem router.
Select Internet Service Select the Internet service provider (ISP) that you are using.
Provider If your ISP is not in the menu, select Other.
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Field

Description

Transfer Mode

DSL Mode

These settings are not disabled but do not apply to a cable or fiber
connection. You can ignore these settings.

Enable This Interface

Make sure that WANL is selected from the menu and that the Enable This
Interface check box is selected. These are the default settings.

Note: For information about interface WAN2, see Enable the WAN2
Interface for IPTV on page 197.

Multiplexing Method

These settings are not disabled but do not apply to a cable or fiber

VPI connection. You can ignore these settings.
VCI
Use VLANID Select the Use VLANID check box and enter the VLAN ID, as indicated by

your ISP.

A VLAN ID might be required if you subscribe to both Internet service and
IPTV service. If your ISP did not provide you with a VLAN ID, leave the Use
VLANID check box cleared, which is the default setting.

For information about setting up VLAN tag groups, see Set Up a Bridge for
a VLAN Tag Group on page 202.

Priority (802.1p)

If your ISP provided you with a VLAN ID and a priority value, enter the
priority value, which is a number from 0 to7.

You can enter a priority value only in combination with a VLAN ID. If your
ISP did not provide you with a priority value, leave the default setting (0).

Encapsulation

For a PPP over Ethernet (PPPOE) connection, select PPPoE from the
menu.

Note: PPP over ATM (PPPoA) is not supported for a cable or fiber
connection.

Login Enter the login name that you use to log in to your Internet service, as
indicated by your ISP.
This login name is often an email address.

Password Enter the password that you use to log in to your Internet service, as

indicated by your ISP.

Service Name (If Required)

Enter the service name that you use to log in to your Internet service, as
indicated by your ISP.

Often, a service name is not required.

Connection Mode

Select how the Internet connection functions:

« Always On. Once the Internet connection is established, it remains on.
This is the default setting.

- Dial on Demand. When someone attempts to connect to the Internet,
the Internet connection is established. When the idle time-out period
expires, the Internet connection is terminated.

« Manually Connect. You must connect to the Internet manually (see
View, Renew, or Release a TCP/IP Internet Connection on page 235 or
View, Connect, or Disconnect a PPPoE or PPPoA Internet Connection
on page 237).
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Field Description

Idle Timeout (In Minutes) If you select Dial on Demand from the Connection Mode menu, enter the
idle time-out period in minutes.

The idle time-out specifies how long the modem router keeps the Internet
connection active when no one on the network is using the Internet
connection. The default is 5 minutes. To disable the idle time-out, enter 0.
(When you disable the idle time-out, the connection is not terminated
automatically).

Internet IP Address

Get Dynamically from ISP Your ISP uses DHCP to assign your IP address. Your ISP automatically
assigns these addresses.

Use Static IP Address Enter the IP address, IP subnet mask, and gateway IP address that your
ISP assigned you for static IP address service. The gateway is the ISP
router to which your modem router connects.

Domain Name Server (DNS) Address
The DNS server is used to look up site addresses based on their domain names.

Get Automatically from ISP Your ISP uses DHCP to assign your DNS servers. Your ISP automatically
assigns this address.

Use These DNS Servers If you know that your ISP does not automatically transmit DNS addresses
to the modem router during login, select this option and enter the IP
address of your ISP primary DNS server. If a secondary DNS server
address is available, enter it also.

NAT (Network Address Translation)

NAT allows computers on your home network to share the modem router Internet connection. NAT is

enabled by default because it is required in most situations. Select the NAT setting:

e Enable. NAT is enabled. This is the default setting. Leave this setting if no reason to disable NAT
exists.

* Disable. NAT is disabled.

Router MAC Address

The Ethernet MAC address that the modem router uses on the Internet port. Some ISPs register the MAC
address of the network interface card in your computer when your account is first opened. They accept
traffic only from the MAC address of that computer. This feature allows your modem router to use your
computer’s MAC address (also called cloning).

Use Default Address Use the default MAC address.

Use Computer MAC Address | The modem router captures and uses the MAC address of the computer
that you are now using. You must use the one computer that is registered
by the ISP.

Use This MAC Address Enter the MAC address that you want to use. By default, the field displays
the MAC address of the Internet port.

8. Click the Apply button.
Your settings are saved.

9. Click the Test button to test your Internet connection.
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If the NETGEAR website does not display within one minute, see Troubleshoot the
Internet Connection on page 280.

Specify an IPv6 Internet Connection

If you want to use an IPv6 Internet connection, you must specify the settings manually.
NETGEAR genie does not detect an IPv6 Internet connection automatically.

IPv6 Internet Connections and IPv6 Addresses

The modem router can support an IPv6 Internet connection through the following connection
types:

Auto Detect. For more information, see Set Up an IPv6 Connection Through Auto Detect
on page 74.

6to4 tunnel. For more information, see Set Up an IPv6 6to4 Tunnel Connection on
page 76.

Pass-through. For more information, see Set Up an IPv6 Pass-Through Connection on
page 77.

Fixed. For more information, see Set Up an IPv6 Fixed Connection on page 78.
DHCP. For more information, see Set Up an IPv6 DHCP Connection on page 80.

PPP over Ethernet. For more information, see Set Up an IPv6 PPPoE Connection on
page 82.

Auto Config. For more information, see Set Up an IPv6 Connection Through Auto Config
on page 84.

6rd tunnel. For more information, see Set Up an IPv6 6rd Tunnel Connection on
page 86.

Which connection type you must use depends on your IPv6 ISP. Follow the directions that
your IPv6 ISP gave you.

If your ISP did not provide details, use the 6to4 tunnel connection type (see Set Up an
IPv6 6to4 Tunnel Connection on page 76).

If you are not sure what type of IPv6 connection the modem router uses, use the Auto
Detect connection type, which lets the modem router detect the IPv6 type that is in use
(see Set Up an IPv6 Connection Through Auto Detect on page 74).

If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or
pass-through but is IPv6, use the Auto Config connection type, which lets the modem
router autoconfigure its IPv6 connection (see Set Up an IPv6 Connection Through Auto
Config on page 84).

When you enable IPv6 and select any connection type other than IPv6 pass-through, the
modem router starts the stateful packet inspection (SPI) firewall function on the WAN
interface. The modem router creates connection records and checks every inbound IPv6
packet. If the inbound packet is not destined to the modem router itself and the modem router
does not expect to receive such a packet, or the packet is not in the connection record, the
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modem router blocks this packet. This function works in two modes: In secured mode, the
modem router inspects both TCP and UDP packets. In open mode, the modem router
inspects UDP packets only.

IPv6 addresses are denoted by eight groups of hexadecimal quartets that are separated by
colons. You can reduce any four-digit group of zeros within an IPv6 address to a single zero
or omit it. The following errors invalidate an IPv6 address:

* More than eight groups of hexadecimal quartets
e More than four hexadecimal characters in a quartet
* More than two colons in a row

Set Up an IPv6 Connection Through Auto Detect

If you are not sure what type of IPv6 connection the modem router uses, use the Auto Detect
connection type, which lets the modem router detect the IPv6 type that is in use.
To set up an IPv6 Internet connection through auto detection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select Auto Detect.
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ADVANCED Home
e — ooty » Il X carcer i G staus etresh
WPS Wizard )
’ Internet Connection Type Auto Detect  ~
» Setup
" Connection Type DHCP/Auto Detect
» USB Functions
Router's IPv6 Address On WAN

» Security Not Available
» Administration LAN Setup

i i Router's IPv6 Address On LAN
zidvanced elup Not Available

Wireless Settings IP Address Assignment

Wireless AP Use DHCP Server

Port Forwarding / Port @ auto Config

Trigaering

Dynamic DNS

VPN Service

Static Routes
Remote Management
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[ use This Interface ID

Traffic Meter
USB Settings
Device Mode

The modem router automatically detects the information in the following fields:

Connection Type. This field indicates the connection type that is detected.

Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired
for the modem router's WAN (or Internet) interface. The number after the slash (/) is
the length of the prefix, which is also indicated by the underline (_) under the IPv6
address. If no address is acquired, the field displays Not Available.

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired
for the modem router’s LAN interface. The number after the slash (/) is the length of
the prefix, which is also indicated by the underline () under the IPv6 address. If no
address is acquired, the field displays Not Available.

Select an IP Address Assignment radio button:

Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPvV6 client
function.

Auto Config. This is the default setting.

To specify the interface ID for the IPv6 address of the modem router's LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

Click the Apply button.

Your settings are saved.
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Set Up an IPv6 6to4 Tunnel Connection

With an IPv6 connection, your modem router creates a 6to4 tunnel to a remote relay router.
Make sure that the IPv4 Internet connection is working before you apply the 6to4 tunnel
settings for the IPv6 connection.

Note: Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 Internet connection by using a 6to4 tunnel:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.

3. Enter the modem router user name and password.
The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select 6to4 Tunnel.

ADVANCED Home ]

ADVANCED 1 Auto -

» Administration
w Advanced Setup

Wireless Settings

_) Static IP Address

Setup Wizard ) o m G Status Refresh
WPS Wizard
_' Internet Connection Type Gtod Tunnel -
» Sefup
» USE Functions Remote 6to4 Relay Router
@ Auto
» Security

IPv6 Domain Name Server (DNS) Address
@ Get Automatically from ISP
2 Use These DNS Servers

Wireless AP Primary DNS
Port Forwarding / Port
Triggering Secondary DNS
Dynamic DNS
VPN Service LAN Setup
Static Routes Router's IPvﬁ Address On LAN
Remote Management Not Available
IP Address Assignment
UPnP 3
N ...
e
Traffic Meter 2 Auto Config
USB Settings = .
Device Mode "/ Use This Interface ID
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The modem router automatically detects the information in the Router’s IPv6 Address On
LAN field. This field shows the IPv6 address that is acquired for the modem router’'s LAN
interface. The number after the slash (/) is the length of the prefix, which is also indicated
by the underline () under the IPv6 address.

7. Select a Remote 6to4 Relay Router radio button:

e Auto. Your modem router uses any remote relay modem router that is available on
the Internet. This is the default setting.

e Static IP Address. Enter the static IPv4 (not IPv6) address of the remote relay
modem router. Your IPv6 ISP usually provides this address.
8. Select an IPv6 Domain Name Server (DNS) Address radio button:

e Get Automatically from ISP. The ISP’s DHCP server automatically assigns IPv6
DNS server addresses.

e Use These DNS Servers. Enter the static IPv6 (not IPv4) DNS server addresses that
your ISP provided to you.
9. Select an IP Address Assignment radio button:

* Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPV6 client
function. This is the default setting.

« Auto Config. The modem router automatically configures its IPv6 address based on the
IPv6 protocol.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

11. Click the Apply button.

Your settings are saved.

Set Up an IPv6 Pass-Through Connection

In IPv6 pass-through mode, the modem router works as a Layer 2 Ethernet switch with two
ports (LAN and WAN Ethernet ports) for IPv6 packets. The modem router does not process
any IPv6 header packets.

Note: Follow the directions that your IPv6 ISP gave you.

» To set up an IPv6 pass-through Internet connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.

A login screen displays.
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3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.
6. From the Internet Connection Type menu, select Pass Through.
The screen adjusts, but no additional fields display.
7. Click the Apply button.
Your settings are saved.

Set Up an IPv6 Fixed Connection

A fixed IPv6 connection is based on a static or fixed IPv6 address that your IPv6 ISP gave
you.

Note: Follow the directions that your IPv6 ISP gave you.

To set up afixed IPv6 Internet connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select Fixed.
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(——

ADVANCED Home
Setup Wizard

» Setup
» USB Functions

» Security

ADVANCED ]

Internet Connection Type

Fixed

Auto

WAN Setup
IPvE AddressiPrefix Length

» Administration Default IPvG Gateway

w Advanced Setup ]
Primary DNS

Wireless Settings k

Wireless AP

Port Forwarding / Port

Triggering

Dynamic DNS

VPN Service

Static Routes

Remote Management

UPnP

Secondary DNS

LAN Setup
IP Address Assignment
Use DHCP Server
2@ Auto Config
1Pv6 Address/Prefix Length

Traffic Meter
USB Settings
Device Mode

Configure the fixed IPv6 addresses for the WAN connection:

e IPv6 Address/Prefix Length. The IPv6 address and prefix length of the modem
router WAN interface that your ISP provided to you.

Default IPv6 Gateway. The IPv6 address of the default IPv6 gateway for the modem
router's WAN interface that your ISP provided to you.

Primary DNS. The primary DNS server that resolves IPv6 domain nhame records for
the modem router that your ISP provided to you.

Secondary DNS. The secondary DNS server that resolves IPv6 domain name
records for the modem router that your ISP provided to you.

Note: If you do not specify the DNS servers, the modem router uses the DNS
servers that are configured for the IPv4 Internet connection on the
Internet Setup screen (see Manually Set Up an ADSL Internet
Connection on page 47).

Select an IP Address Assignment radio button:

e Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPv6 client
function. This is the default setting.

Auto Config. The modem router automatically configures its IPv6 address based on the
IPv6 protocol.

In the IPv6 Address/Prefix Length fields, specify the static IPv6 address and prefix length
of the modem router’'s LAN interface.
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If you do not specify an address here, the modem router generates one automatically
from its MAC address.

10. Click the Apply button.

Your settings are saved.

Set Up an IPv6 DHCP Connection

An IPv6 DHCP connection is based on a dynamic IPv6 address that a DHCPv6 server
assigns to the modem router.

Note: Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 Internet connection with a DHCP server:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select DHCP.
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The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired
for the modem router’'s WAN (or Internet) interface. The number after the slash (/) is
the length of the prefix, which is also indicated by the underline (_) under the IPv6
address. If no address is acquired, the field displays Not Available.

Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired
for the modem router’s LAN interface. The number after the slash (/) is the length of
the prefix, which is also indicated by the underline () under the IPv6 address. If no

address is acquired, the field displays Not Available.

If your IPv6 ISP gave you a specific host name, in the User Class (If Required) field,
enter the host name.

If your IPv6 ISP did not give you a specific host name, you can leave this field blank.
To specify a domain name, in the Domain Name (If Required) field, enter a domain name.

If your ISP gave you a specific domain name, enter it in this field. (For example, Earthlink
Cable might require a host name of home, and Comcast sometimes supplies a domain
name.)

If your ISP did not give you a specific domain name, you can either leave this field blank
or enter the domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4
ISP here.) For example, if your ISP’s mail server is mail.xxx.yyy.zzz, enter Xxx.yyy.zzz as
the domain name.
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9. Select an IP Address Assignment radio button:

e Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPvV6 client
function. This is the default setting.

e Auto Config. The modem router automatically configures its IPv6 address based on the
IPv6 protocol.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

11. Click the Apply button.

Your settings are saved.

Set Up an IPv6 PPPoE Connection

An IPv6 PPPoE connection is based on a dynamic IPv6 address that a PPPoE service
assigns to the modem router.

Note: Follow the directions that your IPv6 ISP gave you.

To set up an IPv6 PPPoE Internet connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select PPPoE.
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The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address On WAN. This field shows the IPv6 address that is acquired
for the modem router's WAN (or Internet) interface. The number after the slash (/) is
the length of the prefix, which is also indicated by the underline (_) under the IPv6
address. If no address is acquired, the field displays Not Available.

Router’s IPv6 Address On LAN. This field shows the IPv6 address that is acquired
for the modem router’'s LAN interface. The number after the slash (/) is the length of
the prefix, which is also indicated by the underline () under the IPv6 address. If no

address is acquired, the field displays Not Available.

In the Login field, enter the login information for the ISP connection.

This is usually the name that you use in your email address. For example, if your main
mail account is JerAB@ISP.com, you would enter JerAB in this field. Some ISPs (such as
Earthlink) require that you use your full email address when you log in. If your ISP
requires your full email address, enter it in this field.

In the Password field, enter the password for the ISP connection.
In the Service Name field, enter a service name.

If your ISP did not provide a service name, leave this field blank.

Note: The default setting of the Connection Mode menu is Always On to
provide a steady IPv6 connection. The modem router never terminates
the connection. If the connection is terminated, for example, when the
modem is turned off, the modem router attempts to reestablish the
connection immediately after the PPPOE connection becomes
available again.
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10. Select an IP Address Assignment radio button;

e Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPvV6 client
function. This is the default setting.

e Auto Config. The modem router automatically configures its IPv6 address based on the
IPv6 protocol.

11. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

12. Click the Apply button.

Your settings are saved.

Set Up an IPv6 Connection Through Auto Config

If your Internet connection does not use PPPoE, DHCP, a fixed IP address, or pass-through
but is IPv6, use the Auto Config connection type, which lets the modem router autoconfigure
its IPv6 connection.

To set up an IPv6 Internet connection through auto-configuration:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select Auto Config.
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The modem router automatically detects the information in the following fields:

* Router’s IPv6 Address on WAN. This field shows the IPv6 address that is acquired
for the modem router's WAN (or Internet) interface. The number after the slash (/) is
the length of the prefix, which is also indicated by the underline (_) under the IPv6
address. If no address is acquired, the field displays Not Available.

Router’s IPv6 Address on LAN. This field shows the IPv6 address that is acquired

for the modem router’s LAN interface. The number after the slash (/) is the length of
the prefix, which is also indicated by the underline (_) under the IPv6 address. If no
address is acquired, the field displays Not Available.

If your ISP gave you a specific host name, in the DHCP User Class (If Required) field,

enter the host name.

If your ISP did not give you a specific host name, leave this field blank.

To specify a domain name, in the DHCP Domain Name (If Required) field, enter a domain

name.

If your ISP gave you a specific domain name, enter it in this field. (For example, Earthlink
Cable might require a host name of home, and Comcast sometimes supplies a domain

name.)

If your ISP did not give you a specific domain name, you can either leave this field blank
or enter the domain name of your IPv6 ISP. (Do not enter the domain name for the IPv4
ISP here.) For example, if your ISP’s mail server is mail.xxx.yyy.zzz, enter Xxx.yyy.zzz as
the domain name.
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9. Select an IP Address Assignment radio button:

e Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPvV6 client
function.

e Auto Config. This is the default setting.

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

11. Click the Apply button.

Your settings are saved.

Set Up an IPv6 6rd Tunnel Connection

The 6rd protocol makes it possible to deploy IPv6 to sites using a service provider’s IPv4
network. 6rd uses the service provider’s own IPv6 address prefix. This limits the operational
domain of 6rd to the service provider’s network and is under direct control of the service
provider. The IPv6 service that is provided is equivalent to native IPv6.

The 6rd mechanism relies on an algorithmic mapping between the IPv6 and IPv4 addresses
that are assigned for use within the service provider’s network. This mapping allows for
automatic determination of IPv4 tunnel endpoints from IPv6 prefixes, enabling stateless
operation of 6rd.

To set up an IPv6 6rd tunnel connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > IPv6.
The IPv6 screen displays.

6. From the Internet Connection Type menu, select 6rd Tunnel.
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ADVANCED Home

Setup Wizard ] [ Apply» BB XCancel [ G StatusRefresh
m’ Internet Connection Type 6rd Tunnel -

» Setup

» USBE Functions 6rd Configuration

6rd Prefix o :0 i 0 -0

L Sacultly 6rd Prefix Length

» Administration 6rd IPv4 Border Relay Address

w Advanced Setup 6rd IPv4 Address Mask Length

Wireless Settings
Wireless AP

Port Forwarding | Port
Triggering Use These DNS Servers
Dynamic DNS Primary DNS

VPN Service

Static Routes

Remote Management

IPvG Domain Name Server (DNS) Address
9 Get Automatically from ISP

Secondary DNS

LAN Setup
e Router's IPv6 Address On LAN
BT D Not Available
Traffic Meter IP Address Assignment
USB Settings Use DHCP Server
Deovice Mode @ Auto Config

| use This Interface ID

The modem router automatically detects the information in the Router’s IPv6 Address
on LAN field. This field shows the IPv6 address that is acquired for the modem router’s
LAN interface. The number after the slash (/) is the length of the prefix, which is also
indicated by the underline (_) under the IPv6 address. If no address is acquired, the field
displays Not Available.

7. In the 6rd Configuration section, configure the 6rd settings:
e 6rd Prefix. Enter the IPv6 prefix that your ISP gave you.
e 6rd Prefix Length. Enter the IPv6 prefix length that your ISP gave you.

e 6rd Border Relay Address. Enter the border router’s IPv4 address that your ISP
gave you.

e 6rd Address Mask Length. Enter the IPv4 mask length that your ISP gave you.

8. Select an IPv6 Domain Name Server (DNS) Address radio button:
* Get Automatically from ISP. The ISP’'s DHCP server automatically assigns IPv6
DNS server addresses.

* Use These DNS Servers. Enter the static IPv6 (not IPv4) DNS server addresses that
your ISP provided to you.

9. Select an IP Address Assignment radio button:

* Use DHCP Server. The modem router assigns IPv6 addresses to the devices on your
home network (the LAN) through a DHCP server. This method passes more information
to LAN devices, but some IPv6 systems might not support the DHCPv6 client
function. This is the default setting.

e Auto Config. The modem router automatically configures its IPv6 address based on the
IPv6 protocol.

Manage the Internet Settings Manually
87

Download from Www.Somanuals.com. All Manuals Search And Download.



AC1600 WiFi VDSL/ADSL Modem Router Model D6400

10. To specify the interface ID for the IPv6 address of the modem router’s LAN interface, select
the Use This Interface ID check box, and enter the interface ID.

If you do not specify an ID here, the modem router generates one automatically from its
MAC address.

11. Click the Apply button.

Your settings are saved.

Manage the MTU Size

The maximum transmission unit (MTU) is the largest data packet a network device transmits.

MTU Concepts

When one network device communicates across the Internet with another, the data packets
travel through many devices along the way. If a device in the data path uses a lower MTU
setting than the other devices, the data packets must be split or “fragmented” to
accommodate the device with the smallest MTU.

The best MTU setting for NETGEAR equipment is often the default value. In some situations,
changing the value fixes one problem but causes another.

Leave the MTU unchanged unless one of these situations occurs:

* You experience problems connecting to your ISP or other Internet service, and the
technical support of either the ISP or NETGEAR recommends changing the MTU setting.
These web-based applications might require an MTU change:

- A secure website that does not open or displays only part of a web page
- Yahoo email
- MSN portal
- America Online’s DSL service
e You use VPN and experience severe performance problems.
e You used a program to optimize MTU for performance reasons and now you are
experiencing connectivity or performance problems.

If you suspect an MTU problem, a common solution is to change the MTU to 1400. If you are
willing to experiment, you can gradually reduce the MTU from the maximum value of 1500
until the problem goes away. The following table describes common MTU sizes and
applications.
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Table 3. Common MTU sizes

MTU Application

1500 The largest Ethernet packet size. This setting is typical for connections that do not use PPPoE
or VPN and is the default value for NETGEAR modem routers, adapters, and switches.

1492 Used in PPPOE environments.

1472 Maximum size to use for pinging. (Larger packets are fragmented.)

1468 Used in some DHCP environments.

1460 Usable by AOL if you do not send or receive large email attachments, for example.

1436 Used in PPTP environments or with VPN.

1400 Maximum size for AOL DSL.

Change the MTU Size

A WARNING:

Anincorrect MTU setting can cause Internet communication problems.
For example, you might not be able to access certain websites, frames
within websites, secure login pages, or FTP or POP servers. Change the
MTU only if you are sure that it is necessary for your ISP connection.

To change the MTU size:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > WAN Setup.

The WAN Setup screen displays.

In the MTU Size field, enter a value from 616 to 1500.

The normal MTU value for most Ethernet networks is 1500 bytes, 1492 bytes for PPPoE
connections, or 1436 for PPTP connections.

Click the Apply button.
Your change is saved.
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Manage the WiFi Network Settings

This chapter describes how you can manage the WiFi network settings of the modem router.

The chapter includes the following sections:

Manage the Basic WiFi Settings and WiFi Security of the Main Network
Use WPS to Add a Device to the WiFi Network

Manage the Basic WiFi Settings and WiFi Security of the Guest Network
Control the WiFi Radios

Set Up a WiFi Schedule

Manage the WPS Settings

Manage Advanced WiFi Features

Use the Modem Router as a WiFi Access Point
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Manage the Basic WiFi Settings and WiFi Security of the
Main Network

The modem router comes with preset security. This means that the WiFi network name
(SSID), network key (password), and security option (encryption protocol) are preset in the
factory. The preset SSID and password are uniquely generated for every device to protect
and maximize your WiFi security. You can find the preset SSID and password on the product
label (see Bottom Panel Product Label on page 15).

IMPORTANT:

NETGEAR recommends that you do not change your preset
security settings. If you decide to change your preset security
settings, make a note of the new settings and store the note in a
safe place where you can easily find it.

View or Change the Basic WiFi Settings

You can view or change the basic WiFi settings and WiFi security. The modem router
simultaneously supports the 2.4 GHz band for 802.11b/g/n devices and the 5 GHz band for
802.11a/n/ac devices.

Tip: If you decide to change the WiFi settings of the modem router’s main
network, use a wired connection to avoid being disconnected when
the new WiFi settings take effect.

» To view or change the basic WiFi settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select Wireless.
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@ WPA2-PSK [AES]
2 WPA-PSK [TKIP] + WPA2-PSK [AES]
() WPA/WPAZ Enterprise

[ ese ) Ao
Home »
Internet » % Cancel
| Wireless >
Attached Devices 3 Region Selection
Region: Europe >
Parental Controls »
Wireless Network (2.4GHz bigin)
ReadySHARE : [¥] Enable SSID Broadcast
Guest Network » Name (SSID): NETGEAR47
Channel: Auto -
Mode: Upto 145Mbps ~
Security Options
) None

Passphrase: grandbird119

(8-63 characters or 64 hex digits)

Wireless Network (5GHz a/n/ac)
[¥] Enable SSID Broadcast
Name (SSID):

Channel:

Mode:

NETGEAR47-5G
44 -
Up to 1300 Mbps ~

Security Options
~ None

9 WPAZ-PSK [AES]

() WPA-PSK [TKIP] + WPAZ-PSK [AES]
_ WPAWPAZ Enterprise

Passphrase: grandbird119 (8-63 characters or 64 hex digits)

6. View or change the basic WiFi settings and security settings.

The following table describes the fields on the Wireless Setup screen.

Field

Description

Region Selectio

n

Region

From the menu, select the region in which the modem router operates.

Note: It might not be legal to operate the modem router in a region other than the regions
listed in the menu. If your country or region is not listed, check with your local government
agency.

Wireless Network (2.4GHz b/g/n)

Enable SSID
Broadcast

By default, the modem router broadcasts its SSID so that WiFi stations can detect the
WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the
Enable SSID Broadcast check box. Turning off the SSID broadcast provides additional
WiFi security, but users must know the SSID to be able to join the WiFi network of the
modem router.
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Field

Description

Name (SSID)

The SSID is the WiFi network name. If you did not change the SSID, the default SSID
displays. The default SSID is also printed on the product label (see Bottom Panel Product
Label on page 15).

Note: NETGEAR recommends that you do not change the default SSID. If you must
change the SSID, enter a 32-character (maximum), case-sensitive name in this field.

Channel

From the Channel menu, select Auto for automatic channel selection or select an
individual channel. The default selection is Auto.

Note: In some regions, not all channels are available. Do not change the channel unless
you experience interference (shown by lost connections or slow data transfers). If this
situation occurs, experiment with different channels to see which one is the best.

Note: If you use multiple WiFi access points (APs), reduce interference by selecting
different channels for adjacent APs. NETGEAR recommends a channel spacing of four
channels between adjacent APs (for example, use Channels 1 and 5, or 6 and 10).

Mode

From the Mode menu, select one of the following modes:

* Up to 54 Mbps. Legacy mode. This mode allows 802.11n, 802.11g, and 802.11b
devices to join the network but limits 802.11n devices to functioning at up to 54 Mbps.

* Up to 145 Mbps. Neighbor-friendly mode for reduced interference with neighboring
WiFi networks. This mode allows 802.11n, 802.11g, and 802.11b devices to join the
network but limits 802.11n devices to functioning at up to 145 Mbps. This mode is the
default mode.

* Up to 300 Mbps. Performance mode. This mode allows 802.11n, 802.11g, and
802.11b devices to join the network and allows 802.11n devices to function at up to
300 Mbps.

Note: WEP security supports speeds of up to 54 Mbps. Even if your devices are capable
of a higher speed, WEP security limits their speed to 54 Mbps.
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Field Description

Security Options
This information applies to the 2.4 GHz WiFi network.

Note: NETGEAR recommends that you do not change your preset security settings (WPA2-PSK [AES])).

If you must change the WiFi security, select one of the following WiFi security options for the modem
router’s WiFi network:

* None. An open WiFi network that does not provide any security. Any WiFi device can join the network.
NETGEAR recommends that you do not use an open WiFi network.

« WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode
that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you select Up to 54
Mbps from the Mode menu. For information about configuring WEP, see Configure WEP Legacy WiFi
Security on page 98.

< WPA2-PSK [AES]. This type of security is the default setting and enables WiFi devices that support
WPAZ2 to join the modem router’s 2.4 GHz WiFi network. If you did not change the passphrase, the
default passphrase displays. The default passphrase is printed on the product label (see Bottom Panel
Product Label on page 15). WPA2 provides a secure connection but some older WiFi devices do not
detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK
[TKIP] + WPA2-PSK [AES] security.

NETGEAR recommends that you do not change the default passphrase. If you must change the
passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s
WiFi network, a user must enter this passphrase.

«  WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either
WPA or WPA2 to join the modem router’s 2.4 GHz WiFi network. However, WPA-PSK [TKIP] is less
secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
modem router’s WiFi network, a user must enter this passphrase.

< WPA/WPA?2 Enterprise. This type of security requires that your WiFi network can access a RADIUS
server. For information about configuring WPA/WPA2 Enterprise, see Configure WPA/WPA2 Enterprise
WiFi Security on page 96.

Wireless Network (5GHz 802.11a/n/ac)

Enable SSID By default, the modem router broadcasts its SSID so that WiFi stations can detect the
Broadcast WiFi name (SSID) in their scanned network lists. To turn off the SSID broadcast, clear the
Enable SSID Broadcast check box. Turning off the SSID broadcast provides additional
WiFi security, but users must know the SSID to be able to join the WiFi network of the
modem router.

Enable Video If you want to stream high-definition video, select this check box. When this option is
Network selected, the modem router uses video reliability algorithms to reduce jitter and packet
loss during video presentations. If you do not stream videos, leave this check box cleared.

Name (SSID) The SSID is the WiFi network name. If you did not change the SSID, the default SSID
displays. The default SSID is also printed on the product label (see Bottom Panel Product
Label on page 15).

Note: NETGEAR recommends that you do not change the default SSID. If you must
change the SSID, enter a 32-character (maximum), case-sensitive name in this field.
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Field Description

Channel From the Channel menu, select Auto for automatic channel selection or select an

individual channel. The default channel depends on your selection from the Region
menu.

Note: In some regions, not all channels are available. Do not change the channel unless
you experience interference (shown by lost connections or slow data transfers). If this
situation occurs, experiment with different channels to see which one is the best.

Note: If you use multiple WiFi access points (APs), reduce interference by selecting
different channels for adjacent APs. NETGEAR recommends a channel spacing of four
channels between adjacent APs.

Mode From the Mode menu, select one of the following modes:

* Up to 289 Mbps. Legacy mode. This mode allows 802.11ac, 802.11na, and 802.11a
devices to join the network but limits 802.11ac and 802.11na devices to functioning at
up to 289 Mbps.

* Up to 600 Mbps. Neighbor-friendly mode for reduced interference with neighboring
WiFi networks. This mode allows 802.11ac, 802.11na, and 802.11a devices to join
the network, allows 802.11na devices to function at up to 600 Mbps, and limits
802.11ac devices to functioning at up to 600 Mbps.

e Up to 1300 Mbps. Performance mode. This mode allows 802.11ac, 802.11na, and
802.11a devices to join the network and allows 802.11ac devices to function at up to
1300 Mbps.

The default mode depends on your selection from the Region menu.

Security Options
This information applies to the 5 GHz WiFi network.

Note: NETGEAR recommends that you do not change your preset security settings (WPA2-PSK [AES]).

If you must change the WiFi security, select one of the following WiFi security options for the modem
router's WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the network.
NETGEAR recommends that you do not use an open WiFi network.

WPA2-PSK [AES]. This type of security is the default setting and enables WiFi devices that support
WPAZ2 to join the modem router’'s 2.4 GHz WiFi network. If you did not change the passphrase, the
default passphrase displays. The default passphrase is printed on the product label (see Bottom Panel
Product Label on page 15). WPA2 provides a secure connection but some older WiFi devices do not
detect WPA2 and support only WPA. If your network includes such older devices, select WPA-PSK
[TKIP] + WPA2-PSK [AES] security.

NETGEAR recommends that you do not change the default passphrase. If you must change the
passphrase, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the modem router’s
WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either
WPA or WPAZ2 to join the modem router's 2.4 GHz WiFi network. However, WPA-PSK [TKIP] is less
secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use this type of security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
modem router's WiFi network, a user must enter this passphrase.

WPA/WPA2 Enterprise. This type of security requires that your WiFi network can access a RADIUS
server. For information about configuring WPA/WPA2 Enterprise, see Configure WPA/WPA2 Enterprise
WIiFi Security on page 96.

7. Click the Apply button.

Your settings are saved.
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If you connected over WiFi to the network and you changed the SSID, you are
disconnected from the network.

8. Make sure that you can reconnect over WiFi to the network with its new settings.

If you cannot connect over WiFi, check the following:

« If your computer or WiFi device is already connected to another WiFi network in your
area, disconnect it from that WiFi network and connect it to the WiFi network that the
modem router provides. Some WiFi devices automatically connect to the first open
network without WiFi security that they discover.

* If your computer or WiFi device is trying to connect to your network with its old
settings (before you changed the settings), update the WiFi network selection in your
computer or WiFi device to match the current settings for your network.

» Does your WiFi device display as an attached device? (See View Devices Currently
on the Network on page 240.) If it does, it is connected to the network.

e Are you using the correct network name (SSID) and password?

Configure WPA/WPA2 Enterprise WiFi Security

Remote Authentication Dial In User Service (RADIUS) is an enterprise-level method for
centralized Authentication, Authorization, and Accounting (AAA) management. To provide
WPA/WPA2 enterprise WiFi security, the WiFi network that the modem router provides must
be able to access a RADIUS server.

Note: WPS and WPA/WPAZ2 enterprise security cannot function together.
When you enable WPA/WPA2 enterprise security, WPS is disabled.

Tip: If you want to change the WiFi settings of the modem router’s main
network, use a wired connection to avoid being disconnected when
the new WiFi settings take effect.

To configure WPA/WPAZ2 enterprise security:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
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5. Select Wireless.
The Wireless Setup screen displays.

6. In the Security Options section, select the WPA/WPA2 Enterprise radio button.

Security Options
Mone
WPA2-PSK [AES]
WPA-PSK [TKIP] + WPA2-PSK [AES]
9 WPANWPAZ2 Enterprise

WPAWPAZ-Enterprise

Encryption Mode: WPA[TKIP] + WPA2 [AES] ~
Group Key Update Interval 3600 Seconds
RADIUS server [P Address:: 0 F « (0 - |0
RADIUS server Port: 1812

RADIUS server Shared Secret:

7. In the Security Options (WPA/WPA2 Enterprise) section, enter the settings as described in
the following table.

Field Description

WPA Mode From the WPA Mode menu, select the enterprise mode:

< WPA2 [AES]. WPA2 provides a secure connection but some older
WiFi devices do not detect WPA2 and support only WPA. If your
network includes such older devices, select WPA [TKIP] + WPA2 [AES]
security.

*  WPA [TKIP] +WPA2 [AES]. This type of security enables WiFi devices
that support either WPA or WPA2 to join the modem router's WiFi
network.

Group Key Update Interval Enter the interval in seconds after which the RADIUS group key is updated.
The default interval is 3600 seconds.

RADIUS server IP Address Enter the IPv4 address of the RADIUS server to which the WiFi network
can connect.

RADIUS server Port Enter the number of the port on the modem router that is used to access
the RADIUS server for authentication. The default port number is 1812.

RADIUS server Shared Enter the shared secret (RADIUS password) that is used between the
Secret modem router and the RADIUS server during authentication of a WiFi user.

8. Click the Apply button.
Your settings are saved.

9. Make sure that you can reconnect over WiFi to the network with its new security settings.
If you cannot connect over WiFi, check the following:

* If your computer or WiFi device is already connected to another WiFi network in your
area, disconnect it from that WiFi network and connect it to the WiFi network that the
modem router provides. Some WiFi devices automatically connect to the first open
network without WiFi security that they discover.
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e If your computer or WiFi device is trying to connect to your network with its old
settings (before you changed the settings), update the WiFi network selection in your
computer or WiFi device to match the current settings for your network.

» Does your WiFi device display as an attached device? (See View Devices Currently
on the Network on page 240.) If it does, it is connected to the network.

e Are you using the correct network name (SSID) and password?

Configure WEP Legacy WiFi Security

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption
mode that is superseded by WPA-PSK and WPA2-PSK. WEP limits the WiFi transmission
speed to 54 Mbps (the modem router is capable of speeds of up 300 Mbps).

Note: WPS and WEP security cannot function together. When you enable
WEP security, WPS is disabled.

Tip: If you want to change the WiFi settings of the modem router’s main
network, use a wired connection to avoid being disconnected when
the new WiFi settings take effect.

To configure WEP security:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select Wireless.

The Wireless Setup screen displays.

From the Mode menu, select Up to 54 Mbps.

The screen adjusts to display the WEP radio button.

In the Security Options section, select the WEP radio button.
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Wireless Network (2.4GHz big/n)
/| Enable SSID Broadcast

Name (SSID): NETGEAR23
Channel: Auto -
Mode: Upto54 Mbps ~

Security Options
MNone
@ WEP
WPA2-PSK [AES]
WPA-PSK [TKIP] + WPA2-PSK [AES]
WPAMWPAZ Enterprise

Security Encryption (WEP)
Authentication Type Automatic -

Encryption Strength 64-bit -

Security Encryption (WEP) Key
Key1 @

Key 2

Key 3

Key 4

From the Authentication Type menu, select one of the following types:
e Automatic. Clients can use either Open System or Shared Key authentication.
e Shared Key. Clients can use only Shared Key authentication.

From the Encryption Strength menu, select the encryption key size:
e 64-bit. Standard WEP encryption, using 40/64-bit encryption.

e 128-bit. Standard WEP encryption, using 104/128-bit encryption. This selection
provides higher encryption security.

Specify the active key by selecting the Key 1, Key 2, Key 3, or Key 4 radio button.
Only one key can be the active key.

Enter the value for the key:

e For 64-bit WEP, enter 10 hexadecimal digits (any combination of 0-9, A—F). The key
values are not case-sensitive.

e For 128-bit WEP, enter 26 hexadecimal digits (any combination of 0-9, A—F). The key
values are not case-sensitive.

To join the modem router's WiFi network, a user must enter the key value for the key that
you specified as the active key.

Click the Apply button.

Your settings are saved.

Make sure that you can reconnect over WiFi to the network with its new security settings.
If you cannot connect over WiFi, check the following:

» If your computer or WiFi device is already connected to another WiFi network in your
area, disconnect it from that WiFi network and connect it to the WiFi network that the
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modem router provides. Some WiFi devices automatically connect to the first open
network without WiFi security that they discover.

e If your computer or WiFi device is trying to connect to your network with its old
settings (before you changed the settings), update the WiFi network selection in your
computer or WiFi device to match the current settings for your network.

» Does your WiFi device display as an attached device? (See View Devices Currently
on the Network on page 240.) If it does, it is connected to the network.

e Are you using the correct network name (SSID) and password?

Use WPS to Add a Device to the WiFi Network

>

WPS (Wi-Fi Protected Setup) lets you connect a computer or WiFi device to the modem
router’s network without entering the WiFi network passphrase or key. Instead, you use a
WPS button or enter a PIN to connect.

If you use the push button method, the WiFi device that you are trying to connect must
provide either a physical button or a software button. If you use the PIN method, you must
know the PIN of the WiFi device that you are trying to connect.

WPS supports WPA and WPA2 WiFi security. If your modem router network is open (no WiFi
security is set, which is not the default setting for the modem router), connecting with WPS
automatically sets WPA + WPA2 WiFi security on the modem router network and generates a
random passphrase. You can view this passphrase (see Manage the Basic WiFi Settings and
WiFi Security of the Main Network on page 91).

Note: WPS and WPA/WPA2 enterprise security or WEP security cannot
function together. When you enable WPA/WPA2 enterprise security or
WEP security, WPS is disabled.

Use WPS with the Push Button Method

For you to use the push button method to connect a WiFi device to the modem router’s WiFi
network, the WiFi device that you are trying to connect must provide either a physical button
or a software button. You can use the physical button and software button to let a WiFi device
join only the main WiFi network, not the guest WiFi network.

To let a WiFi device join the modem router’s main WiFi network using WPS with the
push button method:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.

A login screen displays.
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3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

The BASIC Home screen displays.
5. Select ADVANCED > WPS Wizard.

The screen displays a description of the WPS method.
6. Click the Next button.

ADVANCED Home
Setup Wizard
.

@ Push Button (recommended)
» Setup

You can either press the physical push button on the router or click the button (soft push button) in this screen.
» USE Functions

» Security
» Administration

PIN Number
» Advanced Setup

By default, the Push Button (recommended) radio button is selected.
7. Either click the £ button onscreen or press the WPS button on the right side panel of the
modem router for three seconds.

For two minutes, the modem router attempts to find the WiFi device (that is, the client)
that you want to join the modem router’s main WiFi network.

During this time, the WiFi LED on the front panel of the modem router blinks blue.

8. Within two minutes, go to the WiFi device and press its WPS button to join the modem
router's main WiFi network without entering a password.

After the modem router establishes a WPS connection, the WiFi LED lights solid blue and
the Add WPS Client screen displays a confirmation message.

9. To verify that the WiFi device is connected to the modem router’'s main WiFi network, select
BASIC > Attached Device.

The WiFi device displays onscreen.

Use WPS with the PIN Method

To use the PIN method to connect a WiFi device to the modem router’'s WiFi network, you
must know the PIN of the WiFi device that you are trying to connect.
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> To let a WiFi device join the modem router’s WiFi network using WPS with the PIN
method:

1.

10.

11.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > WPS Wizard.

The screen displays a description of the WPS method.

Click the Next button.

The Add WPS Client screen adjusts.

The Push Button (recommended) radio button is selected by default.

Select the PIN Number radio button.

ADVANCED Home
Setup Wizard )

Select a setup method.:
* Push Buften (recommended)
9 PIN Mumber

» Setup

R runctons This is the security PIN of the WPS client. While connecting, WPS-enabled adapters provide a randomly-generated

» Security security PIN.

» Administration
Enter Clients PIN: m

» Advanced Setup

In the Enter Client's PIN field, enter the PIN number of the WiFi device.
Click the Next button.

For four minutes, the modem router attempts to find the WiFi device (that is, the client)
that you want to join the modem router’s main WiFi network.

During this time, the WiFi LED on the front panel of the modem router blinks blue.

Within four minutes, go to the WiFi device and use its WPS software to join the network
without entering a password.

When the modem router establishes a WPS connection, the WiFi LED lights solid blue
and the Add WPS Client screen displays a confirmation message.

To verify that the WiFi device is connected to the modem router's main WiFi network, select
BASIC > Attached Device.

The WiFi device displays onscreen.
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Manage the Basic WiFi Settings and WiFi Security of the
Guest Network

A guest network allows visitors to use the Internet without using your WiFi security key. By
default, the guest WiFi network is disabled. You can enable and configure the guest WiFi
network for each WiFi band: 2.4 GHz b/g/n and 5.0 GHz a/n/ac.

Set Up and Enable a Guest Network

The WiFi mode of the guest WiFi network depends on the WiFi mode of the main WiFi
network. For example, if you configure the WiFi mode for the main WiFi network as Up to
54 Mbps in the 2.4 GHz band, the guest WiFi network also functions in the Up to 54 Mbps
mode in the 2.4 GHz band. For information about configuring the WiFi mode, see Manage
the Basic WiFi Settings and WiFi Security of the Main Network on page 91.

> To set up a guest network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
4. Select Guest Network.
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B -
Home »

Internet » { o m

Wireless >

Attached Devices > Wireless Network (2.4GHz blg/n) - Profile

Parental Controls » [ZJEnable Guest Network

ReadySHARE

[VIEnable SSID Broadeast
| Allow guests to see each other and access my local
» network

Guest Wireless Network Name (SSID): NETGEAR-Guest

Security Options - Profile
9 None
WPA2-PSK [AES)
) WPA-PSK [TKIP] + WPA2-PSK [AES]

Wireless Network (5GHz ain/ac) - Profile
I Enable Guest Network
[¥| Enable $SID Broadcast

| Allow guests to see each other and access my local
network

Guest Wireless Network Name (SSID): NETGEAR-5G-Guest

Security Options - Profile
@ None
WPA2-PSK [AES)
) WPA-PSK [TKIP] + WPA2-PSK [AES]

5. Enable the guest network and configure its WiFi settings as described in the following table.

Field

Description

Wireless Network (2.4GHz b/g/n) - Profile

Enable Guest

By default, the guest WiFi network is disabled. To enable the guest WiFi network for

Network the 2.4 GHz WiFi band, select the Enable Guest Network check box.
Enable SSID By default, the modem router broadcasts its SSID of the 2.4 GHz WiFi band so that
Broadcast WiFi stations can detect the WiFi name (SSID) in their scanned network lists. To turn

off the SSID broadcast for the 2.4 GHz WiFi band for the guest WiFi network, clear the
Enable SSID Broadcast check box.

Allow guests to
see each other
and access my
local network

By default, WiFi clients that are connected to the 2.4 GHz WiFi band of the guest WiFi
network cannot access WiFi devices or Ethernet devices that are connected to the
main WiFi network. To allow access to the main WiFi network, select the Allow guests
to see each other and access my local network check box.

Guest Wireless
Network Name
(SSID)

The SSID is the 2.4 GHz WiFi band name. If you did not change the SSID, the default
SSID displays, which is NETGEAR-Guest.

If you want to change the SSID in the 2.4 GHz WiFi band for the guest WiFi network,
enter a 32-character (maximum), case-sensitive name in this field.
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Field Description

Security Options - Profile

If you want to change the WiFi security, select one of the following WiFi security options for the 2.4 GHz
band of the guest WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the 2.4 GHz
band of the guest WiFi network. This is the default setting for the guest WiFi network.

WEP. Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption mode
that is superseded by WPA-PSK and WPA2-PSK. The WEP option displays only if you configure the
WiFi mode for the main WiFi network as Up to 54 Mbps in the 2.4 GHz band (see Manage the Basic
WiFi Settings and WiFi Security of the Main Network on page 91). For information about configuring
WEP, see Configure WEP Legacy WiFi Security for the Guest WiFi Network on page 106.

WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices do not
detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect to the 2.4 GHz
band of the guest WiFi network at the fastest speed. If your network includes older devices that do not
support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

To use WPAZ2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the

2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either
WPA or WPAZ2 to join the 2.4 GHz band of the guest WiFi network. However, WPA-PSK [TKIP] is less
secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
2.4 GHz band of the guest WiFi network, a user must enter this passphrase.

Wireless Network (5GHz a/n/ac) - Profile

Enable Guest By default, the guest WiFi network is disabled. To enable the guest WiFi network for
Network the 5 GHz WiFi band, select the Enable Guest Network check box.

Enable SSID By default, the modem router broadcasts its SSID of the 5 GHz WiFi band so that WiFi
Broadcast stations can detect the WiFi name (SSID) in their scanned network lists. To turn off the

SSID broadcast for the 5 GHz WiFi band for the guest WiFi network, clear the Enable
SSID Broadcast check box.

Allow guests to By default, WiFi clients that are connected to the 5 GHz WiFi band of the guest WiFi
see each other network cannot access WiFi devices or Ethernet devices that are connected to the
and access my main WiFi network. To allow access to the main WiFi network, select the Allow guests
local network to see each other and access my local network check box.

Guest Wireless The SSID is the 5 GHz WiFi band name. If you did not change the SSID, the default
Network Name SSID displays, which is NETGEAR-5G-Guest. If you want to change the SSID in the
(SSID) 5 GHz WiFi band for the guest WiFi network, enter a 32-character (maximum),

case-sensitive name in this field.
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Field Description

Security Options - Profile

If you want to change the WiFi security, select one of the following WiFi security options for the 5 GHz band
of the guest WiFi network:

None. An open WiFi network that does not provide any security. Any WiFi device can join the 5 GHz
band of the guest WiFi network. This is the default setting for the guest WiFi network.
WPA2-PSK [AES]. WPA2 provides a secure and fast connection but some older WiFi devices do not
detect WPA2 and support only WPA. Select WPA2 to allow 802.11n devices to connect to the 5 GHz
band of the guest WiFi network at the fastest speed. If your network includes older devices that do not
support WPA2, select WPA-PSK [TKIP] + WPA2-PSK [AES] security.

To use WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the 5 GHz
band of the guest WiFi network, a user must enter this passphrase.

WPA-PSK [TKIP] + WPA2-PSK [AES]. This type of security enables WiFi devices that support either
WPA or WPAZ2 to join the 5 GHz band of the guest WiFi network. However, WPA-PSK [TKIP] is less
secure than WPA2-PSK [AES] and limits the speed of WiFi devices to 54 Mbps.

To use WPA + WPA2 security, in the Passphrase field, enter a phrase of 8 to 63 characters. To join the
5 GHz band of the guest WiFi network, a user must enter this passphrase.

Click the Apply button.

Your settings are saved.

Make sure that you can reconnect over WiFi to the guest network.

If you cannot connect over WiFi, check the following:

If your computer or WiFi device is already connected to another WiFi network in your
area, disconnect it from that WiFi network and connect it to the WiFi network that the
modem router provides. Some WiFi devices automatically connect to the first open
network without WiFi security that they discover.

Does your WiFi device display as an attached device? (See View Devices Currently
on the Network on page 240.) If it does, it is connected to the network.

Are you using the correct network name (SSID) and password?

Configure WEP Legacy WiFi Security for the Guest WiFi

Network

Wired Equivalent Privacy (WEP) security is a legacy authentication and data encryption
mode that is superseded by WPA-PSK and WPA2-PSK. WEP supports speeds of up to
54 Mbps (the modem router is capable of speeds of up to 300 Mbps in the 2.4 GHz band).
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IMPORTANT:

The WiFi mode of the guest WiFi network depends on the WiFi
mode of the main WiFi network. For you to be able to configure
WEP in the guest WiFi network, first configure the mode for the
main WiFi network as Up to 54 Mbps. For information about
configuring the WiFi mode, see Manage the Basic WiFi Settings and
WiFi Security of the Main Network on page 91.

> To configure WEP security for the guest WiFi network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. In the address field of your browser, enter http://routerlogin.net.
The login screen displays.
3. Type admin for the user name and type your password.
If you did not yet personalize your password, type password for the password.
4. Click the OK button.
The BASIC Home screen displays.
5. Select BASIC > Guest Network.
The Guest Network Settings screen displays.

6. In the Security Options section, select the WEP radio button.

Security Options - Profile
Mone
% WEP
WPAZ-PSK [AES]
WPA-PSK [TKIP] + WPA2-PSK [AES]

Security Encryption (WEP)
Authentication Type: Automatic -
Encryption Strength: 64-bit ~

Security Encryption (WEP} Key
Key 1. @

Key 2:

Key 3:

Key 4:

7. From the Authentication Type menu in the Security Encryption (WEP) section, select one
of the following types:

e Shared Key. Clients can use only Shared Key authentication.
* Automatic. Clients can use either Open System or Shared Key authentication.
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8. From the Encryption Strength menu in the Security Encryption (WEP) section, select the
encryption key size:

e 64-bit. Standard WEP encryption, using 40/64-bit encryption.

e 128-bit. Standard WEP encryption, using 104/128-bit encryption. This selection
provides stronger encryption security.

9. In the Security Encryption (WEP) Key section, generate the key automatically:
a. Inthe Passphrase field, enter a passphrase.
b. Click the Generate button.

For 64-bit WEP, four different WEP keys are generated and the four key fields are
populated with different WEP keys. For 128-bit WEP, only one WEP key is generated
and the four key fields are populated with the same WEP key.

c. Specify the active key by selecting the Key 1, Key 2, Key 3, or Key 4 radio button.
Only one key can be the active key.

To join the guest WiFi network, a user must enter the key value for the key that you
specified as the active key.

10. Click the Apply button.
Your settings are saved.

Control the WiFi Radios

The modem router provides internal WiFi radios that broadcast signals in the 2.4 GHz and

5 GHz ranges. By default, they are on so that you can connect over WiFi to the modem
router. When the WiFi radios are off, you can still use an Ethernet cable for a LAN connection
to the modem router.

You can turn the WiFi radios on and off with the WiFi On/Off button on the modem router, or
you can log in to the modem router and enable or disable the WiFi radios through the web
management interface. If you are close to the modem router, it might be easier to press the
WiFi On/Off button. If you are away from the modem router or already logged in, it might be
easier to enable or disable the radios through the web management interface. You can also
turn the WiFi radios off and on based on a schedule. (See Set Up a WiFi Schedule on

page 110.)

Tip: If you want to disable the WiFi radios of the modem router, use a wired
connection to avoid being disconnected when the WiFi radios turn off.

Use the WiFi On/Off Button

> To turn the WiFi radios off and on with the WiFi On/Off button:

Press the WiFi On/Off button on the right side panel of the modem router for three
seconds.

If you turned off the WiFi radios, the WiFi LED turns off. If you turned on the WiFi radios,
the WiFi LED lights solid blue after about half a minute.
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Enable or Disable the WiFi Radios

If you used the WiFi On/Off button to turn off the WiFi radios, you cannot log in to the modem
router over a WiFi connection to turn them back on. You must press the WiFi On/Off button
again for three seconds to turn the WiFi radios back on.

To enable or disable the WiFi radios:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.

ADVANCED Home | Vireless Settings
Setup Wizard . "~ ApplY
WPS Wizard |
» Setup Advanced Wireless Settings (2.4GHz bigin)
» USB Funciions = Enable Wireless Router Radio
¥ Enable 20/40 MHz Coexistence
* Security Fragmentation Length (256-2346); 2346
» Administration CTS/RTS Threshold (1-2347): 2347
v Advanced Setup Preamble Mode Long Preamble ~
. [T Tum off wireless signal by schedule
r*ss Settings The wirel signal is scheduled to turn off during the following time period:
Wireless AP ] Period Start I End | Recurrence Pattern
Port Forwarding / Port
Dynamic DNS
VPN Service Advanced Wireless Settings (5GHz a/nfac)
Static Routes ¥ Enable Wireless Router Radio
q i 1
Ezm:‘e Managermiant Fragmentation Length (256-2346). 216
nl
IPv6 CTS/RTS Threshold (1-2347): 2347 - |
Traffic Meter Preamble Mode Long Preamble -
USB Settings [71 Tumn off wireless signal by schedule
Device Mode The wi signal is scheduled to turn off during the following time period:
Period Start | End | Recurrence Pattern
=l XN

The previous figure does not show the bottom of the Wireless Settings screen.
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6. Do one of the following in the Advanced Wireless Settings (2.4GHz b/g/n) section, Advanced
Wireless Settings (5GHz 802.11a/n/ac) section, or both sections:

« Turn off the radio. Clear the Enable Wireless Router Radio check box.

If both radios are disabled, the WiFi LED turns off (see Front Panel with LEDs on
page 11).
e Turn on the radio. Select the Enable Wireless Router Radio check box.

If you enable at least one radio, the WiFi LED lights solid blue after about half a
minute.

7. Click the Apply button.

Your settings are saved.

Set Up a WiFi Schedule

You can use this feature to turn off the WiFi signal from your modem router at times when you
do not need a WiFi connection. For example, you might turn it off for the weekend if you leave
town. You can set up separate schedules for the 2.4 GHz and 5 GHz bands.

> To set up the WiFi schedule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
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 [marToae

ADVANCED Home | > < £

i -
WPS Wizard |

» Setup Advanced Wireless Settings (2.4GHz big/n)

» USB Functions 'i Enable Wireless Router Radio

¥ Enable 20/40 MHz Coexistence

£ SBCUTHy Fragmentation Length (256-2346). 2346

» Administration CTS/RTS Threshold (1-2347): 2347
v Advanced Setup Preamble Mode Long Preamble ~

. [T] Tum off wireless signal by schedule

‘*ss Settings The wi signal is to turn off during the following time period:

Wireless AP : ] Period Start I End | Recurrence Pattern
Port Forwarding / Port

Dynamic DNS

VPN Service Advanced Wireless Settings (5GHz alnfac)

Static Routes V] Enable ireless Router Radio

hemote Management - ¢

Ezm:‘e Lerteniy Fragmentation Length (256-2346) 2346

nl

PG CTS/RTS Threshold (1-2347): 2347

Traffic Meter Preamble Mode Long Preamble ~

USB Settings [1 Tumn off wireless signal by schedule

Device Mode The wi signal is scheduled to turn off during the following time period:

Period Start | End | Recurrence Pattern
==

The previous figure does not show the bottom of the Wireless Settings screen.

5. Either in the Advanced Wireless Settings (2.4GHz b/g/n) section or the Advanced Wireless

Settings (5GHz 802.11a/n/ac) section, click the Add a new period button.

Start 12:00midnight

End: 12:00noon

Recurrence Pattern
@ Daily
Select Days
Sunday
Thursday

‘When to turn off wireless signal

Monday Tuesday Wednesday
Frigay Saturday

turn off the WiFi signal and specify whether the schedule is recurrent.

The Wireless Settings screen displays.

6.
7. Click the Apply button.
8.
9. Click the Apply button.

Your settings are saved.

Use the menus, radio buttons, and check boxes to set up a period during which you want to

Select the Turn off wireless signal by schedule check box to activate the schedule.
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Manage the WPS Settings

Wi-Fi Protected Setup (WPS) lets you join the WiFi network without typing the WiFi
password. You can change the WPS default and security settings.

» To manage WPS settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
4. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings screen displays.

5. Scroll down to the bottom of the screen.

WPS Settings
Router's PIN: 77816801
¥ Enable Routers PIN
¥ To prevent PIN compromise, auld disable the PIN after 3 failed PIN connections, until router

reboots
In auto disabled mode, routers WPS LED will keep blinking slowly

¥ Keep Existing Wireless Seftings (2.4GHz big/n)
| Keep Existing Wireless Settings (5GHz ainfac)

"] Enable Implicit BEAMFORMING - Boosts WiFi speed, reliability, & range for all mobile devices

The Router’s PIN field displays the fixed PIN that you use to configure the modem
router's WiFi settings from another platform through WPS.

6. To disable the PIN, clear the Enable Router’s PIN check box.

By default, the Enable Router’s PIN check box is selected and the modem router’s PIN is
enabled. For enhanced security, you can disable the modem router’s PIN by clearing the
Enable Router’s PIN check box. However, when you disable the modem router’s PIN,
WPS is not disabled because you can still use the physical WPS button.

7. To keep the PIN enabled and change the number of times that a PIN connection is allowed
to fail before the PIN is automatically disabled, enter a number in the field.

By default, the PIN is automatically disabled after three failed connection attempts. If the
PIN is automatically disabled, the WiFi LED on the front panel of the modem router blinks
blue. The PIN remains disabled until you restart the modem router.
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Note: The PIN function might temporarily be disabled automatically if the
modem router detects suspicious attempts to break into the modem
router's WiFi settings by using the router’s PIN through WPS.

8. To keep the PIN enabled but disable the PIN failure security, clear the To prevent PIN
compromise check box.

9. To allow the WiFi settings to be changed automatically when you use WPS, do the
following:
» To allow the WiFi settings to be changed for the 2.4 GHz band, clear the Keep Existing
Wireless Settings (2.4GHz b/g/n) check box.

e To allow the WiFi settings to be changed for the 5 GHz band, clear the Keep Existing
Wireless Settings (5GHz a/n/ac) check box.

By default, these check boxes are selected. NETGEAR recommends that you leave them
selected. If you clear these check boxes, the next time that a new WiFi client uses WPS
to connect to the modem router, the WiFi settings of the modem router change to an
automatically generated random SSID and passphrase for the band to which the client
connects. For information about viewing this SSID and passphrase, see Manage the
Basic WiFi Settings and WiFi Security of the Main Network on page 91.

Clear the Keep Existing Wireless Settings (2.4GHz b/g/n) or Existing Wireless
Settings (5GHz a/n/ac) check box only if you want to allow the WPS process to change
the SSID and passphrase for WiFi access for the WiFi band.

A WARNING:

If you clear the Keep Existing Wireless Settings check box for a
WiFi band and use WPS to add a computer or WiFi device to that
band of the modem router’s WiFi network, the SSID and passphrase
are automatically generated and other WiFi devices that are already
connected to the band of the modem router’s WiFi network might
be disconnected.

10. Click the Apply button.

Your settings are saved.
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Manage Advanced WiFi Features

For most WiFi networks, the advanced WiFi features work fine and you do not need to
change the settings.

Tip: If you want to change the WiFi settings of the modem router’s main
network, use a wired connection to avoid being disconnected when
the new WiFi settings take effect.

» To manage advanced WiFi features:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Wireless Settings.

[

ADVANCED Home | Vireless Settings
WPS Wizard |

» Setup Advanced Wireless Settings {2.4GHz bigin)

ADVANCED ] Auto

[¥] Enable wireless Router Radio
[¥] Enable 20/40 MHz Coexistence
Fragmentation Length (256-2346); 2346
CTS/RTS Threshold (1-2347): 2347
Preamble Mode

*» USB Functions
» Security

» Administration

v Advanced Setup

Long Preamble -
[T Tum off wireless signal by schedule

. The wirel signal is scheduled to turn off during the following time period:
Wireless AP ] Period Start I End | Recurrence Pattern
Port Forwarding / Port
Dynamic DNS
VPN Service Advanced Wireless Settings (5GHz alnfac)
Static Routes [¥I Enable Wireless Router Radio

q ; ;

E‘;"‘:‘e Sl Fragmentation Length (256-2346): 2346

nl
Py CTS/RTS Threshold (1-2347): 2347

Traffic Meter
USB Settings
Device Mode

Preamble Mode Long Preamble ~

The wi signal is scheduled to turn off during the following time period:

Period Start | End | Recurrence Pattern

4 Add a new period m X Delete

The previous figure does not show the bottom of the Wireless Settings screen.
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6. Enter the settings as described in the following table.

Except for the description of 20/40 MHz coexistence, the descriptions in the table (not the
settings onscreen) apply to both the Advanced Wireless Settings (2.4GHz b/g/n) section
and the Advanced Wireless Settings (5GHz 802.11a/n/ac) section.

Field Description

Enable 20/40 MHz By default, 20/40 MHz coexistence is enabled to prevent interference between WiFi
Coexistence networks in your environment at the expense of the WiFi speed. If no other WiFi
networks are present in your environment, you can clear the Enable 20/40 MHz
Coexistence check box to increase the WiFi speed to the maximum supported
speed.

Note: 20/40 MHz coexistence applies to the 2.4 GHz band only.

Fragmentation

Length (256-2346) The fragmentation length (the default is 2346), CTS/RTS threshold (the default is

2347), and the preamble mode (the default is Long Preamble) are reserved for WiFi
CTS/RTS Threshold | testing and advanced configuration only. Do not change these settings unless
(1-2347) directed by NETGEAR support or unless you are sure what the consequences are.
Incorrect settings might disable the WiFi function of the modem router unexpectedly.

Preamble Mode

7. Click the Apply button.

Your settings are saved.

Use the Modem Router as a WiFi Access Point

You can set up the modem router to function as a WiFi access point (AP) on the same local
network as another router. When the modem router functions as a WiFi AP, many
router-related features are disabled.

Tip: If you want to change the modem router’s function, use a wired connection
to avoid being disconnected when the new function takes effect.
> To set up the modem router as an AP:

1. Use an Ethernet cable to connect the Internet port of the modem router to a LAN port on
the other router.
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Cable the red Internet port
to a LAN port on another router

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Wireless AP.

ADVANCED Home | ireless AP

e =

» Setup Wireless AP mode allows this device to work as a stand-alone wireless access point on your existing network.

» USB Functions [T1 Enable AP Mode

» Security
» Administration

v Advanced Setup

Wirel in

Port Forwarding / Port
Triggering

Dynamic DNS

VPN Service

Static Routes @
Rem Managemen

uenp - -
IBvé Existing This NETGEAR router
Traffic Meter Router/Gateway acts as Wireless AP
USB Settings

Device Mode

Ethernat
cable

f Intemet Port

Internet
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Note: The screen might show the modem router model D6400 or another
model, as in the previous figure.

Select the Enable AP Mode check box.
The screen adjusts.

Scroll down and select the radio button for the IP address setting that you want to use:

e Get dynamically from existing router. The other router on the network assigns an
IP address to the modem router while the modem router functions in access point
mode.

» Enable fixed IP settings on this device (not recommended). Use this setting if you
want to manually assign a specific IP address to the modem router while it functions
in access point mode. Using this option effectively requires advanced network
experience.

Note: To avoid interference with other routers or gateways on your network,
NETGEAR recommends that you use different WiFi settings on each
router. You can also turn off the WiFi radio on the other router or
gateway and use the modem router only for WiFi client access.

Click the Apply button.
The IP address of the modem router changes, and you are disconnected.

To reconnect, close and restart your browser and type http://wwwrouterlogin.net.
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Control Access to the Internet

The modem router comes with a built-in firewall that helps protect your home network from
unwanted intrusions from the Internet.

This chapter includes the following sections:

e Set Up Parental Controls

» Allow or Block Access to Your Network

e Use Keywords to Block Internet Sites

* Manage Simple Outbound Firewall Rules for Services and Applications
e Set Up a Schedule for Keyword Blocking and Outbound Firewall Rules
e Set Up Security Event Email Notifications

For information about more advanced ways to configure Internet security, see Chapter 14,
Manage Port Forwarding and Port Triggering.

118

Download from Www.Somanuals.com. All Manuals Search And Download.



AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Set Up Parental Controls

The first time that you select Parental Controls from the BASIC Home screen, your browser
goes to the Parental Controls website, where you can learn more about Parental Controls. To
set up Parental Controls, you must download the genie app.

Parental Controls

The Easy Way to Set Some Online Boundaries

Manage What Your Teenager Can See and Do Online.

It's an online world and teenagers and children have unprecedented accessto it
For a parent, that can be a scary thought. How can you limit the time they spend
online—all that chalting, gaming, social networking, shopping, and YouTubing? How
will you protect them from potentially harmful and inappropriate material—without
looking over their shoulder 24/77 NETGEAR Parental Controls is the answer

With Parental Controls, you can block inappropriate and dangerous sites, restrict

s by time (for example, no Facebook during homework tim
nd at the same time protect e

ming, social media, etc.)

your home network against malware and phishing through one central control point
- your NETGEAR WiFi Router.

Figure 8. Parental Controls website

» To set up Parental Controls:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select Parental Controls.
The Parental Controls website opens.

6. Click the button for the genie app or version that you want to download and use.

Control Access to the Internet
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7. Follow the onscreen instructions to download and install the genie app.
Open the genie app and select Parental Controls.

Live Parental Controls automatically starts.

Parental Controls

Powered by OpenDNS

You're about to setup NETGEAR Live Parental Controls Powered by OpenDNS on your router to filter
websites visited on your computers and other networked devices

LIVE PARENTAL
CONTROLS ENABLED
SL ' NETGEAR ROUTER

v Set different filtering rules
fer each user en your network.

d

FILTERING: HIGH

f

FILTERING: MOME

|
L

v Set rules based on the time of day.

Our custom settings let you relax security settings for some users or at some times of the day. Leam more

9. Click the Next button, read the note, and click the Next button again.

Because Live Parental Controls uses free OpenDNS accounts, you are prompted to log
in or create a free account.

Setting up Live Parental Controls

Welcome, this setup wizard will quickly configure NETGEAR Live Parental Controls Powered by OpenDNS
on your NETGEAR router

In order to use Live Parental Controls, you need a free OpenDNS account. Do you already have one?

@ Yes, use my existing OpenDNS account

Mo, | need to create a free OpenDNS account

10. Select a radio button as follows:
e If you already own an OpenDNS account, leave the Yes radio button selected.

e If you did not yet create an OpenDNS account, select the No radio button.

If you are creating an account, the following screen displays.
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Create a free OpenDNS account

Please enter your information below.

Usemame | (Ghes il
Password

Confirm Password

Email

Confirm Email

a. Complete the fields.
b. Click the Next button.

After you log on or create your account, the filtering level screen displays.

Live Parental Controls: choose a filtering level for your
network

All computers connected to your router will be protected from the content you select below. You can
customize your Live Parental Controls later on our website.

MNone
Nothing blocked.
@ Minimal
Protects only against phishing attacks
- Low
Protects against pornography and phishing attacks.
) Moderate
Protects against all adult-related sites, illegal activity and phishing attacks.
) High

s It

11. Select a radio button for a filtering level and click the Next button.

Control Access to the Internet

121

Download from Www.Somanuals.com. All Manuals Search And Download.



AC1600 WiFi VDSL/ADSL Modem Router Model D6400

Setup is complete!
You have successfully setup NETGEAR Live Parental Controls Powered by OpenDNS. Next time you run
the Management Utility it will take you to the status screen where you can:

check whether Live Parental Controls are enabled

disable or enable Live Parental Controls

modify basic settings

change custom settings such as per-user and time-of-day based Live Parental Controls

Take me to the status screen

12. Click the Take me to the status screen button.

Status

Live Parental Controls: disabled Enable Live Parental Controls

Filtering level: Minimal Change Basic Settings
Protects only against phishing attacks. Change Custom Settings

OpenDNS account: tipham

Bypass account: Bypass Login

Parental Controls are now set up for the modem router.

13. To enable Parental Controls, click the Enable Live Parental Controls button.

Allow or Block Access to Your Network

You can use access control to block or allow access of devices to your network. You define
access by selecting or specifying the MAC addresses of the wired and WiFi devices that can
either access your entire network or are blocked from accessing your entire network.

Control Access to the Internet
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Enable and Manage Network Access Control

When you enable access control, you must select whether new devices are allowed to

access the network or blocked from accessing the network. By default, currently connected

devices are allowed to access the network, but you can also block these devices from

accessing the network.

To set up network access control:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.
2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.
The user name is admin. The default password is password. The user name and
password are case-sensitive.
4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Access Control.
| oo | -
il — [ Xcancel ]
s
» Setup You can use Access Control to allow or block computers or electronic devices from accessing your network.
) ] Turn on Access Control
RSB Bunctions 4 Access Rule: This is a general rule. You can also allow or block individual devices.
¥ Security 2 Allow all new devices to connect
Parental Controls Block all new devices from connecting
Access Control N
Block Sites [ Aow [
B Srves | W fsous Jooscotome——Jpasumss Juscasass | comecion s
ﬁy@ Allowed |BusinessLaptop 192.168.0.2 60:66:66.DA66:7C  |Wireless
Allowed I- 192.168.0.4 20:D6:70 2C:70.70  |Wireless
» Administration
» Advanced Setup » View list of allowed devices not currently connected to the network
* View list of blocked devices not currently connected to the network
6. Select the Turn on Access Control check box.

You must select this check box before you can specify an access rule and use the Allow
and Block buttons. When this check box is cleared, all devices are allowed to connect,
even if the device is in the list of blocked devices.

Click the Apply button.

Your settings are saved.
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8. Select an access rule for new devices:

* Allow all new devices to connect. With this setting, if you add a new device, it can
access your network. You do not need to enter its MAC address on this screen.
NETGEAR recommends that you leave this radio button selected.

e Block all new devices from connecting. With this setting, if you add a new device,
before it can access your network, you must enter its MAC address for an Ethernet
connection and its MAC address for a WiFi connection in the allowed list. For more
information, see Manage Network Access Control Lists on page 124.

The access rule does not affect previously blocked or allowed devices. It applies only to
devices joining your network in the future after you apply these settings.

9. To manage access for currently connected computers and devices:

e If you blocked all new devices from connecting, to allow the computer or device that
you are currently using to continue to access the network, select the check box next
to your computer or device in the table, and click the Allow button.

e To either continue to allow or to block other computers and devices that are currently
connected, select the check box next to the computer or device in the table, and click
either the Allow button or the Block button.

s [E—
| W [sotes |owicsbame  [Paddess  [WAcAdiess ComectonTios

Blocked |- 192.168.0.3 20:70:70:2CT0:7E  [Wireless
Allowed |BusinessLaptop 192.168.0.2 60:66:66:DA66.7C  [Wireless

10. Click the Apply button.

Your settings are saved.

Manage Network Access Control Lists

You can use access control to block or allow access to your network. An access control list
(ACL) functions with the MAC addresses of wired and WiFi devices that can either access
your entire network or are blocked from accessing your entire network.

The modem router can detect the MAC addresses of devices that are connected to the
network and list the MAC addresses of devices that were connected to the network.

Each network device owns a MAC address, which is a unique 12-character physical address,
containing the hexadecimal characters 0-9, a—f, or A—F (uppercase or lowercase) only, and
separated by colons (for example, 00:09:AB:CD:EF:01). Typically, the MAC address is on the
label of the WiFi card or network interface device. If you cannot see the label, you can display
the MAC address using the network configuration utilities of the computer. You might also
find the MAC addresses through the web management interface of the modem router (see
View Devices Currently on the Network on page 240).
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Add Devices to or Remove Them from the Allowed List

If you set up an access list that blocks all new devices from accessing your network, you
must specify which devices are allowed to access your network.

» To add or remove devices that are allowed:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Access Control.

The Access Control screen displays.

6. Click the View list of allowed devices not currently connected to the network link.

. o )

ADVANCED Home | \ccess Contro
i il
» Setup You can use Access Control to allow or block computers or electronic devices from accessing your network.
" R ——— [¥] Turn on Access Control
Access Rule: This is a general rule. You can also allow or block individual devices.
» Security @ Allow all new devices to connect
Parental Controls "} Block all new devices from connecting
e [ o [ wock |
Blck servces @[S [pescetoms  [Phtess |wachdess
Schedule —
e [l BusinessLaptop 168.0. 60:66:66:DAG6TC  |Wireless
E-mail

» Administration

» Advanced Setup Remove from the list

n—

» View list of blocked devices not currently connected to the network

A table displays the detected device names, MAC addresses, and connection types of
the devices that are not connected but allowed to access the network.

7. To add a device to the allowed list, do the following:
a. Click the Add button.

The Add Allowed Device screen displays.
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b. Enter the MAC address and device name for the device that you want to allow.
c. Click the Add button on the Add Allowed Device screen.

The device is added to the allowed list on the Access Control screen.
8. To remove a device from the allowed list, do the following:

a. Select the check box for the device.
b. Click the Remove from the list button.

The device is removed from the allowed list.
9. Click the Apply button.

Your settings are saved.

Add Devices to or Remove Them from the Blocked List

If you set up an access list that allows all new devices to access your network but you want to
block some devices from accessing your network, you must specify the devices that you want
to block.

To add or remove devices that are blocked:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Security > Access Control.
The Access Control screen displays.

6. Click the View list of blocked devices not currently connected to the network link.
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D e TR
ADVANCED Home ] Access Control
O ' IR X Crc=' |
» Setup You can use Access Control to allow or block computers or electronic devices from accessing your network.
» USB Functions 1 Tum on Access Control
Access Rule: This is a general rule. You can also allow or block individual devices.
¥ Security @ Allow all new devices to connect
Parental Controls '} Block all new devices from connecting
Access Control
Block Sites (IS
B erees T e e e e
Cl e
Senetul ] [atowed [BusinessLaptop 192.168.0.2 80:66:66:DA667C |Wireless

E-mail

» Administration » View list of allowed devices not currently connected to the network

» Advanced Setup

w list of blocked devices not currently connected to the ne

Remove from the list
Wittt

20:D670:2C:70:70 | Wireless

A table displays the detected device names, MAC addresses, and connection types of
the devices that are not connected and blocked from accessing the network.

7. To add a device to the blocked list, do the following:
a. Click the Add button.
The Add Blocked Device screen displays.

b. Enter the MAC address and device name for the device that you want to block.
Click the Add button on the Add Blocked Device screen.

The device is added to the blocked list on the Access Control screen.

8. To remove a device from blocked list, do the following:
a. Select the check box for the device.
b. Click the Remove from the list button.

The device is removed from the blocked list.
9. Click the Apply button.

Your settings are saved.

Use Keywords to Block Internet Sites

You can block keywords and domains (websites) to prevent certain types of HTTP traffic from
accessing your network. By default, keyword blocking is disabled and no domains are
blocked.

Control Access to the Internet
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Set Up Blocking

You can set up blocking of specific keywords and domains to occur continuously or according
to a schedule.
» To set up keyword and domain blocking:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Sites.

[ ADVANCED 1 Auto -

ADVANCED Home

» Setup To learn more aboul advanced content filtering and keyword blocking features from NETGEAR, please goto
www.netgear.com/ipc.

WPS Wizard

» USB Functions

X Keyword Blocking
v Security ® Never
Parental Controls ) Per Schedule
Access Control ) Always
Block Sorvices Type keyword or domain name here.
Schedule
Emal

» Administration Block sites containing these keywords or domain names:

» Advanced Setup =

¥ Delete Keyword Clear List

[Z] Allow trusted IP address to visit blocked sites
Trusted IP Address 192 |.[168 |.|0 .|0

6. Specify a keyword blocking option:
e Per Schedule. Use keyword blocking according to a schedule that you set.

For more information, see Set Up a Schedule for Keyword Blocking and Outbound
Firewall Rules on page 138.

Always. Use keyword blocking continuously.
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In the Type keyword or domain name here field, enter a keyword or domain.
Here are some sample entries:

e Specify XXX to block http://www.badstuff.com/xxx.html.

e Specify .com if you want to allow only sites with domain suffixes such as .edu or .gov.
e Enter a period (.) to block all Internet browsing access.

Click the Add Keyword button.

The keyword or domain is added to the Block sites containing these keywords or
domain names field (which is also referred to as the blocked list).

To add more keywords or domains, repeat Step 7 and Step 8.
The keyword list supports up to 32 entries.
Click the Apply button.

Your settings are saved.

Remove a Keyword or Domain from the Blocked List

If you no longer need a keyword or domain on the blocked list, you can remove the keyword
or domain.

To remove a keyword or domain from the blocked list:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Security > Block Sites.
The Block Sites screen displays.

In the Block sites containing these keywords or domain names field, select the
keyword or domain that you want to remove.

Click the Delete Keyword button.
The keyword or domain is removed from the blocked list.
Click the Apply button.

Your settings are saved.
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Remove All Keywords and Domains from the Blocked List

You can simultaneously remove all keywords and domains from the blocked list.

To remove all keywords and domains from the blocked list:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Sites.
The Block Sites screen displays.
6. Click the Clear List button.
All keywords and domains are removed from the blocked list.
7. Click the Apply button.

Your settings are saved.

Specify a Trusted Computer

You can exempt one trusted device from blocking and logging. The device that you exempt
must be assigned a fixed (static) IP address.
To specify atrusted device:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Sites.
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[

ADVANCED Home
WPS Wizard 1

» Setup
» USB Functions
w Security

Parental Controls
Access Control
Block Services
Schedule
I

£

» Administration

» Advanced Setup

ADVANCED 1 Auto -

To learn more about advanced content filtering and keyword blocking features from NETGEAR, please go to
www.netgear.com/ipc.

Keyword Blocking
@ Never
) Per Schedule
) Always

Type keyword or domain name here.

Block sites containing these keywords or domain names:

e toyvors I cewrtot ]

["] Allow trusted IP address to visit blocked sites
Trusted P Address 192 |.[168 |.|0 .|0

Scroll down and select the Allow trusted IP address to visit blocked sites check box.
7. In the Trusted IP Address field, enter the IP address of the trusted device.

The first three octets of the IP address are automatically populated and depend on the IP
address that is assigned to the modem router on the LAN Setup screen.

8. Click the Apply button.

Your settings are saved.

Manage Simple Outbound Firewall Rules for Services and

Applications

A firewall protects one network (the trusted network, such as your LAN) from another (the
untrusted network, such as the Internet), while allowing communication between the two.

The modem router provides one default outbound firewall rule: It allows all access to the
Internet (that is, the WAN). You can add simple rules to prevent access to specific services
and applications on the Internet. In addition, you can specify if a rule applies to one user, a
range of users, or all users on your LAN.

The modem router lists many default services and applications that you can use in outbound
rules. You can also add an outbound firewall rule for a custom service or application.

For information about blocking specific keywords, URLS, or sites, see Use Keywords to Block
Internet Sites on page 127. This type of blocking is another aspect of the outbound firewall.
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For information about inbound firewall rules, see Manage Port Forwarding and Port
Triggering on page 260.

Note: Service blocking means the same thing as applying outbound firewall
rules.

Add an Outbound Firewall Rule

You can add an outbound firewall rule to prevent access to a specific service or application
on the Internet.
To add an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Services.

-

ADVANCED Home | DIOCK Services
Setup Wizard |

ADVANCED 1 Auto v

» Setup
» USB Functions
» Security

Parental Controls
Access Control
Block Sites
Schedule

E-mail

» Administration

» Advanced Setup

Services Blocking
9 Never
_) Per Schedule
! Always

Service Table

Service Type

6. In the Service Blocking section, specify how the modem router applies outbound rules:
e Per Schedule. The modem router applies outbound rules according to a schedule that

you set.
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For more information, see Set Up a Schedule for Keyword Blocking and Outbound

Firewall Rules on page 138.

» Always. The modem router applies outbound rules continuously.

7. Below the Service Table, click the Add button.

Protocol TCP
Starting Port
Ending Port

Sendce TypeUser Defined

Sendce Type User Defined

(1~65535)
{1-63535)

Filter Services For:

Only This IP Address : 192

IP Address Range: 192
to 192
9 AllIP Addresses

8. From the Service Type menu, select service or application to be covered by this rule.

If the service or application does not display in the list, you can add it (see Add an
Outbound Firewall Rule for a Custom Service or Application on page 133).

9. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their

IP addresses:

« Only This IP Address. Enter the required address in the fields to apply the rule to a

single device on your LAN.

« |P Address Range. Enter the required addresses in the start and end fields to apply

the rule to a range of devices.

e All IP Addresses. All computers and devices on your LAN are covered by this rule.
By default, the All IP Addresses radio button is selected.

10. Click the Add button.

The new rule is added to the Service Table on the Block Services screen.

Add an Outbound Firewall Rule for a Custom Service or

Application

The modem router lists many default services and applications that you can use in outbound
rules. If the service or application is not predefined, you specify a custom service or

application in an outbound rule.
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> To add an outbound firewall rule for a custom service or application:

1.

7.

8.

Find out which protocol and port number or range of numbers the service or application
uses.

You can usually find this information by contacting the publisher of the service or
application or through online user or news groups.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Security > Block Services.

L R -

ADVANCED Home | BloCK Services
Setup Wizard |

» Setup Services Blocking
9 Never

_) Per Schedule
w Security ! Always

Parental Controls Service Table

Access Control [ | # |
#

Block Sites

Schedule i i il

E-mail

» USEB Functions

Service Type | Port P

» Administration

» Advanced Setup

If this is the first time that you add an outbound firewall rule, in the Service Blocking section,
specify how the modem router applies outbound rules:

e Per Schedule. The modem router applies outbound rules according to a schedule that
you set.

For more information, see Set Up a Schedule for Keyword Blocking and Outbound
Firewall Rules on page 138.

e Always. The modem router applies outbound rules continuously.
Below the Service Table, click the Add button.
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Senice Type
Protocol

Starting Port
Ending Port

Senice TypeUser Defined

User Defined -

TCP -
(1~655385)
(1~65535)

Filter Services For:

Only This IP Addregs :

IP Address Range:

2 AllIP Addresses

192 168 0

132 168 0
to 192 168 0

9. From the Service Type menu, select User Defined.

10. Specify a hew outbound

rule as described in the following table.

Field

Description

Protocol

Select the protocol (TCP or UDP) that is associated with the service or
application. If you are unsure, select TCP/UDP.

Starting Port

Enter the start port for the service or application.

Ending Port

If the service or application uses a range of ports, enter the end port for the
range. If the service or application uses a single port, repeat the port number
that you entered in the Starting Port field.

Service Type/User Defined

Enter the name of the custom service or application.

11. Specify which devices on your LAN (or LAN users) are affected by the rule, based on their

IP addresses:

« Only This IP Address. Enter the required address in the fields to apply the rule to a
single device on your LAN.

 |P Address Range.

Enter the required addresses in the start and end fields to apply

the rule to a range of devices.
e All IP Addresses. All computers and devices on your LAN are covered by this rule.
By default, the All IP Addresses radio button is selected.

12. Click the Add button.

The new rule is added to the Service Table on the Block Services screen.
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Change an Outbound Firewall Rule
You can change an existing outbound firewall rule.

To change an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Services.

The following figure shows two rules in the Service Table.

I o =
ADVANCED Home ] BIOCK Services
Setup Wizard |
» Setup Services Blocking
)
» USB Functions : hever
-/ Per Schedule
v Security ' Always
Parental Controls Service Tabie
Access Control =
= # Service Type Port IP
Block Sites
o 1 Quake Il & 11l 27960 192.168.0.145 - 192.168.0.185
Schedule 0 2 Age of Empire 47624 all
E-mail
¥ Edit Delet:
» Administration m i
» Advanced Setup

. In the Service Table, select the radio button for the rule.
7. Click the Edit button.
The Block Services Setup screen displays.
8. Change the settings.

For more information about the settings, see Add an Outbound Firewall Rule for a
Custom Service or Application on page 133.

9. Click the Accept button.

Your settings are saved. The changed rule displays in the Service Table on the Block
Services screen.
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Remove an Outbound Firewall Rule

You can remove an outbound firewall rule that you no longer need.

To remove an outbound firewall rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Security > Block Services.

The following figure shows two rules in the Service Table.

[ ADVANCED 1 Auto

ADVANCED Home DIOCK Services

Setup Wizard

» Setup Services Blocking
» USB Functions o haver
' Per Schedule
v Security ) Always
Parental Controls Service Table
w # Service Type Port IP
Block Sites
@ 1 Quake Il &Il 27960 192.168.0.145 - 192.168.0.185
Schedule © 2 Age of Empire 47624 all
E-mail

B N ETXE

» Administration

» Advanced Setup

6. In the Service Table, select the radio button for the rule.
7. Click the Delete button.
The rule is removed from the Service Table.
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Set Up a Schedule for Keyword Blocking and Outbound

Firewall Rules

You can set up a schedule that you can apply to keyword blocking (see Use Keywords to
Block Internet Sites on page 127) and outbound firewall rules (see Manage Simple Outbound
Firewall Rules for Services and Applications on page 131).

If applied, the schedule specifies the days and time that keyword blocking and outbound

firewall rules are active.

By default, no schedule is set and you can either enable or disable this feature.

> To set up a schedule for blocking:

1. Launch an Internet browser from a computer or WiFi device that is connected to the

network.

2. Type http://www.routerlogin.net.

A login screen displays.

3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.

The BASIC Home screen displays.
5. Select ADVANCED > Security > Schedule.

(GMT) Greenwich Mean Time: Dublin. Edinburgh, Lisbon. London
[T Automatically adjust for daylight savings time

L R -
ADVANCED Home ] schedul
Setup Wizard ] e ; I m
» Setup Days to Block:
T
&
» USB Functions ' Bery Day
Sunday
aecuy Monday
Parental Controls Tuesday
Access Control Wednesday
Block Sites Thursday
Block Services :
Block Services Friday
w Saturda
E-mail Y
- Time of day to block:(use 24-hour clock)
» Administration e
] All Day
» Advanced Setup Start Blocking 0  Hour o Minute
End Blocking 24 Hour 0 |Minute
Time Zone

Current Time: Friday, 20 Mar 2015 05:29:14
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Set up the schedule for blocking:

» Days to Block. Select the check box for each day that you want to block access or
specify that blocking occurs on every day by selecting the Every Day check box.

By default, the Every Day check box is selected.

« Time of Day to Block. Select a start and end time for blocking in 24-hour format or
select the All Day check box for 24-hour blocking.

By default, the All Day check box is selected.

From the Time Zone menu, select your time zone.
If you live in an area that observes daylight saving time, select the Automatically adjust for
daylight savings time check box.

Note: If the modem router synchronizes its internal clock with a time server
on the Internet and you selected the correct time zone, the Current
Time field displays the correct date and time.

Click the Apply button.

Your settings are saved.

Set Up Security Event Email Notifications

The modem router can email you its logs of its activity. The log records router activity and
security events such as attempts to access blocked sites or services.

> To set up email notifications:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Security > E-mail.
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ADVANCED Home

Setup Wizard

WPS Wizard

» Setup
» USB Functions
» Security

Parental Controls
Access Control
Block Sites
Block Semvices
Schedule

» Administration

» Advanced Setup

ADVANCED Auto

| Turn E-mail Notification On

Send alerts and logs through e-mail
Your Outgoing Mail Server

Send to This E-mail Address
Outgoing Mail Server Port Number 25

My mail server requires authentication
User Name

Password [ITYYTYT]

Send Alert Immediately
When someone attempts to visit a blocked site

Send logs according to this schedule
MNone g
Day | Sunday

Time | 12:00 @ am.

6. Select the Turn E-mail Notification On check box.

7. Enter the settings as described in the following table.

Field

Description

Send alerts and logs through e-mail

Your Outgoing Mail Server

Enter the name of your ISP’s outgoing (SMTP) mail server (such as
mail.mylSP.com).

You might be able to find this information in the configuration screen of your
email program. If you leave this field blank, the modem router cannot send
log and alert messages.

Send to This E-mail Address

Enter the email address to which logs and alerts must be sent.

Outgoing Mail Server Port
Number

Enter the port number for your ISP’s outgoing mail server. The default port
number is 25.

My mail server requires
authentication

If your ISP’s outgoing email server requires authentication, select this
check box and specify the following settings:

In the User Name field, enter the user name for your ISP’s outgoing
email server.

In the Password field, enter the password for your ISP’s outgoing
email server.

Send Alert Immediately

By default, this check box is selected and email alerts are sent immediately
when someone attempts to visit a blocked site.
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Field Description

Send logs according to this schedule

To send logs based on a schedule, select one of the following options from the menu:
*  When log is full. This is the default selection.
e Hourly. Logs are sent every hour.

- Daily. Logs are sent every day. From the Time menu, specify the time of day, and select the am or pm
radio button.

*  Weekly. Logs are sent every week. From the Day menu, select the day. From the Time menu, specify
the time of day, and select the am or pm radio button.

If you do not want logs to be sent at all, select the None option from the menu.

8. Click the Apply button.
Your settings are saved.

Logs are sent automatically. If the log fills before the specified time, it is sent. After the log
is sent, it is cleared from the modem router memory. If the modem router cannot email the
log and the log buffer fills, the modem router overwrites the log.
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Optimize Performance

This chapter describes how you can optimize the modem router’s performance and manage the
traffic flows through the modem router.

This chapter contains the following sections:

e Optimize Traffic with Internet Access QoS

» Manage Default and Custom QoS Rules

* Manage Wi-Fi Multimedia Quality of Service

e Manage Implicit Beamforming

* Improve Network Connections with Universal Plug and Play
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Optimize Traffic with Internet Access QoS

You can use Quality of Service (QoS) rules to assign different priorities to Internet traffic,
applications, services, and devices on your LAN. The modem router provides default QoS
rules. You add custom QoS rules and manage both default and custom QoS rules (see
Manage Default and Custom QoS Rules on page 144).

NETGEAR recommends that you enable Internet access QoS only if you use streaming
Internet. When Internet access QoS assigns a high priority to streaming video, it also assigns
lower priority to the rest of your Internet traffic. That means that other tasks such as
downloading content from the Internet take longer.

> To enable Internet access QoS:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Setup > QoS Setup.

L e —

ADVANCED Home )
Setup Wizard |
e —

¥ Setup /] Enable WMM (Wi-Fi multimedia) settings

Internet Setup
Wireless Setup
WAN Setup

A
LAN Setup Uplink bandwidth: Maximum 512 Kbps = OOI\ LA
QoS Setup
Guest Network
VLAN/Bridge Settings QoSS Priority Rule list

[”] Turn Internet Access QoS On
POWERED BY

» USB Functions
» Security
» Administration

» Advanced Setup

6. Select the Turn Internet Access QoS On check box.
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Specify the uplink bandwidth settings by doing one of the following:

e If you know the uplink bandwidth of your Internet connection, type it in the Uplink
bandwidth Maximum field.

« If you are not sure, click the SpeedTest button.

The speed test checks your uplink bandwidth and automatically enters the detected
uplink bandwidth in the Uplink bandwidth Maximum field.

Click the Apply button.

Your settings are saved.

Manage Default and Custom QoS Rules

QoS rules apply when you enable Internet access QoS (see Optimize Traffic with Internet
Access QoS on page 143).

You can add custom QoS rules and change and remove both default and custom QoS rules.
You can add QoS rules for services and applications but also for specific devices on your
network.

You can set up custom rules for the following components:

Application or online game (see Create a Custom QoS Rule for an Application or Online
Game on page 145)

Ethernet LAN port of the modem router (see Create a Custom QoS Rule for a Modem
Router LAN Port on page 147)

Device on the LAN by MAC address (see Create a Custom QoS Rule for a MAC Address
on page 148)

View the Default QoS Rules

The modem router provides default QoS rules for common applications and games.

> To view the default QoS rules:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
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5. Select ADVANCED > Setup > QoS Setup.

The QoS Setup screen displays.
6. Click the Set Up QoS Rule button.

[——

ADVANCED Home ]
Setup Wizard 1
w Sefup

Internet Setup
Wireless Setup
VAN Setup
LAN Setup

QoS Setup

Guest Network
VLANBridge Settings

» USB Functions
» Security
» Administration

» Advanced Setup

ADVANCED | Auto
# QoS Policy Priority Description
1 MSM Messenger High MSN Messenger Applications
2 Skype Highest Skype Applications
3 Yahoo Messenger High Yahoo Messenger Applications
4 IP Phone Highest IP Phone Applications
5 Vonage |P Phone Highest Vonage IP Phone Applications
6 MetMeeting High Netheeting Applications
7 Al High AIM Applications
g Google Talk Highest Google Talk Applications
9 Metgear EVA Highest Metgear EVA Applications
10 S55H High SSH Applications
1 Telnet High Telnet Applications
12 VPN High VPM Applications
13 FTP Mormal FTP Applications
14 SMTP Mormal SMTP Applications
15 www Normal WWW Applications
16 DNS Normal DNS Applications
17 ICMP Normal ICHP Applications

m

7. Scroll down to see more QoS rules.

Create a Custom QoS Rule for an Application or Online Game

If the application or online game for which you want to assign a traffic priority is not part of the
default QoS rules, you can add a custom QoS rule.

To create a QoS policy for an application or online game:
1.

For information about changing a default QoS rule, see Change a Default or Custom QoS

Rule on page 151.

Launch an Internet browser from a computer or WiFi device that is connected to the

network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and

password are case-sensitive.

Click the OK button.
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The BASIC Home screen displays.

Select ADVANCED > Setup > QoS Setup.

The QoS Setup screen displays.

Click the Set Up QoS Rule button.

The QoS Priority Rule list screen displays.

Scroll down and click the Add Priority Rule button.
The QoS - Priority Rules screen displays.

From the Priority Category menu, select one of the following options:

* Applications. When you select Applications from the Priority Category menu, the
Applications menu lets you select existing applications, but scroll down to the bottom
of the menu to select Add a new application.

Priority

QoS Paolicy for

Priority Category Applications -
Applications Add a new application ~
Priority MNomal -

Specified Port Range

Connection Type TCP/UDP -
Starting Pon {1~65535)
Ending Port {1~65535)

¢ Online Gaming. When you select Online Gaming from the Priority Category menu,
the Applications menu lets you select existing games, but scroll down to the bottom
of the menu to select Add a new game.

Priority

QoS Policy for

Priority Category Online Gaming -
Applications Add anewgame =
Prionty MNomal -

Specified Port Range

Connection Type TCPUDP -

Starting Port {1~85535)
Ending Porl (1~65535)
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Specify the new QoS rule as described in the following table.

Field Description

Priority

QoS Policy for Enter a name for the QoS rule.

Priority Select the priority (Highest, High, Normal, or Low) that must be assigned to the

application or game.

Specified Port Range

Connection Type Select the protocol (TCP or UDP) that is associated with the application or game.
If you are unsure, select TCP/UDP.

Starting Port Enter the start port number for the application or game.

Ending Port Enter the end port number for the application or game.

10. Click the Apply button.

Your settings are saved. The new rule is added to the table on the QoS Priority Rule list
screen. However, if you restart the modem router, the QoS rule is removed.

11. On the QoS Priority Rule list screen, click the Apply button.

Your settings are saved and the new QoS rule remains available after you restart the
modem router.

Create a Custom QoS Rule for a Modem Router LAN Port

You can add a custom QoS rule that applies only to a specific LAN port of the modem router.
The rule affects any device that is connected to the LAN port.

To create a QoS policy for a LAN port of the modem router:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > QoS Setup.
The QoS Setup screen displays.

Click the Set Up QoS Rule button.
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The QoS Priority Rule list screen displays.
Scroll down and click the Add Priority Rule button.
The QoS - Priority Rules screen displays.

From the Priority Category menu, select Ethernet LAN Port.

Priority

QoS Policy for LAN Port 1

Priority Category Ethernet LAN Port «
LAN Port 1w

Pririty MNormal -

From the LAN Port menu, select the LAN port (1, 2, 3, or 4) for which you want to configure
the QoS policy.

The QoS Policy for field updates automatically.

From the Priority menu, select the priority (Highest, High, Normal, or Low) that must be
assigned to the LAN port.

Click the Apply button.

Your settings are saved. The new rule is added to the table on the QoS Priority Rule list
screen. However, if you restart the modem router, the QoS rule is lost.

On the QoS Priority Rule list screen, click the Apply button.

Your settings are saved and the new QoS rule remains available after you restart the
modem router.

Create a Custom QoS Rule for a MAC Address

You can add a custom QoS rule that applies only to a specific MAC address for a device on
the LAN.

To create a QoS policy for a specific MAC address:

1.

2.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
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Select ADVANCED > Setup > QoS Setup.

The QoS Setup screen displays.

Click the Set Up QoS Rule button.

The QoS Priority Rule list screen displays.

Scroll down and click the Add Priority Rule button.
The QoS - Priority Rules screen displays.

From the Priority Category menu, select MAC Address.

Priority
QoS Policy for
Priority Category MAC Address -
MAC Device List
GoS Policy Priority Device Name MAC Address
Pri_MAC_DAS4TC Normal BusinessLaptop 60:66.66.DA667C
MAC Address
Device Name
Priority Normal =
[ Add ' Edit || Delete | - Refresh |

In the QoS Policy for field, type a descriptive name for the new policy.

If the device for which you want to create a QoS policy is displayed in the MAC Device List,
select its radio button.

The information from the MAC Device List automatically populates the QoS Policy for,
MAC Address, and Device Name fields.

If the device does not display in the MAC Device List, click the Refresh button.

If it still does not display, complete the QoS Policy for, MAC Address, and Device
Name fields manually.

From the Priority menu, select the priority (Highest, High, Normal, or Low) that must be
assigned to the MAC address.

Click the Apply button.

Your settings are saved. The new rule is added to the table on the QoS Priority Rule list
screen. However, if you restart the modem router, the QoS rule is lost.

On the QoS Priority Rule list screen, click the Apply button.

Your settings are saved and the new QoS rule remains available after you restart the
modem router.
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Change a MAC Address for a QoS Rule
» To change a MAC address on the MAC Device List for QoS rules:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Setup > QoS Setup.
The QoS Setup screen displays.
6. Click the Set Up QoS Rule button.
The QoS Priority Rule list screen displays.
7. Scroll down and click the Add Priority Rule button.
The QoS - Priority Rules screen displays.
8. From the Priority Category menu, select MAC Address.
The MAC Device List displays.
9. Inthe MAC Device List, select the radio button next to the device that you want to change.

The information from the MAC Device List automatically populates the QoS Policy for,
MAC Address, and Device Name fields.

10. Change the MAC address, device name, or priority.
11. Click the Edit button.

The new device information is saved in the MAC Device List.

Note: You cannot change the MAC address for a device that was detected
by the modem router and automatically added to the MAC Device List.

Remove a MAC Address for a QoS Rule

> To remove a MAC address from the MAC Device List for QoS rules:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.

A login screen displays.
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Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > QoS Setup.

The QoS Setup screen displays.

Click the Set Up QoS Rule button.

The QoS Priority Rule list screen displays.

Scroll down and click the Add Priority Rule button.

The QoS - Priority Rules screen displays.

From the Priority Category menu, select MAC Address.
The MAC Device List displays.

In the MAC Device List, select the radio button next to the device that you want to remove.
Click the Delete button.

The device information is removed from the MAC Device List.

Note: You cannot remove a device that was detected by the modem router
and automatically added to the MAC Device List.

Change a Default or Custom QoS Rule

You can change a default or custom QoS rule.

To change a default or custom QoS rule:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Setup > QoS Setup.
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ADVANCED 1 Auto -
ADVANCED Home
(RN
¥ Setup # QoS Policy Priority Description [
Internet Setup 1 MSN Messenger High MSN Messenger Applications
Wireless Setup 2 Skype Highest Skype Applications
%ﬂ 3 Yahoo Messenger High Yahoo Messzenger Applications
4 IP Phone Highest IP Phone Applications 2
Guest Network 5 Vonage IP Phong Highest Vonage IP Phone Applications
VLAN/Bridge Settings 6 NetMeeting High NetMesting Applications
T AlM High AW Applications
» USB Functions
8 Google Talk Highest Google Talk Applications
22 9 Netgear EVA Highest Metgear EVA Applications
* Administration 10 SSH High SSH Applications
» Advanced Setup 1 Telnet High Telnet Applications
12 VPN High VPN Applications
13 FTP Mormal FTP Applications
14 SMTP Mormal SMTP Applications
15 WWwW Mormal WWW Applications
16 DNS Normal DNS Applications
17 ICMP Normal ICHP Applications .

Select the radio button next to the QoS policy that you want to view or change.
Scroll down and click the Edit button.

The QoS - Priority Rules screen displays.

Change the policy settings.

For default QoS rules, NETGEAR recommends that you change the priority only. For
information about changing custom QoS rules, see the following sections:

* Create a Custom QoS Rule for an Application or Online Game on page 145
* Create a Custom QoS Rule for a Modem Router LAN Port on page 147

e Create a Custom QoS Rule for a MAC Address on page 148

Click the Apply button.

Your settings are saved. The rule is updated in the table on the QoS Priority Rule list
screen. However, if you restart the modem router, the changed to the QoS rule are lost.

On the QoS Priority Rule list screen, click the Apply button.

Your settings are saved and the updated QoS rule remains available after you restart the
modem router.
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Remove a QoS Rule

You can remove an individual custom or default QoS rule.

To remove an individual QoS rule:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > QoS Setup.
The QoS Setup screen displays.

Select the radio button for the application, game, LAN port, or MAC address.
Scroll down and click the Delete button.

The QoS rule is removed.

Remove All QoS Rules

You can permanently remove all custom and default QoS rules.

A WARNING:

If you remove all QoS rules, both the custom and default QoS rules
are permanently removed. The only way to get the default QoS rules
back is by returning the modem router to factory default settings.

To remove all QoS rules:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
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The BASIC Home screen displays.

5. Select ADVANCED > Setup > QoS Setup.
The QoS Setup screen displays.

6. Scroll down and click the Delete All button.

All QoS rules are permanently removed.

Manage Wi-Fi Multimedia Quality of Service

Wi-Fi Multimedia Quality of Service (WMM QoS) prioritizes WiFi voice and video traffic over
the WiFi link.

WMM QoS prioritizes WiFi data packets from different applications based on four access
categories: voice, video, best effort, and background. For an application to receive the
benefits of WMM QoS, WMM must be enabled on both the application and the client running
that application. Legacy applications that do not support WMM and applications that do not
require QoS are assigned to the best effort category, which receives a lower priority than
voice and video.

WMM QoS is automatically enabled for the modem router. However, you can disable WMM
QoS.
> To disable WMM QoS:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > QoS Setup.
The QoS Setup screen displays.

6. Clear the Enable WMM (Wi-Fi multimedia) settings check box.
7. Click the Apply button.

Your settings are saved.
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Manage Implicit Beamforming

\7

The modem router supports beamforming to enhance the WiFi range and performance for
your WiFi devices. When you enable beamforming and connect to the WiFi network, the
modem router actively tracks your device and directs WiFi to your device, rather than just
blasting it out in all directions.

The modem router uses explicit and implicit beamforming to improve WiFi performance.
Explicit beamforming requires the devices to support beamforming. (Typically, 802.11ac
devices support beamforming.) Implicit beamforming means that the modem router supports
beamforming even with devices that do not support beamforming. The modem router
supports implicit beamforming for both 2.4 GHz and 5 GHz devices, which means that the
modem router can provide beamforming benefits of better range and performance for all WiFi
devices, even older 802.11a/b/g/n devices and not just the latest WiFi devices.

To enable implicit beamforming:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Wireless Settings.
The Wireless Settings screen displays.

6. Scroll down to the very bottom of the screen.

WPS Settings
Routers PIN: 77816801
[¥] Enable Routers PIN
¥ To prevent PIN compromise, auto disable the PIM after 3 failed PIN connections, until router

reboots.
In auto disabled mode, router's WPS LED will keep blinking slowly

[¥] Keep Existing Wireless Seftings (2 4GHz bigin)
| Keep Existing Wireless Settings (SGHz ain/ac)

[”] Enable Implicit BEAMFORMING - Boosts WiFi speed, reliability, & range for all mobile devices

7. Select the Enable Implicit BEAMFORMING check box.
Click the Apply button.

Your settings are saved.
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Improve Network Connections with Universal Plug and

Play

Universal Plug and Play (UPnP) helps devices such as Internet appliances and computers
access the network and connect to other devices as needed. UPnP devices can
automatically discover the services from other registered UPnP devices on the network.

If you use applications such as multiplayer gaming, peer-to-peer connections, or real-time
communications such as instant messaging or remote assistance, keep UPnP enabled,
which it is by default.

> To manage Universal Plug and Play:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > UPnP.
The UPnP screen displays.

Select or clear the Turn UPnP On check box.

By default, this check box is selected. UPnP for automatic device configuration can be
enabled or disabled. If the Turn UPnP On check box is cleared, the modem router does
not allow any device to automatically control router resources, such as port forwarding.

Enter the advertisement period in minutes.

The advertisement period specifies how often the modem router broadcasts its UPnP
information. This value can range from 1 to 1440 minutes. The default period is 30
minutes. Shorter durations ensure that control points detect current device status at the
expense of more network traffic. Longer durations can compromise the freshness of the
device status but can significantly reduce network traffic.

Enter the advertisement time to live in hops.

The time to live for the advertisement is measured in hops (steps) for each UPnP packet
sent. Hops are the steps a packet takes between routers. The number of hops can range
from 1 to 255. The default value for the advertisement time to live is 4 hops, which should
be fine for most home networks. If you notice that some devices are not being updated or
reached correctly, it might be necessary to increase this value.
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9. Click the Apply button.

The UPnP Portmap Table displays the IP address of each UPnP device that is accessing
the modem router and which ports (internal and external) that device opened. The UPnP
Portmap Table also displays what type of port is open and whether that port is still active
for each IP address.

10. To refresh the information in the UPnP Portmap Table, click the Refresh button.
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Share a Storage Device

This chapter describes how to access and manage a storage device attached to your modem
router. ReadySHARE lets you access and share a USB storage device connected to the modem
router. (If your storage device uses special drivers, it is not compatible.)

Note: You can use the USB port on the modem router only to connect a
USB storage device such as a flash drive or hard drive or a printer. Do
not connect a computer, USB modem, CD drive, or DVD drive to the
modem router USB port.

The chapter includes the following sections:

e USB Device Requirements

* Connect a USB Device to the Modem Router

e Access a Storage Device Connected to the Modem Router
e Back Up Windows Computers with ReadySHARE Vault

* Back Up Mac Computers with Time Machine

» Manage Access to a Storage Device

* Enable FTP Access Within Your Network

* View Network Folders on a Device

e Add a Network Folder on a Storage Device

» Change a Network Folder, Including Read and Write Access, on a USB Drive
» Approve USB Devices

e Safely Remove a USB Device

Note: For more information about ReadySHARE features, visit
netgear.com/readyshare.

158

Download from Www.Somanuals.com. All Manuals Search And Download.


www.netgear.com/readyshare

AC1600 WiFi VDSL/ADSL Modem Router Model D6400

USB Device Requirements

The modem router works with most USB-compliant external flash and hard drives. For the
most up-to-date list of USB devices that the modem router supports, visit
kbserver.netgear.com/readyshare.

Some USB external hard drives and flash drives require you to load the drivers onto the
computer before the computer can access the USB device. Such USB devices do not work
with the modem router.

The modem router supports the following file system types for full read/write access:

« FAT16

 FAT32

* NTFS

e NTFS with compression format enabled
e Ext2

e Ext3

e Ext4

The modem router supports the following file system types with read-only access:

- HFS
. HFS+

Connect a USB Device to the Modem Router

ReadySHARE lets you access and share a USB device that is connected to a USB port on
the modem router. (If your USB device uses special drivers, it is not compatible.) One USB
port is on the back panel of the modem router and another is on the right side panel.

USB 2.0 port on the back panel

USB 2.0 port on the right side panel

Figure 9. USB ports on modem router
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> To connect a USB device:
1. Connect your USB storage device to the USB port on the modem router.
2. If your USB device uses a power supply, connect it.
You must use the power supply when you connect the USB device to the modem router.

When you connect the USB device to the USB port of the modem router, it might take up
to two minutes before the USB device is ready for sharing. By default, the USB device is
available to all computers on your local area network (LAN).

Access a Storage Device Connected to the Modem Router

From a computer or device on the network, you can access a storage device that is
connected to the modem router.

> To access the device from a Mac:
1. Connect a USB storage device to the USB port on the modem router.

If your storage device uses a power supply, you must use it when you connect the device
to the modem router.

When you connect the storage device to the modem router’s port, it might take up to two
minutes before the storage device is ready for sharing. By default, the device is available
to all computers on your local area network (LAN).

On a Mac that is connected to the network, select Go > Connect to Server.
In the Server Address field, enter smb://readyshare.

When prompted, select the Guest radio button.

Click the Connect button.

o b~ DN

A window automatically opens and displays the files and folders on the device.

> To access the device from a Windows computer:
1. Connect a USB storage device to the USB port on the modem router.

If your storage device uses a power supply, you must use it when you connect the device
to the modem router.

When you connect the storage device to the modem router’s port, it might take up to two
minutes before the storage device is ready for sharing. By default, the device is available
to all computers on your local area network (LAN).

2. Launch a web browser from a computer that is connected to the network.
In the address field of the browser, enter \\readyshare.

Windows file manager automatically opens and displays the files and folders on the
device.
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Back Up Windows Computers with ReadySHARE Vault

The modem router comes with free backup software for all the Windows computers in your
home. Connect a USB hard disk drive (HDD) to the modem router for centralized,
continuous, and automatic backup.

The following operating systems support ReadySHARE Vault:

e Windows 7
*  Windows 8
«  Windows 8.1

> To back up your Windows computer:

Connect a USB HDD to one of the USB ports on the modem router.

Visit www.netgear.com/readyshare.

Scroll down to the A Happy Home Is Filled With Love And Safely Stored Data section.
Click the Download the installer and get started link.

Follow the onscreen instructions to download the utility file.

Launch the ReadySHAREVault-instal l .exe file and install the utility.

S

The Dashboard screen displays.

7. Use the dashboard or the Backup tab to set up and run your backup.

Back Up Mac Computers with Time Machine

You can use Time Machine to back up your Mac computers onto a USB hard drive that is
connected to the USB port on the modem router. You can access the connected storage
device from your Mac with a wired or wireless connection to your modem router.

Set Up a USB Hard Drive on a Mac

NETGEAR recommends that you use a new USB HDD or format your old USB disk to do the
Time Machine backup for the first time. Use a blank partition to prevent some issues during
backup using Time Machine. The modem router supports GUID or MBR patrtitions.

> To format your USB hard disk drive and specify partitions:

1. Physically connect the USB hard drive to your Mac.

2. On your Mac, go to Spotlight (or the magnifying glass) at the top right of the screen and
search for Disk Utility.

3. To format your USB device, open the Disk Utility, click the Erase tab, and click the Erase
button.

4. Click the Partition tab.
5. Click the Partition Layout menu and set the number of partitions that you want to use.
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Click the Options button.

The Partition options display.

Select the GUID Partition Table or Master Boot Record radio button.
For the format, select Mac OS Extended (Journaled).
Click the OK button.

10. Click the Apply button.

Your settings are saved.

Prepare to Back Up a Large Amount of Data

Before you back up a large amount of data with Time Machine, NETGEAR recommends that
you follow this procedure.

2.
3.
4

To prepare to back up alarge amount of data:
1.

Upgrade the operating system of the Mac computer.

Verify and repair the backup disk and the local disk.

Verify and repair the permissions on the local disk.

Set Energy Saver:

From the Apple menu, select System Preferences.
From the View menu, select Energy Saver.

Click the Power Adapter tab.

Select the Wake for Wi-Fi network access check box.
. Click the Back arrow to save the changes and exit the screen.
Madify your security settings:

a. From the Apple menu, select System Preferences.

® o0 o

b. From the View menu, select Security.
c. Click the Advanced button at the bottom of the screen.
d. Leave the Log out after minutes of inactivity check box cleared.

Use Time Machine to Back Up onto a Storage Device

You can use Time Machine to back up your Mac computers onto a USB hard disk drive that
is connected to the USB port on the modem router.

> To back up your Mac onto a USB hard drive:

1.

Prepare your USB device with a compatible format and partitions.
See Set Up a USB Hard Drive on a Mac on page 161.

If you plan to back up a large amount of data, see Prepare to Back Up a Large Amount of
Data on page 162.
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Insert your USB storage drive into the USB port on the modem router.

Note: If your USB device uses a power supply, you must use it when you
connect the USB device to the modem router.

When you connect the USB device to the USB port on the modem router, it might take up
to two minutes before the USB device is ready for sharing. By default, the USB device is
available to all computers on your local area network (LAN).

On your Mac computer, select Go > Connect to Server.

Type afp:/lrouterlogin.net.

When prompted to enter your name and password, select the Guest radio button.

Click the Connect button.

A list of connected devices displays. This list includes the name admin when you log in as
admin.

From the Apple menu, select System Preferences.

Open Time Machine.

Click the Select Backup Disk button and select your USB device from the list.

Click the Use for Backup button.

Note: If you do not see the USB partition that you want in the Time Machine
disk list, go to Mac finder and click that USB partition. It displays in the
Time Machine list.

When prompted to enter your name and password, select the Guest radio button and click
the Connect button.

When the setup is complete, the Mac automatically schedules a full backup. You can back up
immediately if you want.

Manage Access to a Storage Device

You can specify the device name, workgroups, and network folders for a storage device
connected to the USB port on the modem router.

> To specify the storage device access settings:

1.

2.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > USB Functions > ReadySHARE Storage.

[ e T

ADVANCED Home | "
Ready SHARE Media Server
Setup Wizard |
WPS Wizard ) SR Storage (A -ad Set :
» Setup " "
e [N C Rotresh |
ReadySHARE Storage
Network/Device N -
ReadySHARE Printer e Ve tame i o
Workgroup : Workgroup
ySecutlly Enable| Access Method Link Port
» Administration @] |Metwork Conneclion Wreadyshare
» Advanced Setup &l HTTP hitp-fireadyshare routerlogin.netishares| 80
] |HTTPS (via internet) 111921 / 443
] FTP direadyshare r rlogin.net/shar 21
| FTP (via internet) 192.168.100.150/sh. 21
Available Network Folders
Read Write = . Total Free
Share Name Neoass PR Folder Name | Volume Name space | Space
All All .
@ |Weadyshare\USB_Storage | no password|- no password Ui STORENGO | 3.7G |617.7M

m Create Network Folder m

The previous figure shows a USB device attached to the modem router.

6. Inthe Network/Device Name field, enter the name that is used to access the USB device or
devices that are connected to the modem router.

By default, the name is readyshare.

7. In the Workgroup field, enter the name of the workgroup that the USB device or devices
are members of.

By default, the name is WORKGROUP. The name works only in an operating system that
supports NetBIOS, such as Microsoft Windows. If you are using a Windows workgroup
rather than a domain, the workgroup name is displayed here.
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8. Enable or disable access methods by selecting or clearing the corresponding check boxes
and specifying access to the storage device as described in the following table.

Access Method

Description

Network Connection

Enabled by default. You can type \\readyshare to access the storage device within
your network. If you change the name in the Network Device Name field from
readyshare to another name, the link changes accordingly.

HTTP

Enabled by default. You can type http://readyshare.routerlogin.net/shares to
access the USB device within your network and download or upload files. In this
URL, readyshare is the name that is specified in the Network/Device Name field. If
you change the name in the Network Device Name field from readyshare to
another name, the link changes accordingly.

You can also click the link that is shown in the Link column. The fixed port is number
is 80.

HTTPS (via internet)

Disabled by default. If you enable this feature, remote users can type
https://<public IP address>/<shares> to access the USB device over the Internet.
<public IP address> is the external or public IP address that is assigned to the
modem router (for example, 1.1.10.102).

This feature supports file uploading only. The default port is number 443, which you
can change.

FTP

Enabled by default. You can type ftp://readyshare.routerlogin.net/shares to
access the USB device within your network and download or upload files. In this
URL, readyshare is the name that is specified in the Network/Device Name field. If
you change the name in the Network Device Name field from readyshare to
another name, the link changes accordingly.

You can also click the link that is shown in the Link column. The fixed port is number
is 21.

FTP (via internet)

Disabled by default. If you enable this feature, remote users can type
ftp://<public IP address>/shares to access the USB device over the Internet and
download or upload files. <public IP address> is the external or public IP address
that is assigned to the modem router (for example, 1.1.10.102).

The default port is number 21, which you can change.

If you set up Dynamic DNS (see Set Up and Manage Dynamic DNS on page 176),
you can also type a URL domain name. For example, if your domain name is
MyName and you use the NETGEAR DDNS server, you can type
ftp://MyName.mynetgear.com to access the USB device over the Internet and
download or upload files.

9. Click the Apply button.

Your settings are saved.
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Enable FTP Access Within Your Network

File Transfer Protocol (FTP) lets you download (receive) and upload (send) large files faster.

Note: For information about using FTP to access a storage device over the
Internet, see Chapter 8, Access Storage Devices Through the Internet.

» To enable FTP access within your network:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > USB Functions > ReadySHARE Storage.

[ [marrcoae TR

ADVANCED Home | i
Ready SHARE Media Server
Setup Wizard |

» Setup

wUSB Functions

Ready SHARE Storage
Network/Device Name : readyshare

ReadySHARE Printer

Workgroup : Workgroup
_' gecurty Enable| Access Method Link Port
» Administration V] |Metwork Connection \readyshare
» Advanced Setup ) HTTP hitp-iireadvshare reuteriogin.netishares 80
] |HTTPS (via internet) nli / 443
[l FTP i hare rlogin.n har 21
] | FTP(viainternet) 41192 168.100.150/sh 21
Available Network Folders
Share Name AEE:: L A\':Crgss Folder Name | Volume Name ST:;‘?:IS str:fe
: Al Al :
@ |Weadyshare\USB_Storage | no password|- no password ui STORENGO | 37G |617.7M

m Create Network Folder X Delete
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The previous figure shows a USB device attached to the modem router.

Select the FTP check box.
Click the Apply button.

Your settings are saved.

View Network Folders on a Device

You can view or change the network folders on a USB storage device connected to the
modem router.

» To view network folders:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > USB Functions > ReadySHARE Storage.

L e -
iowcevions ]
ReadySHARE Media Server

Setup Wizard |
WPS Wizard |
» Setup B )
o vespusce [ C Rofiesh ]
ReadySHARE Storage
Network/Device N L
ReadySHARE Printer o Vice Hams, readyshere
Workgroup : Workgroup
Esecutity Enable| Access Method Link Port
» Administration V] |Metwork Conneclion VYreadyshare
» Advanced Setup ¥ HTTP http-fireadyshare routerlogin.netishares 80
] [HTTPS (via internet) 01921 /: 443
] FTP readyshare r rlggin netishar 21
B FTP (via internet) 1192.168.100.150/sh 21
Available Network Folders
Read Write - Total Free
Share Name Nt T Folder Name | Volume Name space | Space
All All :
@ |\Wweadyshare\USB_Storage |_ no password|- no password Ui STOREN GO | 3.7G |617.7M

m Create Network Folder
Safely Remove USB Device
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The previous figure shows a USB device attached to the modem router.

The Available Networks Folder section shows the following settings:
e Share Name. The default share name is USB_Storage.

 Read Access and Write Access. The permissions and access controls on the
network folder. All-no password (the default) allows all users to access the network
folder. The password for admin is the same one that you use to log in to the modem
router.

* Folder Name. Full path of the network folder.
* Volume Name. Volume name from the storage device.
e Total Space and Free Space. The current utilization of the storage device.

Add a Network Folder on a Storage Device

>

You can add network folders on a storage device connected to the USB port on the modem
router.

To add a network folder:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > USB Functions > ReadySHARE Storage.
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L e

-
Ready SHARE Media Server

» Setup

C Refresh

»USB Functions

Ready SHARE Storage
Network/Device Name :

ReadySHARE Printer mabyeln
Workgroup : Workgroup
_’ gecurity Enable| Access Method Link Port
» Administration [¥] |Metwork Conneclion \readyshare
» Advanced Setup &l HTTP hitprireadyshare routerlogin.net’shares 80
O] [HTTPS (via internet) A J 443
] FTP i hare rogin.net’shar: 21
|l FTF (via internet) -1/192.168.100.150/sh 21
Available Network Folders
Read Write . Total Free
Share Hame N Ko Folder Name |Volume Hame space | Space
: Al All :
9 |Weadyshare\USB_Storage | no password|- no password ui STORENGO [ 37G |617.7TM

m Create Network Folder X Delete

The previous figure shows a USB device attached to the modem router.

In the Available Network Folders table, select a device.
Click the Create Network Folder button.

Create Network Felder

USB Device U (STORENGO) ~

Folder Browse

Share Name

Read Access All - no password ~

[Write Access All-no password -

If this screen does not display, your web browser might be blocking pop-ups. If it is,
change the browser settings to allow pop-ups.

From the USB Device menu, select the USB drive.

Note: NETGEAR recommends that you do not attach more than one drive to
each USB port (for example, through a USB hub).
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Click the Browse button and in the Folder field, select the folder.
In the Share Name field, type the name of the share.

From the Read Access menu and the Write Access menu, select the settings that you
want.

All-no password (the default) allows all users to access the network folder. The other
option is that only the admin user is allowed access to the network folder. The password
for admin is the same one that you use to log in to the modem router.

Click the Apply button.
The folder is added on the storage device.
Click the Close Window button.

The pop-up screen closes.

Change a Network Folder, Including Read and Write
Access, on a USB Drive

You can change network folders on storage devices connected to the USB port on the
modem router.

> To change a network folder:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > USB Functions > ReadySHARE Storage.

Share a Storage Device
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[ ADVANCED 1 Auto -

ADVANCED Home | )

Ready SHARE Media Server
Setup Wizard
WPS Wizard | ISB Storage (Advanced Setti

» Setup
»USB Functions
Ready SHARE Storage i N
two X
eadv SHARE Printer e vice Name readyshare
Workgroup : Workgroup
_’ S_ecnn_ty_ - — Enable| Access Method Link Port
» Administration ) [¥] |Metwork Conneclion \readyshare
» Advanced Setup | &l HTTP hitprireadyshare routerlogin.net’shares 80
] [HTTPS (via internet) hitps:#192,168 100,150/shares 443
] FTP i1 hare r rlopgin nelshar: 21
|l FTF (via internet) -11192.168.100,150/sh 21
Available Network Folders
Read Write . Total Free
Share Hame N Ko Folder Name |Volume Hame space | Space
- All All :
9 |Weadyshare\USB_Storage | no password|- no password us STORENGO [ 37G [617.7M

e X o

Safely Remove USE Device

The previous figure shows a USB device attached to the modem router.

In the Available Network Folders table, select a device.
Click the Edit button.

Edit Network Folder

USB Device U (STOREN GO }

File System FAT

Ut
Share Name USB_Storage

Read Access All-no password «

Write Access All- no password ~

Change the settings in the fields as needed.

For more information about the settings, see Add a Network Folder on a Storage Device
on page 168.

Click the Apply button.

Share a Storage Device
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Your settings are saved.

10. Click the Close Window button.

The pop-up screen closes.

Approve USB Devices

For more security, you can set up the modem router to share only USB devices that you
approve.

> To allow approved USB devices only to connect to the modem router and specify
which USB devices are approved:

1.

Make sure that the USB device or devices that you want to approve are attached to the
modem router.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > USB Settings.

B o -

ADVANCED Home
Setup Wizard |

» Setup

Enable any USB Device connected to the USB port @ Yes No
» USB Functions

» Security
» Administration
wAdvanced Setup

Wireless Settings
Wireless AP

Port Forwarding | Port
Triggering

Dynamic DNS

VPN Service

Static Routes
Remote Management
UPnP

1Pv6

Traffic Meter

Share a Storage Device
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7. Click the No radio button.

By default the Yes radio button is selected. This setting lets you connect and access all
your USB devices.

8. Click the Apply button.
Your settings are saved.

9. Click the Approved Devices button.

Allow only approved devices

Approved USB Devices
Violume Name Device Name Capacity

@ STORE M GO Verbatim STORE N GO 3.7GB
Available USB Devices
Volume Name Device Name Capacity
a STORE M GO Verbatim STORE N GO 37GB
STORE NGO Verbatim STORE N GO i7G6B
Add

10. In the Available USB Devices table, select the USB device that you want to approve.
11. Click the Add button.

The USB device is added to the Approved USB Devices table.

12. To approve a second USB device that is attached to the modem router, repeat Step 10
and Step 11.

13. Select the Allow only approved devices check box.
14. Click the Apply button.
Your settings are saved.

To approve another USB device that is not connected to one of the two USB ports, first
remove one of the USB devices (see Safely Remove a USB Device on page 173), connect
the other USB device, and repeat this procedure.

Safely Remove a USB Device

Before you physically disconnect a USB device from the USB port on the modem router, log
in to the modem router, and take the drive offline.

» Toremove a USB device safely:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.

Share a Storage Device
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A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > USB Functions > ReadySHARE Storage.

D oo
ADVANCED Home ) )
Ready SHARE Media Server
Setup Wizard |
WPS Wizard )
» Setup " "
e [N C Rotresh |
Ready SHARE Storage
Ready SHARE Printer Network/Device Name : readyshare
Workgroup : Workgroup
_’ Secutity Enable| Access Method Link Port
» Administration @] |Metwork Conneclion Wreadyshare
» Advanced Setup &l HTTP hitp-fireadyshare routerlogin.netishares| 80
] |HTTPS (via internet) f / 443
] FTP it hare r rlogin.net/shar 21
] | FTP(viainternet) 41192 168.100.150/sh 21
Available Network Folders
Read Write = ’ Total | Free
Share Name Neoass PR Folder Name | Volume Name space | Space
: Al Al :
@ |Weadyshare\USB_Storage | no password|- no password ui STOREN GO | 37G [617.7M
m Create Network Folder X Delete

The previous figure shows a USB device attached to the modem router.
6. In the Available Network Folders table, select a device.
7. Click the Safely Remove USB Device button.
The device goes offline and a pop-up screen displays.
8. Click the OK button.
9. Physically disconnect the USB device.

Share a Storage Device
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Access Storage Devices Through
the Internet

With Dynamic DNS, you can use the Internet and a personal domain name to access a USB
storage device that is attached to a USB port on the modem router when you are not home. If
you know the IP address of the modem router (and the IP address did not change), you can also
access the USB storage device by using the IP address.

This chapter includes the following sections:

e Set Up and Manage Dynamic DNS
* Access Storage Devices Through the Internet

Note: Forinformation about how to connect the device and specify its settings,
see Chapter 7, Share a Storage Device.
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Set Up and Manage Dynamic DNS

Internet service providers (ISPs) assign numbers called IP addresses to identify each
Internet account. Most ISPs use dynamically assigned IP addresses. This means that the IP
address can change at any time. You can use the IP address to access your network
remotely, but most people do not know what their IP address is or when this address
changes.

To make it easier to connect, you can get a free account with a Dynamic DNS service that
lets you use a domain name to access your home network. To use this account, you must set
up the modem router to use Dynamic DNS. Then the modem router notifies the Dynamic
DNS service provider whenever its IP address changes. When you access your Dynamic
DNS account, the service finds the current IP address of your home network and
automatically connects you.

If your ISP assigns a private WAN IP address (such as 192.168.x.x or 10.x.x.x), the Dynamic
DNS service does not work because private addresses are not routed on the Internet.

Your Personal FTP Server

With your customized free URL, you can use FTP to access your network when you are not
home through Dynamic DNS. To set up your FTP server, you must register for a NETGEAR
Dynamic DNS (DDNS) service account and specify the account settings (see Set Up a New
Dynamic DNS Account on page 177).
To set up your personal account and use FTP:
1. Get your NETGEAR Dynamic DNS domain name.

For more information, see Set Up a New Dynamic DNS Account on page 177.
2. Make sure that your Internet connection is working.

Your modem router must use a direct Internet connection. It cannot connect to a different
router to access the Internet.

3. Connect a USB storage device to one of the USB ports of the modem router.
4. Set up FTP access on the modem router.

For more information, see Set Up FTP Access Through the Internet on page 179.

5. On aremote computer with Internet access, you can use FTP to access your modem router
using ftp://yourname.mynetgear.com, in which yourname is your specific domain name.

For more information, see Access Storage Devices Through the Internet with FTP on
page 181.

Access Storage Devices Through the Internet
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Set Up a New Dynamic DNS Account

NETGEAR offers you the opportunity to set up and register for a free Dynamic DNS account.

To set up Dynamic DNS and register for a free NETGEAR account:

1.

© 00 N O

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

In the address field of your browser, enter http://routerlogin.net.

The login screen displays.

Type admin for the user name and type your password.

If you did not yet personalize your password, type password for the password.
Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Dynamic DNS.

[ ADVANCED ] Auto -

ADVANCED Home

Setup Wizard

» Setup powerea by

» USB Functions ._‘ﬁ

» Security

» Administration | Use a Dynamic DNS Service

v Advanced Setup Service Provider NETGEAR
Wireless Settings Do you have a HETGEAR DDNS or a No-IP DDNS account?
Wireless AP

Port Forwarding / Port
Triggering

Yes
2 No

VPN Service Please enter the following information for registration.

Static Routes HostName .mynetgear.com
Remote Management

UPnP

1Pv6 Password (§~32 characters)

Traffic Meter
USB Settings
Device Mode

Email

By submitting this form | agree to the
8 terms of senvice and that | will only
create one free account.

Select the Use a Dynamic DNS Service check box.

From the Service Provider menu, select NETGEAR.

Select the No radio button.

In the Host Name field, enter the name that you want to use for your URL.

The host name is sometimes called the domain name. Your free URL includes the host

name that you specify and ends with mynetgear.com. For example, specify
MyName.mynetgear.com.

10. In the Email field, enter the email address that you want to use for your account.

Access Storage Devices Through the Internet
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11. In the Password (6-32 characters) field, enter the password that you want to use for your
account.

12. Click the Register button.
13. Follow the onscreen instructions to register for your NETGEAR Dynamic DNS service.

Specify a DNS Account That You Already Created

If you already created a Dynamic DNS account with NETGEAR, No-IP, or Dyn, you can set
up the modem router to use your account.
To set up Dynamic DNS if you already created an account:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. In the address field of your browser, enter http://routerlogin.net.
The login screen displays.
3. Type admin for the user name and type your password.
If you did not yet personalize your password, type password for the password.
4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Settings > Dynamic DNS.

I o -
ADVANCED Home | Uynamic UNo
Setup Wizard |
» Setup poweres by
4
» USB Functions “‘6
» Security
» Al iralion | Use a Dynamic DNS Service
v Advanced Setup Service Provider NETGEAR
Wireless Settings Do you have a NETGEAR DDNS or a No-IP DDNS account?
Wireless AP Yes
Port Forwarding / Port &
- = 2) Mo
Trigoering
VPN Service Please enter the following information for registration.
Static Routes HostName .mynetgear.com
Remote Management ]
Email
UPnP
1Pv6 Password (6~32 characters)
Traffic Meter
" _ By submitting this form | agree to the
USB Settings terms of service and that | will only
Device Mode create one free account

6. Select the Use a Dynamic DNS Service check box.
7. From the Service Provider menu, select your provider.

Access Storage Devices Through the Internet
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8. Select the Yes radio button.
The screen adjusts.

9. In the Host Name field, enter the host name (sometimes called the domain name) for your
account.

10. Depending on the type of account, specify your user name or email address:

* For a No-IP or Dyn account, in the User Name field, enter the user name for your
account.

* For a NETGEAR account, in the Email field, enter the email address for your
account.

11. In the Password (6~32 characters) field, enter the password for your DDNS account.
12. Click the Apply button.

Your settings are saved.

13. To verify that your Dynamic DNS service is enabled in the modem router, click the Show
Status button.

A message displays the Dynamic DNS status.

Access Storage Devices Through the Internet

\7

If you connect a USB storage device to the modem router, you can access the USB device
through the Internet when you are not home. After you gain access, you can use FTP to
share files on the USB device.

To access devices from a remote computer:

1. Launch a web browser on a computer that is not on your home network.
2. Connect to your modem router on your home network:

* To connect with Dynamic DNS, type the DNS name.

To use a Dynamic DNS account, you must enter the account information in the
Dynamic DNS screen (see Set Up and Manage Dynamic DNS on page 176).

e To connect without Dynamic DNS, type the modem router’s Internet port IP address.

You can view the modem router’s Internet IP address on the BASIC Home screen.

Set Up FTP Access Through the Internet

If you attach a storage device to the modem router, you can access the storage device from
your network (see Enable FTP Access Within Your Network on page 166). You can also set
up FTP access through the Internet so that you can access the storage device from outside
your local network, for example, when you are not at home.

Access Storage Devices Through the Internet
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> To set up FTP access through the Internet:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

In the address field of your browser, enter http://routerlogin.net.

The login screen displays.

Type admin for the user name and type your password.

If you did not yet personalize your password, type password for the password.
Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > USB Functions > ReadySHARE Storage.

T

ADVANCED Home | "

’ Ready SHARE Media Server
Setup Wizard
WPS Wizard | SB Sto > ed ]

» Setup

»USB Functions

ReadySHARE Storage
By S S | T —

Ready SHARE Printer Feadyshale
Workgroup : Workgroup
ySecutlly Enable| Access Method Link Port
» Administration V] |Metwork Connection \readyshare
» Advanced Setup &l HTTP hitp-fireadyshare routerlogin.netishares| 80
] |HTTPS (via internet) 1192 1 I 443
] FTP direadyshare r rlogin.net/shar 21
) FTF (via internet) #192.168.100.150/sh 21
Available Network Folders
Read Write = . Total Free
Share Name Aeoass PR Folder Name | Volume Name space | Space
All All .
@ |Weadyshare\USB_Storage | no password|- no password ui STORENGO | 37G |617.7M

Safely Remove USB Device

The previous figure shows a USB device attached to the modem router.

Select the FTP (via internet) check box.
Click the Apply button.

Your settings are saved.

To limit access to the admin user, do the following:
a. In the Available Network Folders list, select a device.

If only one device is connected, it is automatically selected.

Access Storage Devices Through the Internet
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b. Click the Edit button.

Edit Network Folder

USB Device U (STOREN GO )

File System FAT

Folder Uy
Share Name USB_Storage

Read Access All-no password ~

Write Access All-no password ~

c. In the Read Access menu, select admin.
The default setting is All - no password.
d. In the Write Access menu, select admin.
The default setting is All - no password.
e. Click the Apply button.
Your settings are saved.
f. Click the Close Window button.

The pop-up screen closes.

Access Storage Devices Through the Internet with FTP

If you attached a storage device to the modem router, before you can access the storage
device through the Internet with FTP, you must first set it up (see Set Up FTP Access
Through the Internet on page 179).

To access a USB device with FTP from a remote computer to download or upload a
file:

1. Take one of the following actions:

e To download a file from a storage device connected to the modem router, launch a
web browser.

e To upload a file to a storage device connected to the modem router, launch an FTP
client such as Filezilla.

2. Type ftp:// and the Internet port IP address in the address field of the browser.
For example, if your IP address is 10.1.65.4, type ftp://10.1.65.4.
If you are using Dynamic DNS, type the DNS name.

Access Storage Devices Through the Internet
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For example, type ftp://MyName.mynetgear.com.

When prompted, log in:

e Tologin as admin, in the user name field, enter admin and in the password field,
enter the same password that you use to log in to the modem router.

e Tologin as guest, in the user name field, enter guest.
The guest user name does not need a password.

The files and folders that your account can access on the USB device display. For
example, you might see share/partitionl/directoryl.

Navigate to a location on the USB device.
Download or upload the file.

Access Storage Devices Through the Internet
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Use the Modem Router as a Media
Server

The modem router comes set up to work as a ReadyDLNA media server. You can set up the
modem router to play music from iTunes Server and media from TiVo.

This chapter contains the following sections:

e Specify ReadyDLNA Media Server Settings
* Play Media from a USB Device on TiVo
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Specify ReadyDLNA Media Server Settings

By default, the modem router functions as a ReadyDLNA media server, which lets you view
movies and photos on DLNA/UPNP AV-compliant media players, such as Xbox360,
Playstation, and NETGEAR media players.

> To specify media server settings:

1.

Launch an Internet browser from a computer or wireless device that is connected to the
network.

Type http://www.routerlogin.net or http://www.routerlogin.com.
A login screen displays.
Enter the router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
Select ADVANCED > USB Functions > ReadySHARE Storage.

The USB Storage (Advanced Settings) screen displays with the ReadySHARE tab
selected.

Click the Media Server tab.

L [merrae T

ADVANCED Home |
_' ReadySHARE Media Server
Setup Wizard )

» Setup

+ USB Functions

ReadySHARE Storage o
[FonNS R S ] Enable Media Server
ReadySHARE Printer S
¥ Enable TiVo® support.
Media Server Name: ReadyDLNA - DB400

» Security

» Administration

» Advanced Setup

Specify the settings:
« Enable Media Server. Select this check box to enable this device to function as a
media server.

Enable TiVo support. Select this check box if you want to play ReadyNAS media or
media from a USB device on your TiVo device.

For more information, see the Play Media from a USB Device on TiVo on page 185.

Media Server Device Name. Specify the name of the media server.
By default, the media server name is ReadyDLNA:6400.

Use the Modem Router as a Media Server
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7. Click the Apply button.

Your changes are saved.

Play Media from a USB Device on TiVo

\7

You can set up your TiVo to access media files stored on a USB device that is connected to
your modem router. The TiVo must be on the same network as the modem router. This feature
supports the following file formats:

* Video. See and play mpegl, and mpeg?2 files.
* Music. See and play MP3 files.
* Pictures. View images in jpg format.

You can use the TiVo (Series 2 and up) Home Media Option to play photos and music on
your Windows or Mac computer in your TiVo user interface.
To set up the modem router to work with TiVo:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > USB Storage > Media Server.
The Media Server Settings screen displays.

6. Make sure that the Enable TiVo support check box is selected.
7. If you changed the setting, click the Apply button.

Your settings are saved.

Use the Modem Router as a Media Server
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> To play videos:

1. On the TiVo, select TiVo Central > My Shows.

2. Go to the bottom of the list and select the D6400.
(In the following figure, the screen shows not D6400 but R8000.)

> To play music or view photos:

1. On the TiVo, select TiVo Central > Music, Photos, & Showcases.

2. Select an item to play or watch.
(In the following figure, the screen shows not D6400 but R8000.)

Use the Modem Router as a Media Server
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> To copy TiVo files to a computer:

Use the TiVo Desktop accessory, available at
https://lwwwa3.tivo.com/store/accessories-software.do.

Use the Modem Router as a Media Server
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Share a USB Printer

The ReadySHARE Printer utility lets you share a USB printer that is connected to the USB port
on your modem router. You can share this USB printer among the Windows and Mac computers
on your network.

The chapter includes the following sections:

Install the Printer Driver and Cable the Printer
Download the ReadySHARE Printer Utility

Install the ReadySHARE Printer Utility

Use the Shared Printer

View or Change the Status of a Printer

Use the Scan Feature of a Multifunction USB Printer
Change NETGEAR USB Control Center Settings
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Install the Printer Driver and Cable the Printer

Some USB printer manufacturers (for example, HP and Lexmark) request that you do not
connect the USB cable until the installation software prompts you to do so.

N

» To install the driver and cable the printer:
1.

On each computer on your network that shares the USB printer, install the driver
software for the USB printer.

If the printer driver is not installed, contact the printer manufacturer.

Use a USB printer cable to connect the USB printer to USB port on the modem router.

USB 2.0 port on the back panel

USB 2.0 port on the right side panel

Download the ReadySHARE Printer Utility

The utility works on Windows computers, Mac computers, smart phones, and tablets.

> To download the ReadySHARE Printer utility:

1.
2.

Visit netgear.com/readyshare.

Scroll down to the Print From the Comfort of Your Home Network section at the bottom of
the screen.

Click one of the following links:
 Download PC installer and get started. This is the utility for Windows computers.
 Download Mac installer and get started. This is the utility for MAC computers.

* Download the genie App and get started. This is the utility for smart phones and
tablets.

Follow the onscreen instructions to download the ReadySHARE Printer utility setup file.

Share a USB Printer
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Install the ReadySHARE Printer Utility

You must install the ReadySHARE Printer utility on each computer that will share the printer.
After you install it, the utility displays as NETGEAR USB Control Center on your computer.

» To install the utility:

1. If necessary, unzip the ReadySHARE Printer utility setup file.
2. Double-click the ReadySHARE Printer utility setup file that you downloaded.

NETGEAR USE Control Center

The Instalishield(R) Wizard will install NETGEAR USB Control
Center on your computer. To continue, click Next.

WARNING: This program is protected by copyright law and
international treaties.

3. Follow the wizard instructions to install NETGEAR USB Control Center.

After the InstallShield Wizard completes the installation, the NETGEAR USB Control
Center prompts you to select a language.

. NetGear USB Control Center - |0 X|
NETGEAR
UsB
Control
Engiet] -

OK

4. Select a language from the list and click the OK button.

Share a USB Printer
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1. NETGEAR USS Control Center - ] el -
System Tools About .
Dewace Sintus
P Conon- P10 WowgwComea |

Connecy

= = - )

Some firewall software, such as Comodo, blocks NETGEAR USB Control Center from
accessing the USB printer. If you do not see the USB printer displayed in the screen, you
can disable the firewall temporarily to allow the utility to work.

Select the printer and click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only the
computer that you are using can use this printer.

Click the Disconnect button.

The status changes to Available. Now all computers on the network can use the printer.

To exit the utility, select System > EXxit.

Use the Shared Printer

For each computer, after you click the Connect and Disconnect buttons once, the utility
automatically manages the printing queue. By default, the utility starts automatically
whenever you log on to Windows and runs in the background.

» To manually connect and print:

1.

Click the NETGEAR USB Control Center icon m

The main screen displays.
Click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only the
computer that you are using can use this printer.
Use the print feature in your application to print your document.

To release the printer so that all computers on the network can use it, click the Disconnect
button.

Share a USB Printer
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> To print and release the printer to any computer on the network:
1. To print your document, use the print feature in your application.

The NETGEAR USB Control Center automatically connects your computer to the USB
printer and prints the document. If another computer is already connected to the printer,
your print job goes into a queue to wait to be printed.

2. If your document does not print, use the NETGEAR USB Control Center to check the status.
See View or Change the Status of a Printer on page 192.

View or Change the Status of a Printer

> To view or change the status:

1. Click the NETGEAR USB Control Center icon m

i} NETGEAR USB Control Center

Systen  Tools About

Device Status
@ sudio - - Logitech Speaker Manually Connected by netgear-8dc0086
21:MFP - HP - Photosmart C5200 series Available

The Status column shows the status for each device:

e Available. No print jobs are in progress. You can use the USB printer from any
computer in the network.

e Connected. Your computer is connected to the printer and will be released when
your print job is done.

e Manually Connected by. Only the connected computer can use the printer.
e Waiting to Connect. Your computer is not connected to the shared printer yet.

2. To print from your computer when the status shows Manually connected by another
computer, click the Disconnect button.

The printer is released from the connection and the status changes to Available.

3. To print from your computer when the status shows Waiting to Connect, do the following:
a. Click the Connect button.

The printer status changes to Manually connected by Mycomputer. Now only your
computer can use the printer.

b. To allow the printer to be shared, click the Disconnect button.

The printer is released from the connection and the status changes to Available.

Share a USB Printer
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Use the Scan Feature of a Multifunction USB Printer

If your USB printer supports scanning, you can also use the USB printer for scanning. For
example, the USB printer displayed in the Windows Printers and Faxes window is ready for
print jobs.

% Printers and Faxes

File Edit Wiew Favorites Tools Help

& Bk (>} I‘ﬁ’ /‘T)Sear:h *l Folders v

2 Printers and Faxes

|' T S \,_\0 HP Photosmart CS200 series
rinter Tasks ;

1]
Paused
L-_;j Add a printer
&5 Set up Faxing

See Also

7] Troubleshaak printing
@) Get help with printing

Other Places

» To use the scan feature of a multifunction USB printer:

1. Click the NETGEAR USB Control Center icon .

{1t NETGEAR USB Control Center
Systern  Tools About

Device Status
@ sudio - - Logitech Speaker Manually Connected by netgear-8dc0086
{2iMFP - HP - Photosmart C5200 series Awailable

2. Make sure that the printer status shows as Available.
3. Click the Network Scanner button.

T

| System Tools .a.bou‘t

Diaca Status

EAMEP - Cancn - MP180 Avmidable

Connect | Nisconnect [ Network Scannes

The scanner screen displays so that you can use the USB printer for scanning.
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Change NETGEAR USB Control Center Settings

You can stop the NETGEAR USB Control Center from starting automatically when you log in
to Windows. You can also change the language and specify the time-out to release the
printer connection.

» To turn off automatic NETGEAR USB Control Center startup:

1.

Click the NETGEAR USB Control Center icon E

i} NETGEAR USB Control Center
Systen  Tools About

Device Status
@ sudio - - Logitech Speaker Manually Connected by netgear-8dc0086
2iiMFP - HP - Photosmart C5200 series Available

Select Tools > Configuration.

1 Control Center - Configuration @

Basic

Automatically execute when logging on Windows

Timeout

10 | minute (1-600)

Language
(Engish [
| German =3
| Swedish
| French
| Dutch
| Italian v

Note: Language setting will take effect on next execution,

I OK ] I Cancel I

Clear the Automatically execute when logging on Windows check box.
Click the OK button.

Your settings are saved.
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Change the NETGEAR USB Control Center Language

» To change the language:
1. Click the NETGEAR USB Control Center icon m
The main screen displays.
2. Select Tools > Configuration.
The Control Center - Configuration screen displays.

3. From the Language menu, select a language.
4. Click the OK button.

The next time NETGEAR USB Control Center starts, the language changes.

Specify the Time-out

» To specify the time-out:
1. Click the NETGEAR USB Control Center icon 5]
The main screen displays.
2. Select Tools > Configuration.
The Control Center - Configuration screen displays.

3. In the Timeout field, type the number of minutes.

The time-out is the number of minutes that a computer holds its connection to the printer
when the connection is not being used.

4. Click the OK button.

Your settings are saved.
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Manage the WAN and LAN
Network Settings

This chapter describes how you can manage the WAN and LAN network settings of the modem
router.

The chapter includes the following sections:

* Change the Physical WAN Connection Preference

* Enable the WAN2 Interface for IPTV

* Enable and Configure a VLAN

e Set Up a Bridge for a Port Group or VLAN Tag Group
 Manage the WAN Security Settings

e Set Up a Default DMZ Server

* Manage IGMP Proxying

* Manage NAT Filtering

¢ Manage the SIP Application-Level Gateway

¢« Manage the Modem Router’s LAN IP Address Settings
e Manage the Router Information Protocol Settings

* Manage Reserved LAN IP Addresses

» Change the Modem Router’s Device Name

e Manage the DHCP Server Address Pool

e Disable the Built-In DHCP Server

e Set Up and Manage Custom Static Routes

For information about the IPv4 Internet settings, IPV6 settings, and MTU size, see Chapter 3,
Manage the Internet Settings Manually.
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Change the Physical WAN Connection Preference

The modem router can autodetect the type of WAN connection. However, you can also set
the WAN connection preference manually to either the DSL port or the Ethernet WAN port.

Note: The modem router does not support load balancing over ADSL and
Ethernet WAN interfaces. Only one WAN interface (either the DSL
port or the Ethernet WAN port) can be active at any time.

> To change the WAN connection preference:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > WAN Setup.
The WAN Setup screen displays.

From the WAN Preference menu, select one of the following options:

* Auto-Detect. The modem router automatically detects whether the WAN connection
is DSL over the DSL port or Ethernet over the Internet port. Auto-Detect is the default
setting.

* Must use DSL WAN. The modem router uses the DSL port for a DSL WAN
connection. The Internet port is shut down.

* Must use Ethernet WAN. The modem router uses the Internet port for an Ethernet
WAN connection. The DSL port is shut down.

Click the Apply button.

Your settings are saved.

Enable the WAN2 Interface for IPTV

The modem router provides one physical DSL WAN interface and one physical Ethernet

WAN interface; either one or the other is enabled for Internet service. Whichever physical
WAN interface is enabled, it can be divided into two virtual interfaces, WAN1 and WAN?2.
This section refers to these virtual WAN interfaces. For information about changing the
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physical WAN interfaces, see Change the Physical WAN Connection Preference on
page 197.

The modem router uses virtual interface WANL for regular Internet service. The modem
router can use virtual interface WAN2 for Internet Protocol television (IPTV) service. By
default, interface WANL1 is enabled and interface WANZ2 is disabled. In most cases, if you are
not subscribed to IPTV service, you do not need to enable interface WAN2.

If your ISP provides IPTV service in addition to regular Internet service and you are
subscribed to IPTV, you might need to configure and enable interface WAN2. You might also
need to configure one or more VLANS and set up a bridge:

For information about configuring VLANS, see Enable and Configure a VLAN on
page 199.

For information about setting up a bridge, see Set Up a Bridge for a Port Group or VLAN
Tag Group on page 201

To enable virtual interface WAN 2:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.

Select Internet.

L -
Home >
Wireless > 2
Attached Devices » Select Country USA .
Select Internet Service Provider Other -
Parental Controls >
ReadySHARE » Transfer Mode ATM ~
DSL Mode Auto v
Guest Network >
WAN1T - |=
¥ Enable This Interface
Multiplexing Method VC-BASED ~
VPl 0
vCl 35
[Tuse vLaniD o
Priority (802.1p) 0
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The previous figure shows only the top of the Internet Setup screen.
6. From the menu below DSL mode, select WAN2.
7. Select the Enable This Interface check box.

By default, the Enable This Interface check box is selected for interface WAN1 but
cleared for interface WAN2.

8. Click the Apply button.

Your settings are saved.

Enable and Configure a VLAN

A network of computers and devices can behave as if they are connected to the same
network even though they might actually be physically on different segments of a LAN. Virtual
LANs (VLANS) are configured through software rather than hardware, which makes them
very flexible.

If you enable a VLAN and if the network devices (hubs and switches) on your LAN support
the VLAN (802.1Q) standard, the VLAN ID for the wireless access point is associated with all
traffic coming from the modem router.

If you are subscribed to IPTV service, the modem router might require VLAN tags to
distinguish between the Internet traffic and IPTV traffic.

Note: If your ISP provides directions on how to set up VLANSs for IPTV and
Internet service, follow those directions.

» To enable and configure a VLAN for interface WAN1 and another VLAN for interface
WANZ2:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select Internet.
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[ esc )N Ao -
Home >
Wireless > =
Attached Devices » Select Country USA -
Select Internet Service Provider Other -
Parental Controls >
ReadySHARE » Transfer Mode ATM -
DSL Mode Auto v
Guest Network >
WAN1 - £
/|Enable This Interface
Multiplexing Method VC-BASED ~
VPl 0
vCl 35
[Tuse vanD o
Priority (802.1p) 0

The previous figure shows only the top of the Internet Setup screen.

Configure a VLAN for interface WAN1:

a.

Make sure that WANL1 is selected from the menu and that the Enable This Interface
check box is selected for interface WANL1 (it is by default).

Select the Use VLANID check box.
Enter a VLAN ID that applies to interface WANL1.
The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is O.

To specify a priority for the VLAN, in the Priority (802.1p) field, enter a value from 0
to 7.

Click the Apply button.

Your settings are saved for interface WAN1.

Configure a VLAN for interface WANZ2:

a.
b.

From the menu below DSL mode, select WAN2.
Make sure that the Enable This Interface check box is selected for interface WAN2.

If you already enabled interface WAN2 (see Enable the WAN2 Interface for IPTV on
page 197), the check box is selected.

Select the Use VLANID check box.
Enter a VLAN ID that applies to interface WANZ2.
The VLAN ID can be in a range from 0 to 4094. The default VLAN ID is O.

To specify a priority for the VLAN, in the Priority (802.1p) field, enter a value from 0
to 7.

Click the Apply button.

Your settings are saved for interface WAN2.
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Set Up a Bridge for a Port Group or VLAN Tag Group

\7

Some devices, such as an IPTV, cannot function behind the modem router’'s network address
translation (NAT) service or firewall. Based on what your Internet service provider (ISP)
requires, for the device to connect to the ISP’s network directly, you can enable the bridge
between the device and the modem router’s Internet port or add new VLAN tag groups to the
bridge.

Note: If your ISP provides directions on how to set up a bridge for IPTV and
Internet service, follow those directions.

Set Up a Bridge for a Port Group

If the devices that are connected to the modem router's Ethernet LAN port or WiFi network
include an IPTV device, your ISP might require you to set up a bridge for a port group on
interface WANL1.

A bridge with a port group prevents packets that are sent between the IPTV device and the
modem router’s Internet port from being processed through the modem router's network
address translation (NAT) service.

To configure a port group and enable the bridge:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > VLAN/Bridge Settings.
The VLAN/Bridge Settings screen displays.

6. Select the Enable VLAN/Bridge Group check box.
The screen expands.

7. Select the By bridge group radio button.
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ADVANCED Home ) Vi ridge Settings
Setup Wizard | e
CHZT o EzE

v Setup /] Enable VLAN/Bridge Group

Internet Setup @ By bridge group
Wireless Setup
WAN Setup Wired Ports Wireless
LAN Setup
QoS Setup
Guest Network

VLAN/Bridge Settings

[Cprort1 [ClPortz CwiFi-2.46 [ wirFi-56
[Cportz [Port4 [ uest-2.4¢ [ Guest5c

' By VLAN tag group

» USB Functions

» Security

» Administration

» Advanced Setup

8. Select a Wired Ports check box or a Wireless check box:

* If your device is connected to an Ethernet port on the modem router, select the Wired
Ports check box that corresponds to the Ethernet port on the modem router to which
the device is connected.

If your device is connected to your modem router’s WiFi network, select the Wireless
check box that corresponds to the router’s WiFi network to which the device is
connected.

Note: You must select at least one Wired Ports or Wireless check box. You
can select more than one check box.

9. Click the Apply button.

Your settings are saved.

Set Up a Bridge for a VLAN Tag Group

If the devices that are connected to the modem router's Ethernet LAN port or WiFi network
include an IPTV device, your ISP might require you to set up a bridge for a VLAN tag group.

A bridge with a VLAN tag group prevents packets that are sent between the IPTV device and
the modem router’s Internet port from being processed through the modem router’s network
address translation (NAT) service.

You can add VLAN tag groups to a bridge and assign VLAN IDs and priority values to each
VLAN tag group.
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> To add a VLAN tag group and enable the bridge:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > VLAN/Bridge Settings.
The VLAN/Bridge Settings screen displays.

6. Select the Enable VLAN/Bridge Group check box.

R

X Cancel

Setup Wizard

¥ Setup | Enable VLAN/Bridge Group

Internet Setup ) By bridge group
Wireless Setup

WAN Setup

LAl Setup @ By VLAN tag group
QoS Setup

Guest Network
|Enable Name VLANID Priority Wired Ports Wireless

VLAN/Bridge Settings
5 | Internet 101 0 All Al
» USB Functions m m

» Security

* Administration

» Advanced Setup

By default, the By VLAN tag group radio button is selected.
7. Click the Add button.

Mame
VLANID (1~4094)
Priority 0 (0~T7)

IPort1 [portz Clpona [ pond [Dlwiri-2.4¢ ClwiFi-5¢ [ Guest-2.46 [T Guest-s6
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8. Specify the settings as described in the following table.

Field Description

Name Enter a name for the VLAN tag group.
The name can be up to 10 characters.

VLAN ID Enter a value from 1 to 4094.

Priority Enter a value from 0 to 7.

Select the check box for a wired LAN port or WiFi port.

If your device is connected to an Ethernet port on the modem router, select the LAN port check box that
corresponds to the Ethernet port on the modem router to which the device is connected.

If your device is connected to your modem router’s WiFi network, select the WiFi check box that
corresponds to the router’s WiFi network to which the device is connected.

Note: You must select at least one LAN port or WiFi port. You can select more than one port.

9. Click the Add button.
The VLAN tag group is added.
10. Click the Apply button.

Your settings are saved.

Manage the WAN Security Settings

The WAN security settings include port scan protection and denial of service (DoS)
protection, which can protect your LAN against attacks such as Syn flood, Smurf Attack, Ping
of Death, and many others. By default, DoS protection is disabled and a port scan is rejected.

You can also enable the modem router to respond to a ping to its WAN (Internet) port. This
feature allows your modem router to be discovered. Enable this feature only as a diagnostic
tool or if a specific reason exists.

» To change the default WAN security settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Setup > WAN Setup.
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The WAN Setup screen displays.

6. To enable port scan and DoS protection, clear the Disable Port Scan and DoS Protection
check box.

Note: Enabling port scan and DoS protection might affect the performance of
the modem router.

7. To enable modem router to respond to a ping, select the Respond to Ping on Internet
Port check box.

8. Click the Apply button.

Your settings are saved.

Set Up a Default DMZ Server

The default DMZ server feature is helpful when you are using some online games and
videoconferencing applications that are incompatible with Network Address Translation
(NAT). The modem router is programmed to recognize some of these applications and to
work correctly with them, but other applications might not function well. In some cases, one
local computer can run the application correctly if the IP address for that computer is entered
as the default DMZ server.

& WARNING:

DMZ servers pose a security risk. A computer designhated as the
default DMZ server loses much of the protection of the firewall and
is exposed to exploits from the Internet. If compromised, the DMZ
server computer can be used to attack other computers on your
network.

The modem router usually detects and discards incoming traffic from the Internet that is not a
response to one of your local computers or a service or application for which you set up a
port forwarding or port triggering rule. Instead of discarding this traffic, you can direct the
modem router to forward the traffic to one computer on your network. This computer is called
the default DMZ server.

> To set up a default DMZ server:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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The BASIC Home screen displays.

Select ADVANCED > Setup > WAN Setup.
The WAN Setup screen displays.

Select the Default DMZ Server check box.

Enter the IP address of the server.
Click the Apply button.

Your settings are saved.

Manage IGMP Proxying

IGMP proxying allows a computer on the local area network (LAN) to receive the multicast
traffic it is interested in from the Internet. If you do not need this feature, leave it disabled,
which is the default setting.

> To enable IGMP proxying:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > WAN Setup.
The WAN Setup screen displays.

Clear the Disable IGMP Proxying check box.

By default, the Disable IGMP Proxying check box is selected and IGMP proxying is
disabled.

Click the Apply button.

Your settings are saved.
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Manage NAT Filtering

Network Address Translation (NAT) determines how the modem router processes inbound
traffic. Secured NAT protects computers on the LAN from attacks from the Internet but might
prevent some Internet games, point-to-point applications, or multimedia applications from
working. Open NAT provides a much less secured firewall but allows almost all Internet
applications to work. Secured NAT is the default setting.

» To change the default NAT filtering settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > WAN Setup.
The WAN Setup screen displays.

6. Select a NAT Filtering radio button:

* Secured. Provides a secured firewall to protect the computers on the LAN from
attacks from the Internet but might prevent some Internet games, point-to-point
applications, or multimedia applications from functioning. By default, the Secured
radio button is selected.

e Open. Provides a much less secured firewall but allows almost all Internet
applications to function.

7. Click the Apply button.

Your settings are saved.

Manage the SIP Application-Level Gateway

The application-level gateway (ALG) for the Session Initiation Protocol (SIP) is enabled by

default for enhanced address and port translation. However, some types of VolP and video
traffic might not work well when the SIP ALG is enabled. For this reason, the modem router
provides the option to disable the SIP ALG.
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> To disable the default SIP ALG:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > WAN Setup.
The WAN Setup screen displays.

6. Select the Disable SIP ALG check box.
The SIP ALG is enabled by default.

7. Click the Apply button.

Your settings are saved.

Manage the Modem Router’s LAN IP Address Settings

The modem router is preconfigured to use private IP addresses on the LAN side and to act as
a DHCP server. The modem router’s default LAN IP configuration is as follows:

e LAN IP address. 192.168.0.1 (This is the same as www.routerlogin.net and
www.routerlogin.com.)

* Subnet mask. 255.255.255.0

These addresses are part of the designated private address range for use in private networks

and are suitable for most applications. The IP address and subnet mask identify which

addresses are local to a specific device and which must be reached through a gateway or

modem router. You might want to change these settings if you need a specific IP subnet that
one or more devices on the network use, or if competing subnets use the same IP scheme.

> To change the LAN IP address settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Setup > LAN Setup.

[T —

ADVANCED Home ) LAN setup
CHZTR
G
v Setup ) Device Name D6400
Internet Setup
Wireless Setup LAN TCPIP Setup
WAN Setup
I Agaress 2 . e .0 L
QoS Setup IP Subnet Mask 255 . 255 . 255 . O
Guest Netwo o
i ik RIP Direction Both -
VLAN/Bridge Settings . :
RIP Version Disabled ~
» USB Functions [¥] use Router as DHCP Server
» Security Starling IP Address 192 |. (168 |. 0 |2
& Riviaiiation Ending IP Address 192 |. |168 |. |0 . 254
» Advanced Setup Address Reservation
| | # | IP Address | Device Name | MAC Address

B A BN

6. In the IP Address field, enter the LAN IP address for the modem router.
7. Inthe IP Subnet Mask field, enter the LAN subnet mask for the modem router.
8. Click the Apply button.

Your settings are saved.

If you changed the LAN IP address of the modem router, you are disconnected when the
changes take effect.

To reconnect, close your browser, relaunch it, and log in to the modem router at its new
LAN IP address.

Manage the Router Information Protocol Settings

Router Information Protocol (RIP) lets the modem router exchange routing information with
other routers. By default, RIP is enabled in both directions (in and out) without a particular
RIP version.

» To manage the RIP settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
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A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Setup > LAN Setup.

B =

ADVANCED Home LAN Setup
Setup Wizard e
¥ Setup Device Name DE400
Internet Setup
Wireless Setup LAN TCPIP Setup
WAN Setup
I Adaress 2 .26 .0 Lt
QoS Setup IP Subnet Mask 255 . 255 . 255 . O
o
Guest Network RIP Direction Both -
VLAN/Bridge Settings . R
RIP Version Disabled ~
» USB Functions /| Use Router as DHCP Server
» Security Starling IP Address 192 |. (168 |. |0 “ |2
» Administration Ending IP Address 192 |. (168 |. |0 . 254
» Advanced Setup Address Reservation
| | # | IP Address | Device Name | MAC Address

A =l XN

In the RIP direction menu, select one of the following options:

e Both. The modem router broadcasts its routing table periodically and incorporates
information that it receives. This is the default setting.

e Out Only. The modem router broadcasts its routing table periodically but does not
incorporate the RIP information that it receives.

* In Only. The modem router incorporates the RIP information that it receives but does
not broadcast its routing table.

In the RIP Version menu, select one of the following options:
» Disabled. The RIP version is disabled. This is the default setting.

* RIP-1. This format is universally supported. It is adequate for most networks, unless
you are using an unusual network setup.

« RIP-2B or RIP-2M. This format carries more information. Both RIP-2B and RIP-2M
send the routing data in RIP-2 format. RIP-2B uses subnet broadcasting. RIP-2M
uses multicasting.

Click the Apply button.

Your settings are saved.
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Manage Reserved LAN IP Addresses

When you specify a reserved IP address for a computer on the LAN, that computer always
receives the same IP address each time it accesses the modem router's DHCP server.

Reserve a LAN IP address

You can assign a reserved IP address to a computer or server that requires permanent IP
settings.
» Toreserve an IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Setup > LAN Setup.

D o =
ADVANCED Home ) LAN Setup
* Setup ) Device Name D6400
Internet Setup
Wireless Setup LAN TCPIP Setup
WAN Setup
LAN Setup IP Address 192 . 168 . O - |2
QoS Setup IP Subnet Mask 255 . 255 . 255 . O
Guest Network e
m, K . RIP Direction Both -
VLAN/Bridge Settings
RIP Version Disabled =
£ ULSE Eunctions [¥] Use Router as DHCP Server
» Security Starting IP Address 192 |. |168 |. |0 . |2
r i 192 |. [168 |. |0 . 254
» Administration Ending e Address
» Advanced Setup | Address Reservation
| I # | IP Address | Device Name | MAC Address
X B

6. In the Address Reservation section, click the Add button.
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Address Reservation Table

# IP Address Device Name MAC Address

1 192.168.0.2 BusinessLaptop 60:6666:daB6Te

IP Address 192 |. (168 |. O
MAC Address

Device Name

Either select a device from the Address Reservation Table table by selecting the
corresponding radio button or specify the reserved IP address information:

e Inthe IP Address field, enter the IP address to assign to the computer or device.
Choose an IP address from the modem router’s LAN subnet, such as 192.168.0.x.

* Inthe MAC Address field, enter the MAC address of the computer or device.

¢ Inthe Device Name field, enter the name of the computer or device.

Click the Add button.

The reserved address is entered into the table on the LAN Setup screen.

The reserved address is not assigned until the next time the computer or device contacts the
modem router's DHCP server. Reboot the computer or device, or access its IP configuration
and force a DHCP release and renew.

Change a Reserved IP Address

You can change a reserved IP address entry.

To change areserved IP address entry:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup screen displays.

In the Address Reservation section, select the radio button next to the reserved address.
Click the Edit button.

The Edit screen displays.
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8. Change the settings.

9.

Click the Apply button.

Your settings are saved.

Remove a Reserved IP Address Entry

You can remove a reserved IP address entry.

> Toremove areserved IP address entry:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup screen displays.

In the Address Reservation section, select the radio button next to the reserved address.
Click the Delete button.

The address entry is removed.

Change the Modem Router’s Device Name

The modem router’s default device name is D6400. This device name displays in a file
manager when you browse your network.

> To change the modem router’s device hame:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
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The BASIC Home screen displays.
Select ADVANCED > Setup > LAN Setup.
The LAN Setup screen displays.

In the Device Name field, enter a new name.
Click the Apply button.

Your settings are saved.

Manage the DHCP Server Address Pool

By default, the modem router acts as a Dynamic Host Configuration Protocol (DHCP) server.
The modem router assigns IP, DNS server, and default gateway addresses to all computers
that are connected to its LAN and WiFi network. The assigned default gateway address is the
LAN address of the modem router.

These addresses must be part of the same IP address subnet as the modem router’s LAN IP
address. The default DHCP address pool is 192.168.0.2-192.168.0.254.

The modem router delivers the following parameters to any LAN device that requests DHCP:

An IP address from the range that you define

Subnet mask

Gateway IP address (the modem router’s LAN IP address)
DNS server IP address (the modem router’'s LAN IP address)

> To specify the pool of IP addresses that the modem router assigns:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Setup > LAN Setup.
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D o -
ADVANCED Home | o
Setup Wizard |
[ weswizard ]
v Setup Device Name D6400
Internet Setup
Wireless Setup LAN TCPIP Setup
WAN Setup
A . 0 1.
QoS Setup IP Subnet Mask 255 . 255 . 255 . O
Guest Netwo o
i ik RIP Direction Both -
VLAN/Bridge Settings
RIP Version Disabled ~
» USB Functions [¥] use Router as DHCP Server
» Security Starting IP Address 192 |. |168 |. |0 . |2
& Riviaiiation Ending IP Address 192 |. |168 |. |0 . 254
» Advanced Setup Address Reservation
| | # | IP Address | Device Name | MAC Address

B A BN

6. Make sure that the Use Router as DHCP Server check box is selected.
This check box is selected by default.

7. Specify the range of IP addresses that the modem router assigns:
* Inthe Starting IP Address field, enter the lowest number in the range.

This IP address must be in the same subnet as the modem router. By default, the
starting IP address is 192.168.0.2.

In the Ending IP Address field, enter the number at the end of the range of IP
addresses.

This IP address must be in the same subnet as the modem router. By default, the
ending IP address is 192.168.0.254.

8. Click the Apply button.

Your settings are saved.

Disable the Built-In DHCP Server

By default, the modem router functions as a DHCP server. The modem router assigns IP,
DNS server, and default gateway addresses to all devices connected to the LAN. The
assigned default gateway address is the LAN address of the modem router.

You can use another device on your network as the DHCP server or specify the network
settings of all your computers.
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Note: If you disable the DHCP server and no other DHCP server is available
on your network, you must set your computer IP addresses manually
so that they can access the modem router.

> To disable the built-in DHCP server:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Setup > LAN Setup.
The LAN Setup screen displays.

Clear the Use Router as DHCP Server check box.
Click the Apply button.

Your settings are saved.

Set Up and Manage Custom Static Routes

Static routes provide detailed routing information to your modem router. Typically, you do not
need to add static routes. You must configure static routes only for unusual cases such as
when you use multiple routers or multiple IP subnets on your network.

As an example of when a static route is needed, consider the following case:

Your primary Internet access is through an ADSL modem to an ISP.

You use an ISDN router on your home network for connecting to the company where you
are employed. This router’s address on your LAN is 192.168.0.100.

Your company'’s network address is 134.177.0.0.

When you first configured your modem router, two implicit static routes were created. A
default route was created with your ISP as the gateway and a second static route was
created to your local network for all 192.168.0.x addresses. With this configuration, if you
attempt to access a device on the 134.177.0.0 network, your modem router forwards your
request to the ISP. The ISP forwards your request to the company where you are employed,
and the request is likely to be denied by the company’s firewall.
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In this case, you must define a static route, instructing your modem router that 134.177.0.0 is
accessed through the ISDN modem router at 192.168.0.100. Here is an example:

Through the destination IP address and IP subnet mask, specify that this static route
applies to all 134.177.x.x addresses.

Through the gateway IP address, specify that all traffic for these addresses is forwarded
to the ISDN modem router at 192.168.0.100.

A metric value of 1 works fine because the ISDN modem router is on the LAN.

Set Up a Static Route

You can add a static route to a destination IP address and specify the subnet mask, gateway
IP address, and metric.

To set up a static route:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Static Routes.

L e -

i Active Hame Destination Gateway
m 1 Yes CentralOffice 203.0.113.43 203.0.113.1
2 safup 2 Yes CentralOfficeAlt 203.0.113.57 203.0.113.1
» USB Functions
» Sciiily (WA V-

» Administration
Advanced Setup

Wireless Settings

ir P
Port Forwarding / Port
Trigoering
Jynamic DNS
VPN Senvice
Remote Management
Pn
IPv6
Traffic Meter
USB Settings
Device Mode

-]
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The previous figure shows two routes in the table as an example.
6. Click the Add button.

Route Name
Private
41 Active
Destination IP Address
IP Subnet Mask
Gateway IP Address

Metric

7. To make the route private, select the Private check box.
A private static route is not reported in RIP.

8. To prevent the route from becoming active after you click the Apply button, clear the Active
check box.

In some situations, you might want to set up a static route but keep it disabled until a later
time. By default, the Active check box is selected and a route becomes active after you
click the Apply button.

9. Enter the settings as described in the following table.

Field Description

Destination IP | Enter the IP address for the final destination of the route.
Address

IP Subnet Mask | Enter the IP subnet mask for the final destination of the route.
If the destination is a single host, enter 255.255.255.255.

Gateway IP Enter the IP address of the gateway.
Address The IP address of the gateway must be on the same LAN segment as the modem router.
Metric Enter a number from 1 through 15.

This value represents the number of routers between your network and the destination.
Usually, a setting of 2 or 3 works, but if this is a direct connection, setitto 1.

10. Click the Apply button.

Your settings are saved. The static route is added to the table on the Static Routes
screen.
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Change a Static Route

You can change an existing static route.

To change a static route:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes screen displays.

In the Static Routes table, select the radio button to the left of the route that you want to
change.

Click the Edit button.

The screen adjusts.

Change the settings for the route.

For more information about the settings, see Set Up a Static Route on page 217.
Click the Apply button.

The route is updated in the table on the Static Routes screen.

Remove a Static Route

You can remove an existing static route that you no longer need.

To remove a static route:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
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The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Static Routes.
The Static Routes screen displays.

In the Static Routes table, select the radio button to the left of the route that you want to
remove.

Click the Delete button.

The route is removed from the table on the Static Routes screen.
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Manage the Modem Router and 1 2
Monitor the Traffic

This chapter describes how you can manage the settings for administering and maintaining your
modem router and monitor the network.

The chapter includes the following sections:

L]

Update the Firmware of the Modem Router

Manage the Configuration File of the Modem Router
Recover the admin Password

Return the Modem Router to Its Factory Default Settings
View the Status and Statistics of the Modem Router
Manage the Activity Log and Syslog

View Devices Currently on the Network

Monitor and Meter Internet Traffic

Manage the Modem Router Remotely

Configure the Modem Router as a DSL Modem Only

For information about changing the admin password, see Change the admin Password and
Automatic Login Time-Out Period on page 37.

For information about setting up password recovery, see Set Up Password Recovery on
page 38.
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Update the Firmware of the Modem Router

The modem router firmware is stored in flash memory.

You can check to see if new firmware is available and update the modem router to the new
firmware. You can also visit the NETGEAR support website, download the firmware manually,
and update the modem router to the new firmware.

Check for New Firmware and Update the Modem Router

For you to check for new firmware, the modem router must be connected to the Internet.

» To check for new firmware and update your modem router:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Administration > Router Update.
The Firmware Update screen displays.

6. Click the Check button.

The modem router detects new firmware if any is available and displays a message
asking if you want to download and install it.

7. To download and install the new firmware, click the Yes button.

The modem router locates the firmware, downloads it, and begins the update.

A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
upload. For example, do not close the browser, click alink, or load a
new page. Do not turn off the modem router. Wait until the modem
router finishes restarting and the Power LED turns solid green.

A progress bar shows the progress of the firmware upload process. The firmware upload
process takes several minutes. When the upload is complete, your modem router
restarts.
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8. Verify that the modem router runs the new firmware version:

a. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

b. Type http://www.routerlogin.net.
A login screen displays.
c. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

d. Click the OK button.
The BASIC Home screen displays.
The firmware version is stated in the top right, under the Logout button.

9. To determine whether you must reconfigure the modem router after updating (which is
unlikely but possible), visit downloadcenter.netgear.com, go to the support page for your
product, and locate and read the new firmware release notes.

Manually Upload New Firmware and Update the Modem Router

Downloading firmware and updating the modem router are two separate tasks that are
combined in the following procedure.
To download new firmware manually and update your modem router:

1. Visit downloadcenter.netgear.com, locate the support page for your product, and
download the new firmware.

2. Read the new firmware release notes to determine whether you must reconfigure the
modem router after updating (which is unlikely but possible).

3. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

4. Type http://www.routerlogin.net.
A login screen displays.
5. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

6. Click the OK button.
The BASIC Home screen displays.
7. Select ADVANCED > Administration > Router Update.

The Firmware Update screen displays.
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8. Locate and select the firmware file on your computer:

a.
b.

C.

Click the Browse button.
Navigate to the firmware file.

The file ends in .chk. An example of a firmware file name is
D6400-V1.0.0.22_1.0.22._chk.

Select the firmware file.

9. Click the Upload button.

A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
upload. For example, do not close the browser, click alink, or load a
new page. Do not turn off the modem router. Wait until the modem
router finishes restarting and the Power LED turns solid green.

A progress bar shows the progress of the firmware upload process. The firmware upload
process takes several minutes. When the upload is complete, your modem router
restarts.

10. Verify that the modem router runs the new firmware version:

a.

b.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.

The version firmware is stated in the top right, under the Logout button.
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Manage the Configuration File of the Modem Router

The configuration settings of the modem router are stored within the modem router in a
configuration file. You can back up (save) this file to your computer or restore it.

Back Up the Settings

You can save a copy of the current configuration settings.

» To back up the modem router’s configuration settings:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Administration > Backup Settings.
The Backup Settings screen displays.

Click the Back Up button.
Choose a location to store the file on your computer.

The name of the backup file is NETGEAR_D6400 . cfg.

Follow the directions of your browser to save the file.

Restore the Settings

If you backed up the configuration file, you can restore the configuration from this file.

> To restore configuration settings that you backed up:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
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The BASIC Home screen displays.

Select ADVANCED > Administration > Backup Settings.

The Backup Settings screen displays.

Click the Browse button and navigate to and select the saved configuration file.

The name of the backup file from which you can restore the configuration is
NETGEAR_D6400.cfg.

Follow the directions of your browser to locate and select the file.
Click the Restore button.

The configuration is uploaded to the modem router. When the restoration is complete, the
modem router reboots. This process takes about one minute.

A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
restoration. For example, do not close the browser, click a link, or
load a new page. Do not turn off the modem router. Wait until the
modem router finishes restarting and the Power LED turns solid
green.

Recover the admin Password

NETGEAR recommends that you enable password recovery if you change the password for
the modem router user name admin. Then you can recover the password if it is forgotten.
This recovery process is supported in Internet Explorer, Firefox, and Chrome browsers, but
not in the Safari browser.

For information about setting up password recovery, see Set Up Password Recovery on
page 38. The following procedure works only if you did set up password recovery.

To recover your password:
1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

In the address field of your browser, type www.routerlogin.net.
A login screen displays.
Click the Cancel button.

If password recovery is enabled, you are prompted to enter the serial number of the
modem router. The serial number is on the product label of the modem router.

Enter the serial number of the modem router.
Click the Continue button.
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A screen displays requesting the answers to your security questions.

6. Enter the saved answers to your security questions.
7. Click the Continue button.

A screen displays your recovered password.
8. Click the Login again button.
A login screen displays.

9. With your recovered password, log in to the modem router.

Return the Modem Router to Its Factory Default Settings

Under some circumstances (for example, if you lost track of the changes that you made to
the modem router settings or you move the modem router to a different network), you might
want to erase the configuration and reset it to factory default settings.

If you do not know the current IP address of the modem router, first try to use an IP scanner
application to detect the IP address before you reset the modem router to factory default
settings.

To reset the modem router to factory default settings, you can use either the Reset button on
the back of the modem router or the Erase function. However, if you cannot find the IP
address or lost the password to access the modem router, you must use the Reset button.

After you reset the modem router to factory default settings, the user name is admin, the
password is password, the LAN IP address is 192.168.0.1 (which is the same as
www.routerlogin.net and www.routerlogin.com), and the DHCP server is enabled. For a list of
factory default settings, see Factory Settings on page 289.

Use the Reset Button
CAUTION:

This process erases all settings that you configured in the modem router.

> To reset the modem router to factory default settings:

1. On the back of the modem router, locate the Reset button.
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2. Using a straightened paper clip, press and hold the Reset button for eight seconds.
Release the Reset button.

The configuration is reset to factory default settings. When the reset is complete, the
modem router reboots. This process takes about one minute.

A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
reset. For example, if you are connected to the web management
interface, do not close the browser, click alink, or load a new page.
Do not turn off the modem router. Wait until the modem router
finishes restarting and the Power LED turns solid green.

Erase the Settings

CAUTION:

This process erases all settings that you configured in the modem router.

To erase the settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Administration > Backup Settings.
The Backup Settings screen displays.

Click the Erase button.
7. To confirm the action, click the Yes button.

The configuration is reset to factory default settings. When the reset is complete, the
modem router reboots. This process takes about one minute.
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A WARNING:

To avoid the risk of corrupting the firmware, do not interrupt the
reset. For example, do not close the browser, click a link, or load a
new page. Do not turn off the modem router. Wait until the modem
router finishes restarting and the Power LED turns solid green.

View the Status and Statistics of the Modem Router

You can view information about the modem router, its broadband modem, and ports, and the
status of the Internet connection and WiFi network. In addition, you can view traffic statistics
for the various ports.

View Information About the Modem Router and the Internet,
Modem, and WiFi Settings

You can view modem router information, the Internet port status, and WiFi settings.
> To view information about the modem router and the Internet, modem, and WiFi
settings:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
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| ADVANCED Home

WPS Wizard

* Setup

» USB Functions
» Security

» Administration

» Advanced Setup

ADVANCED 1

~ Router Information  Internet Port

Hardware Version DE400
Firmware Version V1.0.022_1.022
GUI Language Version V1.0.0.22_31.25

MAC Address 80:37:73:C6:BB:E7
IP Address 192.168.0.1
DHCP On

~ Wireless Settings (2.4GHz) ~ Wireless Settings (5GHz)

Name (SSID) MNETGEAR47
Region Europe
Channel Auto (1)

Mode Up to 145 Mbps
Wireless AP on

Broadcast Name On

Wi-Fi Protected Setup Configured

A Guest Network (2.4 GHz)

HName (SSID) NETGEAR-Guest
Wireless AP On
Broadcast Name On

Allow guests to see
each other and access Off
my local network

MAC Address 80:37:73.C6:BB.ES

IP Address 192.168.100.150
Connection PPPoA
IP Subnet Mask 255.255.255.0

Domain Name Server 192.168.100.1

Connection Status

Name (SSID) NETGEARAT-5G
Region Europe

Channel 36 + 40 + 44(P) + 48
Mode Up to 1300 Mbps
Wireless AP On

Broadcast Name On

‘Wi-Fi Protected Setup Configured

#® Guest Network (5 GHz)

Name (S5ID) MNETGEAR-5G-Guest
Wireless AP Off
Broadcast Name On

Allow guests to see
each other and access Off
my local network

Auto s

The information onscreen uses the following color coding:

 Agreenflag indicates that the Internet port is configured correctly and connected
to the Internet or that a WiFi network is up and enabled.

Aredxn

Internet connection or that a WiFi network is down or disabled.

An amber exclamation mark n

indicates that the Internet port is not configured and cannot get an

indicates that the Internet port is configured but

cannot get an Internet connection (for example, because the cable is disconnected),
that a WiFi network is enabled but unprotected, or that another situation that requires
your attention occurred.

The following table describes the fields of the six panes on the ADVANCED Home

screen.

Field

Description

Router Information

Hardware Version

The modem router model.

Firmware Version

The version of the modem router firmware. If you upgrade the firmware on the

modem router, the version changes.
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Field

Description

GUI Language Version

The version of the modem router firmware. If you upgrade the firmware on
modem router, the version changes.

LAN Port

The settings of the LAN port. For information about how to configure the LAN settings, see Manage the
Modem Router’s LAN IP Address Settings on page 208 and Disable the Built-In DHCP Server on page 215.

MAC Address The Media Access Control (MAC) address. This address is the unique physical
address that is assigned to the Ethernet LAN port.

IP Address The IP address that the Ethernet LAN port uses. The default IP address is
192.168.0.1.

DHCP Displays whether the DHCP server of the modem router is enabled for devices

that are attached to the LAN.

Internet Port

The settings of Internet port. The Internet connection can run through the DSL port with ADSL or VDSL
service or through the WAN Ethernet port with cable or fiber service. For information about how to configure
the Internet settings, see one of the following sections:

e Set Up Your Modem Router for DSL Service on page 21

e Set Up Your Modem Router for Cable or Fiber Service on page 29
e Manually Set Up an ADSL Internet Connection on page 47

e Manually Set Up a VDSL Internet Connection on page 56

e Manually Set Up a Cable of Fiber Internet Connection on page 64

MAC Address The Media Access Control (MAC) address. This address is the unique physical
address that is assigned to the Internet port.

IP Address The IP address that the Internet port uses. If this field does not display an
address or displays 0.0.0.0 as the address, the modem router is not connected
to the Internet.

Connection The type of Internet connection, which can be a PPPoE connection, PPPoA

connection, fixed IP address connection, or DHCP connection.

IP Subnet Mask

The IP subnet mask that the Internet port uses.

Domain Name Server

The IP address of the Domain Name System (DNS) server that the Internet
uses.

Wireless Settings (2.4GHz)

The settings of the WiFi port for the 2.4 GHz band of the main network. For information about how to
configure the settings of the main network, see Manage the Basic WiFi Settings and WiFi Security of the
Main Network on page 91, Control the WiFi Radios on page 108, and Manage Advanced WiFi Features on

page 114.

Name (SSID) The WiFi network name for the 2.4 GHz band of the main network.

Region The location (country).

Channel The channel that the 2.4 GHz band of the main network uses.

Mode The WiFi mode in which the 2.4 GHz band operates for both the main network

and the guest network.
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Field Description

Wireless AP Displays whether the 2.4 GHz band of the main network is enabled.

If the 2.4 GHz band is disabled but the 5 GHz band is enabled, the WiFi LED on
the front of the modem router lights blue. If both radios are off, the WiFi LED is

off.
Broadcast Name Displays whether the 2.4 GHz band of the main network broadcasts its SSID.
Wi-Fi Protected Setup Displays whether the modem router keeps its existing WiFi settings when you

use WPS to connect a device to the 2.4 GHz band of the main network:

e Configured. The modem router keeps its existing WiFi settings. This is the
default setting.

« Not configured. The modem router generates a random SSID and
passphrase and changes the security mode to WPA/WPA2-PSK mixed
mode.

For more information, see Manage the WPS Settings on page 112.

Wireless Settings (5GHz)

The settings of the WiFi port for the 5 GHz band of the main network. For information about how to
configure the settings of the main network, see Manage the Basic WiFi Settings and WiFi Security of the
Main Network on page 91, Control the WiFi Radios on page 108, and Manage Advanced WiFi Features on
page 114.

Name (SSID) The WiFi network name for the 5 GHz band of the main network.

Region The location (country).

Channel The channel that the 5 GHz band of the main network uses.

Mode The WiFi mode in which the 5 GHz band operates for both the main network

and the guest network.

Wireless AP Displays whether the 5 GHz band of the main network is enabled.

If the 5 GHz band is disabled but the 2.4 GHz band is enabled, the WiFi LED on
the front of the modem router lights blue. If both radios are off, the WiFi LED is

off.
Broadcast Name Displays whether the 5 GHz band of the main network broadcasts its SSID.
Wi-Fi Protected Setup Displays whether the modem router keeps its existing WiFi settings when you

use WPS to connect a device to the 5 GHz band of the main network:

e Configured. The modem router keeps its existing WiFi settings. This is the
default setting.

« Not configured. The modem router generates a random SSID and
passphrase and changes the security mode to WPA/WPA2-PSK mixed
mode.

For more information, see Manage the WPS Settings on page 112.

Guest Network (2.4 GHz)

The settings of the WiFi port for the 2.4 GHz band of the guest network. For information about how to
configure the settings of the guest network, see Manage the Basic WiFi Settings and WiFi Security of the
Guest Network on page 103.

Name (SSID) The WiFi network name for the 2.4 GHz band of the guest network.
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Field

Description

Wireless AP

Displays whether the 2.4 GHz band of the guest network is enabled.

The WiFi LED on the front of the modem router is not affected by the status of
the guest network.

Broadcast Name

Displays whether the 2.4 GHz band of the guest network broadcasts its SSID.

Allow guests to see each
other and access my local
network

Displays whether users of the 2.4 GHz band of the guest network are allowed to
access the main network.

Guest Network (5 GHz)

The settings of the WiFi port for the 5 GHz band of the guest network. For information about how to
configure the settings of the guest network, see Manage the Basic WiFi Settings and WiFi Security of the
Guest Network on page 103.

Name (SSID)

The WiFi network name for the 5 GHz band of the guest network.

Wireless AP

Displays whether the 5 GHz band of the guest network is enabled.

The WiFi LED on the front of the modem router is not affected by the status of
the guest network.

Broadcast Name

Displays whether the 5 GHz band of the guest network broadcasts its SSID.

Allow guests to see each
other and access my local
network

Displays whether users of the 5 GHz band of the guest network are allowed to
access the main network.

View the Traffic Statistics

You can view the traffic statistics for the ports of the modem router, change the polling
frequency, and stop traffic polling.

To view the traffic statistics for the ports of the modem router:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the

network.

Type http://www.routerlogin.net.

A login screen displays.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.
Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.

In the Internet Port pane, click the Show Statistics button.
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Show Statistics

y Up Time 03:56:49
Port Status TxPkts RxPkts Collisions Tx Bis Rx Bis Up Time
VAN 100MFull 24694 71764 0 300 1858 03:55:54
LAN1 Link Down —
LANZ Link Down =
TANG ik Down 50948 75541 0 3140 630 -
LAN4 Link Down =
2.4G WLAN bigin 1450 77079 72343 0 3389 659 03:56:48
5G WLAN ainlac 1300M 0 0 0 0 0 03:56:48
ADSL Link Downstream Upstream
Connection Speed
Line Attenuation
Noise Margin
Poll Interval: 5 (5~86400 Seconds)

The following table describes the fields and columns of the Show Statistics pop-up

screen.

Field or Column

Description

System Up Time

The time elapsed since the modem router was last restarted.

this table.

Port The statistics for the WAN (Internet over Ethernet) port, LAN (Ethernet) ports,
WLAN b/g/n ports, and WLAN a/n/ac ports. For each port, the screen displays
the information that is described in this table.

Status The link status of the port.
TxPkts The number of packets transmitted on this port since reset or manual clear.
RxPkts The number of packets received on this port since reset or manual clear.
Collisions The number of signal collisions that occurred on the port. A collision occurs when
the port attempts to send data at the same time as the device that is connected to
the port.
Tx Bls The number of bytes transmitted per second on the port.
Rx B/s The number of bytes received per second on the port.
Up Time The time elapsed since this port acquired the link.
Poll Interval The interval at which the statistics are updated in this screen.
ADSL Link

In addition to the xDSL firmware version, the screen displays the ADSL link information that is described in

Connection Speed

The downstream and upstream data rates in Kbps.

Line Attenuation

The downstream and upstream line attenuation (LATN) in dB. The LATN
expresses the signal quality.

Noise Margin

The downstream and upstream signal-to-noise-margin (SNRM) in dB. The
SNRM expresses the signal quality in relation to interference.
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» To change the traffic statistics polling frequency or stop polling:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.
6. In the Internet Port pane, click the Show Statistics button.
A pop-up screen displays.
7. Change the polling frequency or stop polling:
» To change the polling frequency:

a. In the Poll Interval field, enter a time in seconds.
b. Click the Set Interval button.

» To stop polling, click the Stop button.

View, Renew, or Release a TCP/IP Internet Connection

You can view information about a TCP/IP Internet connection of the modem router and renew
or release such a connection. This information displays only if the modem router connects to the
ISP network over a TCP/IP connection (see Specify a Cable or Fiber Connection Without a
Login Requirement on page 65).

» To view the TCP/IP Internet connection status or renew or release the TCP/IP Internet
connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/iwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
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The BASIC Home screen displays.
Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.

In the Internet Port pane, click the Connection Status button.
The fields that display depend on the type of Internet connection.
The following screen shows the fields for an established TCP/IP connection with DHCP.

Connection Status

IP Address 192.168.100.150

Subnet Mask 255.255.255.0

Default Gateway 192.168.100.1

DHCP Server 192.168.100.1

DNS Server 192.168.100.1

Lease Obtained 0 days,0 Hours,10 Minutes
Lease Expires 0 days,0 Hours,7 Minutes

The following table describes the fields of the Connection Status pop-up screen.

Field Description

IP Address The IP address that is assigned by the ISP to the modem router.
Subnet Mask The subnet mask that is assigned by the ISP to the modem router.
Default Gateway The IP address of the default gateway of the ISP that the modem router

communicates with.

DHCP Server The IP address of the DHCP server of the ISP that issues the IP address to the
modem router.

DNS Server The IP address of the Domain Name System (DNS) server of the ISP that provides
translation of network names to IP addresses.

Lease Obtained The time at which the modem router obtained the DHCP lease. (The type of DHCP
connection determines whether this field displays onscreen.)

Lease Expires The time at which the DHCP lease expires. (The type of DHCP connection
determines whether this field displays onscreen.)

To renew the Internet connection when the connection is active, click the Renew button.
To terminate the Internet connection when the connection is active, click the Release button.
Click the Close Window button.

The pop-up screen closes.
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View, Connect, or Disconnect a PPPoE or PPPoOA Internet
Connection

You can view information about a PPPoE or PPPOA Internet connection of the modem router
and establish or terminate such a connection. This information displays only if the modem router
connects to the ISP network over a PPPoE connection or PPPoA connection. The following
sections describe Internet connections that use PPPoe and PPPoA:

e Specify an ADSL Connection with a Login Requirement and PPPoA or PPPoE Service
on page 51
e Specify a VDSL Connection with a Login Requirement and PPPoE Service on page 60

e Specify a Cable or Fiber Connection With a Login Requirement and PPPoE Service on
page 69

To view the PPPOE or PPPOA Internet connection status or connect or disconnect the
PPPoOE or PPPOA Internet connection:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.
6. In the Internet Port pane, click the Connection Status button.

The Connection Status pop-up screen displays. The fields that display depend on the
type of connection (PPPoE or PPPOoA).

The following table describes the fields of the Connection Status pop-up screen.

Field Description

Connection Time The time elapsed since the connection was established.

Connection Status The status can be Connected or Disconnected.

Negotiation The negotiation can be a series of dashes, which indicates that the connection is not
established, or successful (Success).

Authentication The authentication can be a series of dashes, which indicates that the connection is
not established, or successful (Success).
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Field Description
IP Address The IP address that is assigned by the ISP to the modem router.
Subnet Mask The subnet mask that is assigned by the ISP to the modem router.

7. To establish the Internet connection when the connection is down, click the Connect button.

To terminate the Internet connection when the connection is active, click the Disconnect
button.

9. Click the Close Window button.

The pop-up screen closes.

Manage the Activity Log and Syslog

The log is a detailed record of the websites that users on your network accessed or
attempted to access and many other modem router actions. Up to 256 entries are stored in
the log. You can also manage which activities are logged.

View and Manage the Log

> To view and manage the log:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

The BASIC Home screen displays.
4. Select ADVANCED > Administration > Logs.
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L EEe
ADVANCED Home ]
WPS Wizard |
» Setup Current Time: Saturday, Mar 21,2015 20:04:16
h : [LAN access from remote] from 94.245.121.253:3544 to -
* USB Functions 192.168.0.2:56287, Saturday, Mar 21,2015 20:04:15
. . . [UPnP ser event: Public UPNP C3]) from source 192.168.0.2,
* Security Saturday, Mar 21,2015 20:04:15
g e . : [LEN access from remote] from 94.245.121.253:3544 to
v Administration 192.168.0.2:56287, Saturday, Mar 21,2015 20:03:36
[UPnP set event: Public UPNP C3] from source 192.168.0.2,
Router Status = =

Saturday, Mar 21,2015 20:03:36

Logs [LAN access from remote] from 94.245.121.253:3544 to
Attach vi 192.168.0.2:56287, Saturday, Mar 21,2015 20:03:04
. [UPnP sect event: Public UPNP C3] from source 192.168.0.2,
Backup Settings i — -
Saturday, Mar 21,2015 20:03:04
Set Password [LAN access from remote] from 94.245.121.253:3544 to
Router Update 192.168.0.2:56287, Saturday, Mar 21,2015 20:02:24
[UPnP set event: Public UPNP C3] from source 192.168.0.2, -
» Advanced Setup Saturday, Mar 21,2015 20:02:24

Include in Log

[¥] attempted access to allowed sites

= Attempted access to blocked sites and senvices

[¥I connections to the Web-based interface of this Router
[¥IRouter operation (startup, get time etc)

[¥] Known DoS attacks and Port Scans

[¥] Port Forwarding / Port Triggering

[wireless access

[¥] Automatic Internet connection reset

[¥1Turmn off wireless signal by schedule

The Logs screen shows the following information:

Action. The action that occurred, such as whether Internet access was blocked or
allowed.

Source. The name, IP address, or MAC address of the target device, application, or
website for this log entry.

Target. The name, IP address, or MAC address of the target device, application, or
website for this log entry.

» Date and time. The date and time at which the action occurred.
To refresh the log screen, click the Refresh button.

To clear the log entries, click the Clear Log button.

To email the log immediately, click the Send Log button.

The modem router emails the logs to the address that you specified (see Set Up Security
Event Email Notifications on page 139).
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Specify Which Activities Are Logged

You can specify which activities are logged. These activities display in the log and are
forwarded to the syslog server if you enabled the syslog server function.

Y

To manage which activities are logged:
1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Administration > Logs.
The Logs screen displays.

Scroll down and select the check boxes that correspond to the activities that you want to be
logged.

By default, all check boxes are selected.

Clear the check boxes that correspond to the activities that do not want to be logged.
Click the Apply button.

Your settings are saved.

View Devices Currently on the Network

You can view the active wired devices, 2.4 GHz WiFi devices, and 5 GHz WiFi devices in the
network. If you do not recognize a device, it might be an intruder. If it is an intruder, make sure
that your WiFi security is set up correctly (see Manage the Basic WiFi Settings and WiFi
Security of the Main Network on page 91) or set up access control to secure your network
(see Allow or Block Access to Your Network on page 122).

> To display the wired and WiFi devices:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.

Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select Attached Devices.
The Attached Devices screen displays.

Wired devices are connected to the modem router with Ethernet cables. WiFi devices are
connected to the modem router through the WiFi network, either in the 2.4 GHz band or
the 5 GHz band.

The following table describes the fields on the Attached Devices screen.

Field Description

Status The access control status (Allowed or Blocked).

Device Name The device name, if detected.

IP Address The IP address that the modem router assigned to the device when it joined the network.
This address can change when a device is disconnected and rejoins the network.

MAC Address The unique MAC address of the device. The MAC address does not change and is
usually shown on the product label.

Connection Type | The type of connection for the device (Wired or Wireless).

6. To refresh the information onscreen, click the Refresh button.

The information onscreen is updated.

Monitor and Meter Internet Traffic

Traffic metering allows you to monitor the volume of Internet traffic that passes through the
modem router Internet port. With the traffic meter utility, you can set limits for traffic volume,
set a monthly limit, and get a live update of traffic usage.

Start the Traffic Meter Without Traffic Volume Restrictions

You can monitor the traffic volume without setting a limit.

> To start or restart the traffic meter without configuring traffic volume restrictions:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.

3. Enter the user name and password for the modem router.
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The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Traffic Meter.

P e
ADVANCED Home |
i |
WPS Wizard |
» Setup Internet Traffic Meter
] le Traffic M
» USB Functions E.nab & Traffic Meter —
@ Traffic volume control by Mo limit
» Security Monthly limit 0 (Mbytes)
» Administration Round up datavolume for each connection by 0 (Mbytes)
v Advanced Setup Connection time control
: Monthly limit 0 (hours)
Wireless Settings
Wireless AP Traffic Counter
Port Forwarding | Port
Trianerin Restart traffic counter at| 0000 | am Onthe 1st day of each month
Dynamic DNS | Restart Counter Now =
VPN Service
Static Routes Traffic Control
Remote Management Pop up a waming message
UPnP 0 IbytesMinutes before the monthly limitis reached
1Pvé When the monthly limitis reached
Trafic Weter Turn the Internet LED to flashing green/amber
USE Settings Disconnect and disable the Internet connection
Device Mode
Traffic

Select the Enable Traffic Meter check box.
The buttons, fields, and check boxes on the screen become available.
By default, no traffic limit is specified and the traffic volume is not controlled.

In the Traffic Counter section, set the traffic counter to begin at a specific time and date.
If you want the traffic counter to start immediately, click the Restart Counter Now button.
Click the Apply button.

Your settings are saved and the WiFi connection restarts. Any WiFi devices that were
connected to the network must reconnect.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more
information, see View the Traffic Statistics and Traffic Status on page 243.
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View the Traffic Statistics and Traffic Status

If you enabled the traffic meter (see Start the Traffic Meter Without Traffic Volume
Restrictions on page 241), you can view the traffic statistics and traffic status.

To view the traffic statistics and status of the traffic meter:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter screen displays.

Scroll down to the Internet Traffic Statistics section.

Internet Traffic Statistics

Start Date/Time: Sunday, 01 Mar 2015 00:00
Current Date/Time: Saturday, 21 Mar 2015 20:51
Traffic Volume Left No limit

Period

Connection Time

{hh:mm)

Upload/Avg

Traffic Volume (Mbytes)

Download/Avg

TotallAvg

Today

377

1284

16.61

Yesterday

0.00

0.00

0.00

This week

377
0.54

12.84/
183

16617
237

This month

3771
0.13

12.84/
0.43

16.61/
055

Last month

0.00/
0.00

0.00/

0.00

.00/
0.00

The Internet Traffic Statistics section displays when the traffic counter was started and what
the traffic balance is. The table displays information about the connection time and traffic
volume in MB.

To refresh the information onscreen, click the Refresh button.
The information onscreen is updated.

To display more information about the data traffic and to change the polling interval, click the
Traffic Status button.

The Traffic Status pop-up screen displays.
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Restrict Internet Traffic by Volume

You can record and restrict the traffic by volume in MB. This is useful when your ISP
measures your traffic in volume.

» To record and restrict the Internet traffic by volume:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the

network.

Type http://www.routerlogin.net.

A login screen displays.

Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Traffic Meter.

[ —

ADVANCED Home |
Setup Wizard |
WPS Wizard ]

» Setup

» USB Functions
» Security

» Administration
v Advanced Setup

Wireless Settings
Wireless AP

Port Forwarding | Port
Triggering

Dynamic DNS

VPN Service

Static Routes
Remote Management
uenP

1Pv6

USB Settings

Device Mode

ADVANCED ] Auto
| M
Internet Traffic Meter
1 Enable Traffic Meter
@ Trafficvolume control by | Mo limit
Monthly limit 0 (Mbytes)
Round up datavolume for each connection by 0 (Mbytes)
Connection time control
Menthly limit 0 (hours)
Traffic Counter
Restart traffic counter at 00200 | am Onthe 1st day of each month

Traffic Control
Pop up a wamning message

0 MbytesMinutes before the
When the monthly limitis reached

menthly limit is reached

Turn the Internet LED to flashing green/amber
Disconnect and disable the Internet connection

Internet Traffic Statistics

m

Select the Enable Traffic Meter check box.
Select the Traffic volume control by radio button.

The buttons, fields, and check boxes on the screen become available.

By default, no traffic limit is specified and the traffic volume is not controlled.
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From the corresponding menu, select an option:

* Download only. The restriction is applied to incoming traffic only.

e Both directions. The restriction is applied to both incoming and outgoing traffic.
In the Monthly limit field, enter how many MBytes (MB) per month are allowed.

If your ISP charges you for extra data volume when you make a new connection, enter the
extra data volume in MB in the Round up data volume for each connection by field.

In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

In the Traffic Control section, enter a value in minutes to specify when the modem router
issues a warning message before the monthly limit in hours is reached.

This setting is optional. The modem router issues a warning when the balance falls under
the minutes that you enter. By default, the value is 0 and no warning message is issued.
Select one or more of the following actions to occur when the limit is reached:

e Turn the Internet LED to flashing green/amber. This setting is optional. When the
traffic limit is reached, the Internet LED blinks alternating green and amber.

» Disconnect and disable the Internet connection. This setting is optional. When the
traffic limit is reached, the Internet connection is disconnected and disabled.

Click the Apply button.

Your settings are saved and the WiFi connection restarts. Any WiFi devices that were
connected to the network must reconnect.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more
information, see View the Traffic Statistics and Traffic Status on page 243.

Restrict Internet Traffic by Connection Time

You can record and restrict the traffic by connection time. This is useful when your ISP
measures your connection time.

To record and restrict the Internet traffic by time:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Traffic Meter.
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s e T—

ADVANCED Home |
Setup Wizard | by >
WPS Wizard |
.- -
» Setup Internet Traffic Meter
] Enable Traffic Meter
» USB Functions E. ale Traffic Hete
9 Traffic volume control by Mo limit
» Security Monthly limit 0 (Mbytes)
» Administration Round up data volume for each connection by 0 (Mbytes)
v Advanced Setup Connection time control
z Maonthly limit 0 (hours)
Wireless Settings
\é'\i_l_rgl:_eg.s.&_l’.d_ - Traffic Counter
ort Forwarding / Port

Tra0aria Restart traffic counter at|00:00 | am Onthe | Ist day of each month

Dynamic DNS =

VPN Service

Static Routes Traffic Control

Remote Management Pop up a warning message

UBnP 0 MbytesMinutes before the monthly limitis reached

L When the monthly limit is reached

Traffic Weter Tum the Internet LED to flashing green/amber

USE Setfings Disconnect and disable the Internet connection

Device Mode

Traffic

6. Select the Enable Traffic Meter check box.

The buttons, fields, and check boxes on the screen become available.

By default, no traffic limit is specified and the traffic volume is not controlled.
7. Select the Connection time control radio button.

Note: The modem router must be connected to the Internet for you to be able
to select the Connection time control radio button.

8. In the Monthly limit field, enter how many hours per month are allowed.

Note: The modem router must be connected to the Internet for you to be able
to enter information in the Monthly limit field.

9. In the Traffic Counter section, set the traffic counter to begin at a specific time and date.

10. In the Traffic Control section, enter a value in minutes to specify when the modem router
issues a warning message before the monthly limit in hours is reached.

This setting is optional. The modem router issues a warning when the balance falls under
the minutes that you enter. By default, the value is 0 and no warning message is issued.
11. Select one or more of the following actions to occur when the limit is reached:

e Turn the Internet LED to flashing green/amber. This setting is optional. When the
traffic limit is reached, the Internet LED alternates blinking green and amber.

L]

Disconnect and disable the Internet connection. This setting is optional. When the
traffic limit is reached, the Internet connection is disconnected and disabled.
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12. Click the Apply button.
Your settings are saved.

The Internet Traffic Statistics section helps you to monitor the data traffic. For more
information, see View the Traffic Statistics and Traffic Status on page 243.

Unblock the Traffic Meter After the Traffic Limit Is Reached

If you configured the traffic meter to disconnect and disable the Internet connection after the
traffic limit is reached, you cannot access the Internet until you unblock the traffic meter.

CAUTION:

If your ISP set a traffic limit, your ISP might charge you for the overage
traffic.

» To unblock the traffic meter:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Traffic Meter.
The Traffic Meter screen displays.

6. In the Traffic Control section, clear the Disconnect and disable the Internet connection
check box.

7. Click the Apply button.

Your settings are saved.

Manage the Modem Router Remotely

The remote management feature lets you access your modem router securely over the
Internet to view or change its settings. You must know the modem router's WAN IP address
to use this feature. For information about remote access using Dynamic DNS, see Chapter 8,
Access Storage Devices Through the Internet.
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Note: Be sure to change the password for the user name admin to a secure
password. The ideal password contains no dictionary words from any
language and contains uppercase and lowercase letters, numbers,
and symboils. It can be up to 30 characters. See Change the admin
Password and Automatic Login Time-Out Period on page 37.

» To set up remote management:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Remote Management.

S

ADVANCED Home

PSewp 0 ) @E | Turn Remote Management On

» USB Functions Remote Management Address:

» Security hitps:/192.168.100.150:8443

» Administration Allow Remote Access By:

v Advanced Setup _ Only This Computer:

Wireless Settings
Wireless AP
PortF ing / B To
Trigoering

Dynamic DNS @ Everyone

VPN Service

Static Routes Port Number: RS
UPnP

1Pv6

Traffic Meter

USB Settings

Device Mode

_' IP Address Range From

6. Select the Turn Remote Management On check box.
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7. In the Allow Remote Access By section, specify the external IP addresses to be allowed to
access the modem router’s remote management.

Note: For enhanced security, restrict access to as few external IP addresses
as practical.

Select one of the following radio buttons and configure the options accordingly:

* To allow access from a single IP address on the Internet, select the Only This
Computer radio button. Enter the IP address to be allowed access.

e To allow access from a range of IP addresses on the Internet, select the IP Address
Range radio button. Enter a beginning and ending IP address to define the allowed
range.

e To allow access from any IP address on the Internet, select the Everyone radio
button. This radio button is selected by default.

8. Specify the port number for accessing the web management interface.

The default port number is 8443, which is a common alternate for HTTPS. For greater
security, enter a custom port number for the remote web management interface. Choose
a number from 1024 to 65535, but do not use the number of any common service port.

9. Click the Apply button.

Your settings are saved.

» To use remote access:

1. Launch an Internet browser on a computer that is not on your home network.

Enter your modem router's WAN IP address into your browser’s address or location field
followed by a colon (:) and the custom port number.

For example, if your external address is 100.168.110.147 and you use port number 8443,
enter https://100.168.110.147:8443 in your browser.

Configure the Modem Router as a DSL Modem Only

By default, the modem router functions both as a modem and a router. You can change the
operation mode to a mode in which the modem router functions as a DSL modem only with
the routing, firewall, wireless support, and traffic meter features disabled.

A typical use of such a mode is when the modem router is used for DSL connectivity only
behind a router, firewall, or security device manager that provides routing, firewall, wireless
support, and traffic meter features.

» To configure the modem router as a DSL modem only:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
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A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Device Mode.

The Device Mode screen displays.

From the Device Mode menu, select Modem (Modem Only).
The default selection is Router (Modem + Router).

Click the Apply button.

Your settings are saved. The modem router restarts in modem-only mode.
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Use VPN to Access Your Network 1

You can use OpenVPN software to remotely access your modem router using virtual private
networking (VPN). This chapter explains how to set up and use VPN access.

This chapter includes the following sections:

e Set Up a VPN Connection
« Use VPN to Access the Modem Router’'s USB Device and Media
« Use VPN to Access Your Internet Service at Home
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Set Up a VPN Connection

A virtual private network (VPN) lets you use the Internet to securely access your network
when you are not home. This type of VPN access is called a client-to-gateway tunnel. The
computer is the client, and the modem router is the gateway. To use the VPN feature, you
must log in to the modem router and enable VPN, and you must install and run VPN client
software on the computer.

Note: The modem router does not support iOS or Android VPN client software.

VPN uses DDNS or a static IP address to connect with your modem router.

To use a DDNS service, register for an account with a host name (sometimes called a
domain name). You use the host name to access your network. The modem router supports
these accounts: NETGEAR, No-IP, and Dyn. See Set Up and Manage Dynamic DNS on
page 176.

If your Internet service provider (ISP) assigned a static WAN IP address (such as 50.196.x.x
or 10.x.x.x) that never changes to your Internet account, the VPN can use that IP address to
connect to your home network.

Specify VPN Service in the Modem Router

You must specify the VPN service settings in the modem router before you can use a VPN
connection.
> To specify the VPN service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > VPN Service.
The VPN Service screen displays.

6. Select the Enable VPN Service check box.

Use VPN to Access Your Network
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By default, the VPN uses the UDP service type and uses port 12974. If you want to
customize the service type and port, NETGEAR recommends that you change these
settings before you install the OpenVPN software.

To change the service type, scroll down and select the TCP radio button.

To change the port, scroll down to the Service Port field, and type the port number that you
want to use.

Note: For information about configuring the type of access, see Use VPN to
Access Your Internet Service at Home on page 257.

Click the Apply button.

Your changes are saved. VPN is enabled in the modem router, but you must install and
set up OpenVPN software on your computer before you can use a VPN connection (see
Install OpenVPN Software on Your Computer on page 253).

Install OpenVPN Software on Your Computer

You must install this software on each computer that you plan to use for VPN connections to
your modem router.

To install VPN client software:

1.
2.

A w

5.
6.

Visit openvpn.net/index.php/download/community-downloads.html.

In the Windows Installer section of the screen, double-click the
openVPN-instal l-xxx_exe link.

Download the file.

To install the Open VPN software on your computer, click the
openVPN-instal l-xxx.exe file.

| | OpenVPN 2.3.2-1003 Setup [o] ® ==

Welcome to the OpenVPN
2.3.2-1003 Setup Wizard

This wizard will guide you through the installation of
OpenVPN , an Open Source VPN package by James Yonan.

Mote that the Windows version of OpenVPN will only run on
Windows XP, or higher.

e asin)

Click the Next button.
Read the License Agreement and click the | Agree button.
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| OpenVPN 2.3.2-1003 Setup =l @
Choose Components
Choose which features of OpenVPN 2.3.2-1003 you want to
install.

Select the components to installjupgrade. Stop any OpenVPN processes or the OpenVPN
service if it is running. All DLLs are installed locally.

i UL I OV Liser-Space Components, -]
[¥] OpenVPH Service
[¥] TAP Virtual Ethernet Adapter
[¥] OpenvPN GUT
[¥] OpenvPN File Associations
[] Opensst Utiities I

Desaipton =
Space required: 3.9MB

[ <Back || mext> | [ cancel

7. Leave the check boxes selected as shown in the previous figure, and click the Next button.

8. To specify the destination folder, click the Browse button, select a destination folder, and
click the Next button.

"] Windows Security ==
Would you like to install this device software?
~  Mame: TAP-Windows Provider V8 Network adapters

k' publicher OpenVPN Technologies, Inc.

| Always trust software from "OpenVPN [ lﬂstail ]|| Don't Install |
Technologies, Inc.".

# You should enly install driver softs fror publishers you trust. How can [ decide which
device software is safe to install?

9. Click the Install button.

The screen displays the progress of the installation and then displays the final installation

screen.
[} OpenVPN 2.3.2-1003 Setup =0l 3

Completing the OpenVPN 2.3.2-1003
Setup Wizard

OpenVPN 2.3.2-1003 has been installed on your computer,
Click Finish to dose this wizard.

7|Show Readme!

10. Click the Finish button.
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11. Unzip the configuration files that you downloaded and copy them to the folder where the
VPN client is installed on your device.

For a client device with Windows 64-bit system, the VPN client is installed at
C:\Program files\OpenVPN\config\ by default.

12. For a client device with Windows, modify the VPN interface name to NETGEAR-VPN:

a. In Windows, select Start > Control Panel > Network and Internet > Network
Connections.

b. In the local area connection list, find the local area connection with the device name
TAP-Windows Adapter.

c. Select the local area connection and change its name (not its device name) to
NETGEAR-VPN.

If you do not change the VPN interface name, the VPN tunnel connection will fail.

Use a VPN Tunnel

After you set up the modem router to use VPN and install the OpenVPN application on your
computer, you can open a VPN tunnel from your computer to your modem router over the
Internet.

For the VPN tunnel to work, the local LAN IP address of the remote router must use a
different LAN IP scheme from that of the local LAN where your VPN client computer is
connected. If both networks use the same LAN IP scheme, when the VPN tunnel is
established, you cannot access your home router or your home network with the OpenVPN
software.

The default LAN IP address scheme for the modem router is 192.x.x.X. The most common IP
schemes are 192.x.x.x, 172.x.x.x, and 10.x.x.x. If you experience a conflict, change the IP
scheme either for your home network or for the network with the client VPN computer. For
information about changing these settings, see Manage the Modem Router’s LAN IP
Address Settings on page 208.

» To open a VPN tunnel:

1. Launch the OpenVPN application with administrator privileges.

OpenVPN 2.3.2-1003 Setup E=2ic

Welcome to the OpenVPN
2.3.2-1003 Setup Wizard

This wizard will guide you through the installation of
OpenVPN , an Open Source VPN package by James Yonan.

Mote that the Windows version of OpenVPN will only run on
Windows XP, or higher,

Next > ] _ Cancel |
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The OpenVPN icon displays in the Windows taskbar.

Tip: You can create a shortcut to the VPN program, then use the shortcut
to access the settings and select the run as administrator check
box. Then every time you use this shortcut, OpenVPN automatically
runs with administrator privileges.

2. Right-click the OpenVPN icon.

Connect

onnect

View Log
Edit Config

Change Password

Settings...
Eat

3. Select Connect.
The VPN connection is established. You can do the following:

e Launch a web browser and log in to your modem router.

* Use Windows file manager to access the modem router's USB device and download
files.

Use VPN to Access the Modem Router’s USB Device and
Media

» To access a USB device and download files:

1. In Windows file manager, select the Network folder.

Organize = Metwork and Sharing Center Add a printes Add a wireless device
Favorites 4 Computer (2)
I Desktop
s Downloads * NETGEARI 1‘* READVSHARE
2 Recent Places
& Vault Timeline 4 Media Devices (3)
al » H) ' m']
477 Libraries .L lifestyle_NAS: ReadyNAS 104 MNETGEARIL: Melgearuser: ReadyDLNA: D6400
. < k b EV
Documents
4. Music 4 Network Infrastructure (2)
=, Pictures
B videos _"a? WHNDR4500 {Gateway) ,‘_""/ D5400 (Gateway)
4 Computer
& Windows7_05 (C)
> Removable Disk (D)
@ Lenovo_Recovery (Q2)
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The network resources display. The ReadySHARE icon is in the Computer section and
the remote ReadyDLNA: D6400 icon is in the Media Devices section (if DLNA is enabled
in the modem router).

2. If the icons do not display, click the Refresh button to update the screen.

If the local LAN and the remote LAN are using the same IP scheme, the remote
ReadyDLNA: D6400 icon does not display in the Media Devices section and the
D6400 (Gateway) icon does not display in the Network Infrastructure section.

3. To access the USB device, click the ReadySHARE icon.
4. To access media on the modem router’'s network, click the ReadyDLNA: D6400 icon.

Use VPN to Access Your Internet Service at Home

When you are away from home and you access the Internet, you usually use a local Internet
service provider. For example, at a coffee shop you might be given a code that lets you use
the coffee shop’s Internet service account to surf the web.

The modem router lets you use a VPN connection to access your own Internet service when
you are away from home. You might want to do this if you travel to a geographic location that
does not support all the Internet services that you use at home. For example, your Netflix
account might work at home but not in a different country.

Set Up VPN Client Internet Access in the Modem Router

By default, the modem router is set up to allow VPN connections only to your home network
but you can change the setting to allow Internet access. Accessing the Internet remotely
through a VPN might be slower than accessing the Internet directly.

> To allow VPN clients to use your home Internet service:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://Iwww.routerlogin.net.
A login screen displays.
3. Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > VPN Service.
The VPN screen displays.

6. Select the Enable VPN Service radio button.

Use VPN to Access Your Network
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Scroll down to the Clients will use this VPN connection to access section, and select the All
sites on the Internet & Home Network radio button.

When you access the Internet with the VPN connection, instead of using a local Internet
service, you use the Internet service from your home network.

Note: By default, the Auto radio button is selected. The Auto option uses an
automatic detection system that enables VPN access only for necessary
services and sites and might not include full Internet access.

Click the Apply button.

Your settings are saved.

Click the For Windows or For Non Windows button and download the configuration files
for your VPN clients.

Unzip the configuration files and copy them to the folder where the VPN client is installed on
your device.

For a client device with Windows 64-bit system, the VPN client is installed at
C:\Program files\OpenVPN\config\ by default.

Block VPN Client Internet Access in the Modem Router

By default, the modem router is set up to allow VPN connections only to your home network,
not to the Internet service for your home network. If you changed this setting to allow Internet
access, you can change it back.

To allow VPN clients to access only your home network:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the modem router user name and password.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > VPN Service.
The VNP screen displays.

Select the Enable VPN Service radio button.

Scroll down to the Clients will use this VPN connection to access section, and select the
Home Network only radio button.

Click the Apply button.

Use VPN to Access Your Network
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Your settings are saved.

Click For Windows or For Non Windows button and download the configuration files for
your VPN clients.

10. Unzip the configuration files and copy them to the folder where the VPN client is installed on

your device.

For a client device with Windows 64-bit system, the VPN client is installed at
C:\Program files\OpenVPN\config\ by default.

Use a VPN Tunnel to Access Your Internet Service at Home

> To access your Internet service:

1.

Set up the modem router to allow VPN access to your Internet service.
See Set Up VPN Client Internet Access in the Modem Router on page 257.
On your computer, launch the OpenVPN application.

The OpenVPN icon displays in the Windows taskbar.

Right-click the icon and select Connect.
When the VPN connection is established, launch your Internet browser.

Use VPN to Access Your Network
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Manage Port Forwarding and Port 1 4
Triggering

You can use outbound firewall rules, port forwarding, and port triggering to set up rules for
Internet traffic for services and applications. You need networking knowledge to set up these
features.

This chapter includes the following sections:

* Manage Port Forwarding to a Local Server for Services and Applications
« Manage Port Triggering for Services and Applications
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Manage Port Forwarding to a Local Server for Services
and Applications

If a server is part of your network, you can allow certain types of incoming traffic to reach the
server. For example, you might want to make a local web server, FTP server, or game server
visible and available to the Internet.

The modem router can forward incoming traffic with specific protocols to computers on your
local network. You can specify the servers for applications and you can also specify a default
DMZ server to which the modem router forwards all other incoming protocols (see Set Up a
Default DMZ Server on page 205).

Forward Incoming Traffic for a Default Service or Application

You can forward traffic for a default service or application to a computer on your network.

> To forward incoming traffic for a default service or application:

1.
2.

Decide which type of service, application, or game you want to provide.
Find the local IP address of the computer on your network that will provide the service.

The server computer must always receive the same IP address. To specify this setting,
use the reserved IP address feature. See Manage Reserved LAN IP Addresses on
page 211.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http:/lwww.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

Manage Port Forwarding and Port Triggering
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ADVANCED ] Auto -

ADVANCED Home

Setup Wizard
WPS Wizard Please select the service type.

» Setup 9 Port Forwarding

_) Port Triggerin
» USB Functions agening

» Security Service Name Server IP Address
ETP - 192 ||168 .0 !
» Administration m

¥ Advanced Setup | ‘ > I

External
Start Port

External
End Port

Internal
Start Port

Internal End

Service Name | Port Internal IP address

Wireless Settings
Wireless AP

PortForwarding | Por [ o servee |
Triggering

VPN Service

Static Routes
Remote Management
UPnP

1Pv6

Traffic Meter

USB Settings

Device Mode

8. Make sure that the Port Forwarding radio button is selected.
9. From the Service Name menu, select the service or application.

If the service or application that you want to add is not in the menu, create a port
forwarding rule with a custom service or application (see Add a Port Forwarding Rule with
a Custom Service or Application on page 262).

10. In the Server IP Address field, enter the IP address of the computer that must provide the
service or that runs the application.

11. Click the Add button.

Your settings are saved. The rule is added to the table on the Port Forwarding / Port
Triggering screen.

Add a Port Forwarding Rule with a Custom Service or
Application

The modem router lists default services and applications that you can use in port forwarding
rules. If the service or application is not predefined, you can add a port forwarding rule with a
custom service or application.

> To add a port forwarding rule with a custom service or application:

1. Find out which port number or range of numbers the service or application uses.
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You can usually find this information by contacting the publisher of the service or
application or through user groups or news groups.

2. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

3. Type http://www.routerlogin.net.
A login screen displays.
4. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

5. Click the OK button.
The BASIC Home screen displays.

6. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering screen displays.

7. Make sure that the Port Forwarding radio button is selected.
Click the Add Custom Service button.

Senice Name

Senice Type TCP/UDP =

External Starting Port (1~65535)

External Ending Port (1-65535)
¥| Use the same port range for Internal port

Internal Starting Port (1~65535)

Internal Ending Port

Internal IP address 182 . 168 ]

Or seled from currently attached devices

IP Address Device Name

192.168.0.2 BusinessLaptop

9. Specify a new port forwarding rule with a custom service or application as described in the
following table.

Field Description
Service Name Enter the name of the custom service or application.
Service Type Select the protocol (TCP or UDP) that is associated with the service or application.

If you are unsure, select TCP/UDP.

External Starting Port | Enter the external start port number that the service or application uses.

External Ending Port Enter the external end port number that the service or application uses.
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Field Description

Internal Starting Port Specify the internal start port by one of these methods:

» Clear the Use the same port range for Internal port check box and enter
the internal start port number that the service or application uses.

Internal Ending Port Specify the internal end port by one of these methods:

» Clear the Use the same port range for Internal port check box and enter
the internal end port number that the service or application uses.

Internal IP address Either enter an IP address in the Internal IP address field or select the radio
button for an attached device that is listed in the table.

10. Click the Apply button.

Your settings are saved. The rule is added to the table on the Port Forwarding / Port
Triggering screen.

Change a Port Forwarding Rule

You can change an existing port forwarding rule.

To change a port forwarding rule:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.
The BASIC Home screen displays.
Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The following figure shows two port forwarding rules.
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[ ADVANCED 1 Auto -

ADVANCED Home Port Forwarding / Port Triggering

Setup Wizard
Please select the service type.

[}
I

» Setup @ Port Forwarding

» USB Functions ! Port Triggering

» Security I Service Name Server IP Address
FTP A 192 . 168 .0 L
» Administration | m

v Advanced Setup

External External Internal  |Internal End Internal IP addr
- StartPort | End Port | Start Port Port eAlaties:
Wireless Settings

Wireless AP EXPORTTUREO 57902 57905 57902 57905 192.168.0.214

Port Forwarding / Port 8 |2 TagSwitching 61235 61334 61235 61334 192.168.0.199
Triggering

Dynamic DNS

e [ e somice

Static Routes )

Remote Management
UPnP

1Pv6

Traffic Meter

USE Settings

Device Mode

# Service Name

-

6. Make sure that the Port Forwarding radio button is selected.
7. In the table, select the radio button next to the service or application name.
8. Click the Edit Service button.

The Ports - Custom Services screen displays.
9. Change the settings.

For more information about the settings, see Add a Port Forwarding Rule with a Custom
Service or Application on page 262.

10. Click the Apply button.

Your settings are saved. The changed rule displays in the table on the Port Forwarding /
Port Triggering screen.

Remove a Port Forwarding Rule
You can remove a port forwarding rule that you no longer need.

> To remove a port forwarding rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The following figure shows two port forwarding rules.

{ ADVANCED 1 Auto =

ADVANCED Home

Setup Wizard

Please select the service type.

» Setup 9 Port Forwarding

» USB Functions ! Port Triggering

» Security I Service Name Server IP Address

FTP - 192 | 168 .0 L
» Administration m

¥ Advanced Setup

External External Internal  |internal End Siteinial P adds
StartPort | EndPort | StartPort Port emalitanciess

EXPORTTURBO 57902 57905 57902 57905 182.168.0.214

# Service Name
Wireless Settings
Wireless AP

Port Forwarding / Port
Triggering

Dynamic DNS

Static Routes

Remote Management
PnP

1Pvé

Traffic Meter

USB Settings
Device Mode

-

(X]

Tagswitching 61235 61334 61235 61334 192.168.0.199

6. Make sure that the Port Forwarding radio button is selected.

7. In the table, select the radio button next to the service or application name.
8. Click the Delete Service button.

The rule is removed from the table.

Application Example: Make a Local Web Server Public

If you host a web server on your local network, you can use port forwarding to allow web
requests from anyone on the Internet to reach your web server.

» To make alocal web server public:

1. Assign your web server either a fixed IP address or a dynamic IP address using DHCP
address reservation.

In this example, your modem router always gives your web server an IP address of
192.168.1.55.

2. On the Port Forwarding / Port Triggering screen, configure the modem router to forward the
HTTP service to the local address of your web server at 192.168.1.55.

HTTP (port 80) is the standard protocol for web servers.
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(Optional) Register a host name with a Dynamic DNS service, and specify that name on the
Dynamic DNS screen of the modem router.

Dynamic DNS makes it much easier to access a server from the Internet because you
can enter the name in the Internet browser. Otherwise, you must know the IP address
that the ISP assigned, which typically changes.

How the Modem Router Implements the Port Forwarding Rule

The following sequence shows the effects of a port forwarding rule:

1.

When you enter the URL www.example.com in your browser, the browser sends a web

page request message with the following destination information:

o Destination address. The IP address of www.example.com, which is the address of
your modem router.

* Destination port number. 80, which is the standard port number for a web server
process.

The modem router receives the message and finds your port forwarding rule for incoming
port 80 traffic.

The modem router changes the destination in the message to IP address 192.168.1.123
and sends the message to that computer.

Your web server at IP address 192.168.1.123 receives the request and sends a reply
message to your modem router.

Your modem router performs Network Address Translation (NAT) on the source IP address
and sends the reply through the Internet to the computer or WiFi device that sent the web
page request.

Manage Port Triggering for Services and Applications

Port triggering is a dynamic extension of port forwarding that is useful in these cases:

An application must use port forwarding to more than one local computer (but not

simultaneously).

An application must open incoming ports that are different from the outgoing port.

With port triggering, the modem router monitors traffic to the Internet from an outbound
“trigger” port that you specify. For outbound traffic from that port, the modem router saves the
IP address of the computer that sent the traffic. The modem router temporarily opens the
incoming port or ports that you specify in your rule and forwards that incoming traffic to that
destination.

Port forwarding creates a static mapping of a port number or range of ports to a single local
computer. Port triggering can dynamically open ports to any computer when needed and
close the ports when they are no longer needed.
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Note: If you use applications such as multiplayer gaming, peer-to-peer
connections, real-time communications such as instant messaging, or
remote assistance, enable Universal Plug and Play (UPnP). See Improve
Network Connections with Universal Plug and Play on page 156.

Add a Port Triggering Rule

The modem router does not provide default services and applications for port triggering rules.
You must define a custom service or application for each port triggering rule.

To add a port triggering rule:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering screen displays.

Select the Port Triggering radio button.
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[ ADVANCED 1 Auto =

Please select the service type.

) Port Forwarding
@ Port Triggering

[ pisable Port Triggering
Port Triggering Time-out(in minutes) 20

Port Triggering Portmap Table
|#| Enable |  Service Name |

4 Add Service 4 Edit Service X Delete Service

Service Type | Inbound Connection | Service User |

7. Click the Add Service button.

Service
Senvice Name
Sendce User

Senvice Type
Triggering Port

TCP -
(1-65535)

Inbound Connection
Connection Type:
Starting Port
Ending Port

TCP/UDP ~
(1-65535)
(1-65535)

8. Specify a new port triggering rule with a custom service or application as described in the

following table.

Field

Description

Service Name

Enter the name of the custom service or application.

Service User

From the Service User menu, select Any, or select Single address and enter the IP
address of one computer:

* Any. This is the default setting and allows any computer on the Internet to use
this service.

» Single address. Restricts the service to a particular computer.

Service Type

Select the protocol (TCP or UDP) that is associated with the service or application.
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Field Description

Triggering Port Enter the number of the outbound traffic port that must open the inbound ports.

Inbound Connection

Connection Type Select the protocol (TCP or UDP) that is associated with the inbound connection.
If you are unsure, select TCP/UDP.

Starting Port Enter the start port number for the inbound connection.

Ending Port Enter the end port number for the inbound connection.

Click the Apply button.

Your settings are saved. The rule is added to the Port Triggering Portmap Table on the
Port Forwarding / Port Triggering screen and is enabled.

Change a Port Triggering Rule

You can change an existing port triggering rule.

To change a port triggering rule:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering screen displays.

Select the Port Triggering radio button.

The following figure shows two port triggering rules.
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D o -
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7. In the Port Triggering Portmap Table, select the radio button next to the service or
application name.

8. Click the Edit Service button.

The Port Triggering - Services screen displays.
9. Change the settings.

For more information about the settings, see Add a Port Triggering Rule on page 268.
10. Click the Apply button.

Your settings are saved. The changed rule displays in the Port Triggering Portmap Table
on the Port Forwarding / Port Triggering screen.

Disable or Remove a Port Triggering Rule

You can disable or remove a port triggering rule that you no longer need.

> To disable or remove a port triggering rule:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http:/lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.

The Port Forwarding / Port Triggering screen displays.

6. Select the Port Triggering radio button.

The following figure shows two port triggering rules.

L mrToa -
Port Forwarding / Port Triggering
[ weswizad ]

» Setup .
Please select the service type.
» USB Functions .
) Port Forwarding

» Securlty @ Port Triggering

» Administration )
» is ["I pisable Port Triggering
vanced Setu
b e Port Triggering Time-out(in minutes) 20

Wireless Settings
Wireless AP Port Triggering Portmap Table

Port Forwarding / Port # | Enable Service Name Service Type Inbound Connection Service User
Triggering ®1 @ VoiceAppOptimizer TCP:47992 TCPAUDP:35416..35418 Any
Dynamic DNS —

: 2 @ |2 il TrippleWoozer TCP:58996 TCPAUDP:23792.23798 192.168.0.214
VPN Service

b O EmEs
Remote Management

UenP

g

Traffic Meter

USB Settings
vice N

7. To disable the rule, do the following:

a.

=

In the Enable column of the Port Triggering Portmap Table, clear the check box next
to the service or application name.

Click the Apply button.

Your settings are saved.

8. To remove the rule entirely, do the following:

a.

b

In the Port Triggering Portmap Table, select the radio button next to the service or
application name.

. Click the Delete Service button.

The rule is removed from the Port Triggering Portmap Table.
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Specify the Time-Out Period for Port Triggering

The time-out period for port triggering controls how long the inbound ports stay open when
the modem router detects no activity. A time-out period is required because the modem
router cannot detect when the service or application terminates.

> To specify the time-out for port triggering:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering screen displays.
6. Select the Port Triggering radio button.
The port triggering settings display.
7. In the Port Triggering Time-out field, enter a value up to 9999 minutes.
The default setting is 20 minutes.
8. Click the Apply button.

Your settings are saved.

Disable Port Triggering

By default, port triggering is enabled. You can disable port triggering temporarily without
removing any port triggering rules.
> To disable port triggering:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.
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4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > Advanced Setup > Port Forwarding / Port Triggering.
The Port Forwarding / Port Triggering screen displays.

6. Select the Port Triggering radio button.
The port triggering settings display.

7. Select the Disable Port Triggering check box.

If this check box is selected, the modem router does not apply port triggering rules even if
you specified them.

8. Click the Apply button.
Your settings are saved.

Application Example: Port Triggering for Internet Relay Chat

Some application servers, such as FTP and IRC servers, send replies to multiple port
numbers. Using port triggering, you can tell the modem router to open more incoming ports
when a particular outgoing port starts a session.

An example is Internet Relay Chat (IRC). Your computer connects to an IRC server at
destination port 6667. The IRC server not only responds to your originating source port but
also sends an “identify” message to your computer on port 113. Using port triggering, you can
tell the modem router, “When you initiate a session with destination port 6667, you must also
allow incoming traffic on port 113 to reach the originating computer.”

The following sequence shows the effects of this port triggering rule:

1. You open an IRC client program to start a chat session on your computer.

2. Your IRC client composes a request message to an IRC server using a destination port
number of 6667, the standard port number for an IRC server process. Your computer then
sends this request message to your modem router.

3. Your modem router creates an entry in its internal session table describing this
communication session between your computer and the IRC server. Your modem router
stores the original information, performs Network Address Translation (NAT) on the source
address and port, and sends this request message through the Internet to the IRC server.

4. Noting your port triggering rule and observing the destination port number of 6667, your
modem router creates another session entry to send any incoming port 113 traffic to your
computer.

5. The IRC server sends a return message to your modem router using the NAT-assigned
source port (for example, port 33333) as the destination port and the IRC server also sends
an “identify” message to your modem router with destination port 113.

6. When your modem router receives the incoming message to destination port 33333, it
checks its session table to see if a session is active for port number 33333. Finding an active
session, the modem router restores the original address information replaced by NAT and
sends this reply message to your computer.
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7. When your modem router receives the incoming message to destination port 113, it checks
its session table and finds an active session for port 113 associated with your computer. The
modem router replaces the message’s destination IP address with your computer’s IP
address and forwards the message to your computer.

8. When you finish your chat session, your modem router eventually senses a period of
inactivity in the communications. The modem router then removes the session information

from its session table, and incoming traffic is no longer accepted on port numbers 33333 or
113.
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Troubleshooting

This chapter provides information to help you diagnose and solve problems you might
experience with your modem router. If you do not find the solution here, check the NETGEAR
support site at support.netgear.com for product and contact information.

This chapter contains the following sections:

*  Quick Tips for Troubleshooting

e Troubleshoot with the LEDs

* You Cannot Log In to the Modem Router

e Troubleshoot the Internet Connection

e Changes Are Not Saved

» Troubleshoot the WiFi Connectivity

e Troubleshoot Your Network Using the Ping Utility
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Quick Tips for Troubleshooting

The following table includes tips for troubleshooting some common problems.

Table 4. Quick tips for troubleshooting

Problem

Possible Solution

Your network is unresponsive
or does not function normally.

Restart your network:

1.
2.
3.
4.

Turn off and unplug the DSL, cable, or fiber modem.

Turn off the modem router.

Plug in the DSL, cable, or fiber modem and turn it on. Wait two minutes.
Turn on the modem router and wait two minutes.

If network problems still occur, make sure that your ISP does not require you to
use the MAC address of the computer that was used to initially register the ISP
account. If your ISP does require that you do this, you must change the modem
router MAC address that the modem router uses. For more information, see
one of the following sections:

Manually Set Up an ADSL Internet Connection on page 47
Manually Set Up a VDSL Internet Connection on page 56
Manually Set Up a Cable of Fiber Internet Connection on page 64

Your cannot connect over an
Ethernet cable to the modem
router.

Make sure that the Ethernet cables are securely plugged in.

Make sure that your computer or device does not use a static IP address
but is configured to receive an IP address automatically with DHCP. (For
most devices, DHCP is the default setting.)

You cannot connect over WiFi
to the modem router.

Make sure that the WiFi settings in your WiFi device and modem router
match exactly.
For a device that is connected over WiFi, the WiFi network name (SSID)
and WiFi security settings of the modem router and WiFi computer must
match exactly. The default SSID and password are on the product label (see
Bottom Panel Product Label on page 15).
Make sure that your WiFi device supports the security that you are using
for your WiFi network (WEP, WPA, or WPA2). For information about WiFi
security settings, see Manage the Basic WiFi Settings and WiFi Security of
the Main Network on page 91.
Make sure that the modem router is not too far from your WiFi device or too
close:
- Move your WiFi device near the modem router but at least 6 feet
(1.8 meters) away and see if the signal strength improves.
- Make sure that the WiFi signal is not blocked by objects between the
modem router and your WiFi device.
Make sure that the WiFi LED on the modem router is not off.
If this LED is off, both WiFi radios might be disabled. For more information
about the WiFi radios, see Control the WiFi Radios on page 108.
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Table 4. Quick tips for troubleshooting

Problem Possible Solution

You cannot connect over WiFi

to the_ modem router. If the modem router’s SSID broadcast is disabled, the WiFi network name is
(continued) hidden and does not display in your WiFi device's scanning list. To connect

Make sure that the modem router's SSID broadcast is not disabled.

to a hidden network, you must enter the network name and the WiFi
password. For more information about the SSID broadcast, see Manage the
Basic WiFi Settings and WiFi Security of the Main Network on page 91.

* Make sure that your WiFi device does not use a static IP address but is
configured to receive an IP address automatically with DHCP. (For most
devices, DHCP is the default setting.)

Troubleshoot with the LEDs

When you turn on the power, the LEDs light as described here.

When power is first applied, the Power LED lights solid amber @) .

After about 50 seconds, the following occurs:

« The Power LED lights solid green @), indicating that the startup procedure finished.
«  The WIFi LED lights solid blue @, indicating the WiFi network is available.

After approximately one minute, the DSL LED blinks green €9 to indicate that the modem
router is negotiating the best possible speed on the DSL line. If the negotiation completes
and a DSL link is established, the LED turns solid green. If you do not use a DSL modem
but a cable or fiber modem, the LED remains off.

When the DSL, cable, or fiber connection is established, the Internet LED blinks amber € .
When an Internet connection is established, the Internet LED lights solid green €).

Note: Whether the USB LED @ lights depends on whether a USB device
is connected to one of the USB ports.

Power LED Remains Solid Amber

When you turn on the modem router, the Power LED turns solid amber @) . After about
50 seconds, the Power LED lights solid green @), indicating that the startup procedure
finished. If the LED still does not turn green after two minutes, a power-on self-test (POST)
failure occurred or the modem router is malfunctioning.

If the Power LED does not turn green, do the following:

1.
2.

Turn the power off and back on to see if the modem router recovers.

If the Power LED still does not turn green, reset the modem router to factory default
settings.

For more information, see Use the Reset Button on page 227.
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If the error persists, a hardware problem might exist. For recovery instructions or help with a
hardware problem, contact technical support at netgear.com/support.

Power LED Is Off

If the Power LED @) and other LEDs remain off when you turn on the modem router, do the
following:

e Check that the Power On/Off button on the back is in the on position, that is, it is pushed
in.

e Check that the power cord is correctly connected to your modem router and that the
power supply adapter is correctly connected to a functioning power outlet.

» Check that you are using the 12 VDC 2.5A power adapter that NETGEAR supplied for
this product.

If the error persists, a hardware problem might exist. For recovery instructions or help with a
hardware problem, contact technical support at netgear.com/support.

WiFi LED Is Off

If the WiFi LED stays off @), check to see if both radios on the modem router are disabled
(see Control the WiFi Radios on page 108). By default, both radios are enabled and the WiFi
LED lights solid blue.

You Cannot Log In to the Modem Router

If you are unable to log in to the modem router from a computer on your local network and
use the web management interface, check the following:

* If you are using an Ethernet-connected computer, check the Ethernet connection
between the computer and the modem router.

e If the computer is set to a static or fixed IP address (this setting is uncommon), either
change the computer to obtain an IP address automatically from the modem router
through DHCP, or change the IP address of the computer to a static or fixed IP address in
the 192.168.0.2-192.168.0.254 range.

e Make sure that your computer can reach the modem router’'s DHCP server. Recent
versions of Windows and Mac OS generate and assign an IP address if the computer
cannot reach a DHCP server. These autogenerated addresses are in the range of
169.254.x.x. If your IP address is in this range, check the connection from the computer
to the modem router and reboot your computer.

e If your modem router’s IP address was changed and you do not know the current IP
address, use an IP scanner application to detect the IP address. If you still cannot find the
IP address, clear the modem router’s configuration to factory defaults. This sets the
modem router’s IP address to 192.168.0.1. For more information, see Return the Modem
Router to Its Factory Default Settings on page 227 and Factory Settings on page 289.
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« Make sure that Java, JavaScript, or ActiveX is enabled in your browser. If you are using
Internet Explorer, click the Refresh button to be sure that the Java applet is loaded.

e Try quitting the browser and launching it again.

e Make sure that you are using the correct login information. The user name is admin, and
the default password is password. Make sure that Caps Lock is off when you enter this
information.

« If you are attempting to set up your modem router behind an existing router in your
network, set up the modem router as a WiFi access point (see Use the Modem Router as
a WiFi Access Point on page 115).

Troubleshoot the Internet Connection

If your modem router cannot access the Internet, check the DSL connection, then the WAN
TCP/IP connection.

Troubleshoot the DSL Link

If your modem router is unable to access the Internet, first determine whether the DSL link
with the service provider is working. The DSL LED indicates the state of this connection.

DSL LED Is Green

If the DSL link LED lights green €9, the ADSL connection is good. You can be confident that
the service provider connected your line correctly and that your wiring is correct.

DSL LED Is Blinking Green

If the DSL LED is blinking green €, your modem router is attempting to make a DSL (ADSL
or VDSL) connection with the service provider. If the modem router establishes a DSL
connection, the DSL LED turns solid green. This connection process generally lasts several
minutes.

If the DSL LED does not turn solid green, disconnect all telephones on the line. If this solves
the problem, reconnect the telephones one at a time, being sure to use a microfilter on each
telephone. If the microfilters are connected correctly, you can connect all your telephones.

If disconnecting telephones does not result in a green DSL LED, a problem with your wiring
might exist. If the telephone company tested the ADSL or VDSL signal at your network
interface device (NID), then wiring in your house might be of poor quality.

DSL LED Is Off or Internet LED Is Off

If the DSL LED is off @, the Internet LED is off , or both are off, disconnect all
telephones on the line. If this solves the problem, reconnect the telephones one at a time,
being sure to use a microfilter on each telephone. If the microfilters are connected correctly,
you can connect all your telephones.
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If disconnecting telephones does not result in a green DSL LED, check the following:

e Check that the telephone company made the connection to your line and tested it.

»  Verify that you are connected to the correct telephone line. If more than one phone line is
installed, be sure that you are connected to the line with the ADSL or VDSL service. It
might be necessary to use a swapper if your ADSL or VDSL signal is on pins 1 and 4 or
the RJ-11 jack. The modem router uses pins 2 and 3.

Internet LED Is Off

If the Internet LED is off @), the modem router cannot connect to the Internet. Verify the
following:

» Check that your login credentials are correct or that the information you entered for the
ISP connection is correct. For more information, see one of the following sections:

- Manually Set Up an ADSL Internet Connection on page 47
- Manually Set Up a VDSL Internet Connection on page 56
- Manually Set Up a Cable of Fiber Internet Connection on page 64

» Check to see if your ISP is experiencing a problem—it might not be that the modem
router cannot connect to the Internet, but rather that your ISP cannot provide an Internet
connection.

Obtain an Internet IP Address

If the modem router cannot access the Internet but the Internet LED is green @), see if the
modem router can obtain an Internet IP address from the ISP. Unless the modem router is
assigned a static IP address, the modem router requests an IP address from the ISP. You
can determine whether the request was successful using the web management interface.
To check the Internet IP address:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://www.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.

5. Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.
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6. In the Internet Port pane, check that the IP Address field shows a valid IP address.

If the field shows 0.0.0.0, your modem router did not obtain an IP address from your ISP.

If your modem router cannot obtain an IP address from the ISP, the problem might be one of
the following:

e Your Internet service provider (ISP) might require a login program.
Ask your ISP whether they require PPP over Ethernet (PPPOE) or some other type of
login.

* If you selected a login program, the service name, user name, or password might be
incorrectly set.
For more information, see Troubleshoot PPPoE or PPPoA on page 282.

e Your ISP might check for your computer’s host name.
Assign the computer host name of your ISP account as the account name. For more
information, see one of the following sections:

- Manually Set Up an ADSL Internet Connection on page 47
- Manually Set Up a VDSL Internet Connection on page 56
- Manually Set Up a Cable of Fiber Internet Connection on page 64

e If your ISP allows only one Ethernet MAC address to connect to Internet and checks for
your computer’s MAC address, inform your ISP that you bought a new network device
and ask them to use the modem router's MAC address.

e Configure your modem router to clone your computer’s MAC address. For more
information, see one of the following sections:

- Manually Set Up an ADSL Internet Connection on page 47
- Manually Set Up a VDSL Internet Connection on page 56
- Manually Set Up a Cable of Fiber Internet Connection on page 64

Troubleshoot PPPoE or PPPOA

If you use a PPPoE or PPPOA connection to your ISP, make sure that the connection works.

To verify that your PPPOE or PPPOA connection is working:

1. Launch an Internet browser from a computer or WiFi device that is connected to the
network.

2. Type http://lwww.routerlogin.net.
A login screen displays.
3. Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

4. Click the OK button.
The BASIC Home screen displays.
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Select ADVANCED > ADVANCED Home.
The ADVANCED Home screen displays.

In the Internet Port pane, check that the IP Address field shows a valid IP address and that
the Connection field shows PPPoE or PPPOA.

In the Internet Port pane, click the Connection Status button.
The Connection Status screen displays.

Check the following:
« The Connection Status field shows Connected.
e The Connection Time field does not show 00:00:00.

If all of the information is correct, your PPPoE or PPPoA connection is working.

To reconnect if your PPPoE or PPPoA connection does not function:

1.

Launch an Internet browser from a computer or WiFi device that is connected to the
network.

Type http://www.routerlogin.net.
A login screen displays.
Enter the user name and password for the modem router.

The user name is admin. The default password is password. The user name and
password are case-sensitive.

Click the OK button.

The BASIC Home screen displays.

Select ADVANCED > ADVANCED Home.

The ADVANCED Home screen displays.

In the Internet Port pane, click the Connection Status button.
The Connection Status screen displays.

Click the Connect button.

The modem router attempts to reconnect.

If you cannot connect after several minutes, you might be using an incorrect service name,
user name, or password. Or your ISP might not be able to provide an Internet connection.

Unless you connect manually, the modem router does not authenticate using PPPoE or
PPPoOA until data is transmitted to the network.
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Troubleshoot Internet Browsing

If your modem router can obtain an IP address but your computer is unable to load any web
pages from the Internet, it might be for one of the following reasons:

The traffic meter is enabled, and the limit was reached.

By configuring the traffic meter not to block Internet access when the traffic limit is
reached, you can resume Internet access (see Unblock the Traffic Meter After the Traffic
Limit Is Reached on page 247). If your ISP sets a usage limit, they might charge you for
the overage.

Your computer might not recognize any DNS server addresses.

A DNS server is a host on the Internet that translates Internet names (such as www
addresses) to numeric IP addresses. Typically your ISP provides the addresses of one or
two DNS servers for your use. If you entered a DNS address when you set up the modem
router, reboot your computer and verify the DNS address. Alternatively, you can configure
your computer manually with DNS addresses, as explained in your operating system
documentation.

The modem router might not be configured as the TCP/IP router on your computer.

For information about TCP/IP problems, see Troubleshoot Your Network Using the Ping
Utility on page 285.

If your computer obtains its information from the modem router by DHCP, reboot the
computer and verify the modem router address.

Changes Are Not Saved

If the modem router does not save the changes that you make in the web management
interface, do the following:

When entering configuration settings, always click the Apply button before moving to
another screen or tab or your changes are lost.

Click the Refresh or Reload button in the web browser. It is possible that the changes
occurred but that the old settings remain in the web browser’s cache.

Troubleshoot the WiFi Connectivity

If you are experiencing trouble connecting over WiFi to the modem router, try to isolate the
problem:

Make sure that the WiFi settings in your WiFi device and modem router match exactly.

For a device that is connected over WiFi, the WiFi network name (SSID) and WiFi
security settings of the modem router and WiFi computer must match exactly. The default
SSID and password are on the product label (see Bottom Panel Product Label on

page 15).
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Does the WiFi device that you are using find your WiFi network?

If not, check the WiFi LED @ on the front of the modem router. If this LED is off, both
WiFi radios might be disabled. For more information about the WiFi radios, see Control
the WiFi Radios on page 108.

If you disabled the modem router’'s SSID broadcast, your WiFi network is hidden and
does not display in your WiFi client’s scanning list. (By default, SSID broadcast is
enabled.) For more information, see Manage the Basic WiFi Settings and WiFi Security of
the Main Network on page 91.

Does your WiFi device support the security that you are using for your WiFi network
(WEP, WPA, or WPA2)? For information about changing the WiFi security, see Manage
the Basic WiFi Settings and WiFi Security of the Main Network on page 91.

Tip: If you want to change the WiFi settings of the modem router’s main
network, use a wired connection to avoid being disconnected when
the new WiFi settings take effect.

If your WiFi device finds your network but the signal strength is weak, check these conditions:

Is your modem router too far from your WiFi device or too close? Place your WiFi device
near the modem router but at least 6 feet (1.8 meters) away and see whether the signal
strength improves.

Are objects between the modem router and your WiFi device blocking the WiFi signal?

Troubleshoot Your Network Using the Ping Utility

Most network devices and routers contain a ping utility that sends an echo request packet to
the designated device. The device then responds with an echo reply. You can easily
troubleshoot a network using the ping utility in your computer or workstation.

Test the LAN Path to Your Modem Router

You can ping the modem router from your computer to verify that the LAN path to your
modem router is set up correctly.

> To ping the modem router from a Windows computer:

1.
2.

From the Windows taskbar, click the Start button and select Run.

In the field provided, enter ping followed by the IP address of the modem router, as in this
example:

ping 192.168.0.1
Click the OK button.
A message such as the following one displays:

Pinging <IP address> with 32 bytes of data
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If the path is working, you see this message:

Reply from < IP address >: bytes=32 time=NN ms TTL=XxxX

If the path is not working, you see this message:

Request timed out
If the path is not functioning correctly, one of the following problems might be occurring:
e Wrong physical connections

For a wired connection, make sure that the numbered LAN port LED is lit for the port to
which you are connected.

Check that the appropriate LEDs are on for your network devices. If your modem router
and computer are connected to a separate Ethernet switch, make sure that the link LEDs
are lit for the switch ports that are connected to your computer and modem router.

* Wrong network configuration

Verify that the Ethernet card driver software and TCP/IP software are both installed and
configured on your computer.

Verify that the IP address for your modem router and your computer are correct and that
the addresses are on the same subnet.

Test the Path from Your Computer to a Remote Device

After you verify that the LAN path works correctly, test the path from your computer to a
remote device:

1. From the Windows toolbar, click the Start button and select Run.

2. In the field provided, enter

ping -n 10 IP address
where IP address is the IP address of a remote device such as your ISP’s DNS server.

If the path is functioning correctly, replies as described in Test the LAN Path to Your Modem
Router on page 285 display. If you do not receive replies, do the following:

* Check that the IP address of your modem router is listed as the default router in your
computer. If the IP configuration of your computer is assigned by DHCP, this information
is not visible in your computer’s Network Control Panel. Verify that the IP address of the
modem router is listed as the default router.

e Check that the network address of your computer (the portion of the IP address specified
by the netmask) is different from the network address of the remote device.

e If your ISP assigned a host name to your computer, enter that host name as the account
name (see Manually Set Up an ADSL Internet Connection on page 47).

e Your ISP might be rejecting the Ethernet MAC addresses of all but one of your
computers.
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Many broadband ISPs restrict access by allowing traffic only from the MAC address of
your modem, but some additionally restrict access to the MAC address of a single
computer connected to that modem. In this case, configure your modem router to clone
or spoof the MAC address from the authorized computer (see Manually Set Up an ADSL

Internet Connection on page 47).
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Supplemental Information

This appendix covers the following topics:

e Factory Settings
e Technical Specifications
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Factory Settings

You can reset the modem router to the factory default settings that are shown in the following
table.

For more information about resetting the modem router to its factory settings, see Return the
Modem Router to Its Factory Default Settings on page 227.

Table 5. D6400 modem router factory default settings

Feature Default Settings

Router login

User login URL http://routerlogin.net, http://routerlogin.com, or http://192.168.0.1
User name (case-sensitive) admin

Login password (case-sensitive) password

Internet connection

WAN MAC address Use default hardware address
WAN MTU size 1500
Port speed Autosensing

Local network (LAN)

LAN IP address 192.168.0.1

Subnet mask 255.255.255.0

DHCP server Enabled

DHCP range 192.168.0.2 to 192.168.0.254

DHCP starting IP address 192.168.0.2

DHCP ending IP address 192.168.0.254

DMZ Disabled

Time zone » North America: Pacific Standard Time

* Europe: GMT
» Other continents: Varies by region

Time adjusted for daylight saving time | Disabled

Main WiFi network

WiFi communication Enabled
SSID name See product label
SSID broadcast Enabled
Security WPA2-PSK (AES)
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Table 5. D6400 modem router factory default settings (continued)

Feature

Default Settings

WiFi network key (passphrase)

See product label

Country/region

* North America: United States
e Europe: Europe
* Other continents: Varies by region

RF channel

Auto. The available channels depend on the region.

Transmission speed

Autol

Operating mode

 Up to 300 Mbps at 2.4 GHz
 Up to 1300 Mbps at 5 GHz

Guest WiFi network

WiFi communication

Disabled

SSID name

e 2.4 GHz band: NETGEAR-Guest
5 GHz band: NETGEAR-5G-Guest

SSID broadcast

Enabled

Security

None (open network)

Allow guests to access main network

Disabled

General WiFi settings

Radio transmission power

100 percent, nonconfigurable

20/40 MHz coexistence Enabled
Fragmentation length 2346
CTS/RTS threshold 2347

Preamble mode

Long Preamble

WPS

WPS capability

Enabled

Modem router’s PIN

Enabled, see the web management interface (path ADVANCED >

Advanced Setup > Wireless Settings)

Keep Existing Wireless Settings

Enabled

1. Maximum WiFi signal rate derived from IEEE Standard 802.11 specifications. Actual throughput can vary. Network conditions
and environmental factors, including volume of network traffic, building materials and construction, and network overhead, lower

actual data throughput rate.
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Technical Specifications

Table 6. D6400 modem router specifications

Feature

Description

Data and routing protocols

TCP/IP, RIP-1, RIP-2, DHCP, PPPoE, PPTP, Bigpond, Dynamic DNS, UPnP,
and SMB

Power adapter

* North America: 120V, 60 Hz, input
» UK, Australia: 240V, 50 Hz, input
e Europe: 230V, 50 Hz, input

e All regions: 12V @ 2.5 A output

Dimensions

Dimensions: 191 mm x 198.5 mm x 65 mm (7.5 in. x 7.8 in. x 2.6 in.)

Weight

Weight: 422 g (0.93 Ib)

Operating temperature

0° to 40°C (32° to 104°F)

Operating humidity

90% maximum relative humidity, noncondensing

Electromagnetic emissions

* EN 55022:2010/AC:2011, Class B
+ CISPR 22:2008, Class B
* AS/NZS CISPR 22:2009/Amdt 1:2010, Class B

LAN Four RJ-45 LAN ports supporting 10BASE-T, 100BASE-TX, and 1000BASE-T
WAN One RJ-45 Internet port supporting 10BASE-T, 100BASE-TX, and 1000BASE-T
DSL One RJ-11 DSL port for ADSL or VDSL service

WiFi Maximum WiFi signal rate complies with the IEEE 802.11 standard. See the

footnote for the table in Factory Settings on page 289.

Radio data rates

Auto-rate sensing

Data encoding standards

 |EEE 802.11ac 2.0
+ |EEE 802.11n version 2.0

* |EEE 802.11n 256QAM IEEE 802.11g, IEEE 802.11b 2.4 GHz
IEEE 802.11n, IEEE 802.11a 5.0 GHz

Maximum computers per
WiFi network

Limited by the amount of WiFi network traffic generated by each node (typically
50-70 nodes).
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Table 6. D6400 modem router specifications (continued)

Feature

Description

Operating frequency range

2.4 GHz band

- US: 2.412-2.462 GHz

- Europe: 2.412-2.472 GHz

- Australia: 2.412-2.472 GHz

- Japan: 2.412-2.472 GHz

5 GHz band

- US:5.18-5.24 + 5.745-5.825 GHz and DFS (5.25-5.35 + 5.50-5.70)

- Europe: 5.18-5.24 GHz and DFS (5.25-5.35 + 5.50-5.70)

- Australia: 5.18-5.24 + 5.745-5.825 GHz and DFS (5.25-5.35 + 5.50-5.70)
- Japan: 5.18-5.24 GHz and DFS (5.25-5.35 + 5.50-5.70)

802.11 security

WPA2-PSK, WPA/WPA2, WPA/WPA2 Enterprise, and WEP
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